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1Introduction

Introduction
This chapter provides an overview of the different Kaleido multiviewer models.

About this Document
The Kaleido Software User’s Manual is intended to help you leverage the full working 
potential of the Kaleido Software and XEdit application for controlling and monitoring 
audio, and video broadcast signal paths for interfacing, routing distribution and other 
peripheral devices.

For specific installation instructions for your multiviewer model, refer to the multiviewer’s 
Installation & Service Manual. The Installation & Service Manual document lists all related 
documentation for the multiviewer model. This document presumes that you have made 
the multiviewer functional according to the Installation & Service Manual document. Then 
use this document to complete your system configuration until it meets your monitoring 
requirements.

Related Documentation
Use the following related documentation to configure the multiviewer and to better 
understand the features available with this multiviewer. You can obtain the latest product 
documentation from the Documentation Library section of Grass Valley’s website 
(www.grassvalley.com/docs/multiviewers). The multiviewer’s Installation & Service Manual 
lists the specific documentation set for a given multiviewer model. The Kaleido Multiviewers 
Documentation Resource Guide (part number M770-9905) provides an overview of available 
documentation and explains how to access it from the Grass Valley website.

Document Number / 
Documentation Library Title

M770-2800 Kaleido Software User’s Manual

M770-2103 Kaleido Software Release Notes

M770-9904 Kaleido Software Product Comparison Charts

See 
www.grassvalley.com/docs/
multiviewers

Kaleido multiviewer Documentation Library

M735-9902 Kaleido-RCP2 Guide to Installation and Operation

M876-9900 RCP-200 Guide to Installation and Operation

M770-0900 Kaleido Remote Control Protocol (Gateway) User’s Guide

http://www.grassvalley.com/docs/multiviewers
http://www.grassvalley.com/docs/multiviewers
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Software and Firmware Updates
You can obtain the latest software, drivers, and sample databases from the Downloads section 
of the Grass Valley’s website (www.grassvalley.com/dl/multiviewers).

Feature Availability and Multiviewer Specifications
This user manual shows features and capacities that are not supported by all multiviewer 
models. To better understand the features that are available for your multiviewer, see the 
Kaleido Multiviewer Product Comparison Guide (part number M770-9904). The multiviewer’s 
Installation & Service Manual has the full specifications for a given multiviewer model.

M796-9902 Audio Bridge Terminal Guide to Installation and Operation

M407-9900 iControl Router User Guide

Published online iControl Online Help
iControl Solo Online Help

See 
https://www.grassvalley.com
/products/nv9000/

NV9000 Control System Documentation Library

Document Number / 
Documentation Library Title

https://www.grassvalley.com/products/nv9000/
http://www.grassvalley.com/dl/multiviewers
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XEdit Application Shortcuts
The following is a list of shortcut keys available in XEdit to execute specific actions.

Action Shortcut key

Save Ctrl+S

Import sources from spreadsheeta

a. Available for Kaleido-IP only (see Importing an Input Configuration from a Spreadsheet on page 58).

Ctrl+I

Toggle the status bar Ctrl+Shift+B

Toggle the layout navigator Ctrl+Shift+N

Toggle the grid Ctrl+Shift+G

Toggle the Tools pane Ctrl+Shift+T

Toggle the Properties pane Ctrl+Shift+P

Toggle the Tips pane Ctrl+Shift+H

Undo last operation Ctrl+Z

Redo last operation Ctrl+Y

Cut Ctrl+X

Copy Ctrl+C

Paste Ctrl+V

Delete selection Delete

Duplicate Ctrl+D

New Ctrl+N

Open Ctrl+O

Save as Ctrl+Shift+S

Close Ctrl+W

Create grid-type layout based on selection (Auto-layout) Ctrl+M

Select all Ctrl+A

Send to back Ctrl+B

Send to front Ctrl+R

Unlock composite F2

Zoom in Ctrl+plus sign

Zoom out Ctrl+minus sign
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2Getting Started

Introduction
This chapter provides an overview of how to configure a Kaleido multiviewer. 

Once the multiviewer has been connected and powered up, according to the multiviewer’s 
Installation & Service Manual, you must use XEdit to configure the multiviewer to make the 
monitoring output functional. To start XEdit, refer to the multiviewer’s Installation & Service 
Manual.
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Multiviewer Signal Flow Overview
The following diagrams shows how a signal proceeds through the multiviewer. However, 
note that the order in which you configure the multiviewer is different from the way the 
signal flows through the multiviewer.
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Multiviewer Sources
Depending on the multiviewer model, the source signal type and how it arrives at the 
multiviewer varies. 

Source
Multiviewer 
Models Description

“On Demand” 
Network Sources

Kaleido-IP 
series

These sources represent streams that are available to the 
multiviewer but are only used when they are displayed 
through a logical source. When these streams are not 
currently being displayed, the multiviewer will still 
periodically inspect these sources to determine their 
content.

Virtual Inputs Kaleido-IP 
series

Virtual inputs aren't actual sources but instead represent 
multiviewer resources that are actively receiving streams 
from the moment they are configured with a valid stream 
IP address or URL. As a result, these streams will 
continuously use network bandwidth, and your 
network link must be scaled appropriately to handle 
the number of simultaneous streams you want to 
make available to the multiviewer.

“On Demand” 
Router Sources

Non-Kaleido-IP These sources represent Router Sources available to the 
multiviewer through the available cabling between the 
multiviewer and the router (See Router Connections, on 
page 355). These sources are routed to the multiviewer 
only when they are put on a display through a logical 
source. Even if they are not currently used, the 
multiviewer will periodically poll the router control 
system to determine the source names (if the protocol 
allows it).

Physical Inputs Non-Kaleido-IP These sources represent physical inputs that are actively 
receiving SDI or analog signals.
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Logical Sources
A logical source organizes a group of audio, video, or metadata sources, as well as alarms 
generated by these sources, into a series of levels. See Logical Sources, on page 71.

Monitors
A monitor is an element that is part of a layout and displays a level from a logical source. The 
Kaleido Software supports several types of layout elements (for example, clocks, video 
monitors, audio monitors, UMDs, time code monitors, etc.), as well as composite monitors. 
See Adding Monitors to a Layout, on page 183.
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Layouts
A layout is a visual grouping of monitors that appear on displays within a room. A layout 
includes different types of monitors in a variety of placements and sizes. There are two 
types of layouts: room layouts, and full screen layouts. See Managing Layouts, on page 172.

Rooms and Displays
Each Display forms one of the multiviewer’s monitoring outputs. Add two or more Displays 
to a Room, to represent a physical display monitor’s orientation (portrait / landscape), to 
establish the display’s location with respect to other displays, to integrate mouse cursor 
movement between the displays, and so on. See Setting Up Rooms, on page 145.

Room Configuration
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3Managing Kaleido Multiviewer Systems

Introduction
This section explains what constitutes a Kaleido multiviewer system, and the related 
workflow. 

Creating and maintaining a Kaleido multiviewer system involves a number of file 
management tasks, including backup and restore operations. The XEdit software is used to 
perform these tasks. Some tasks are done in online mode, others in offline mode. Most are 
available in both modes.

A local database is used as a workspace to save layouts and related configuration data 
temporarily while you are building your Kaleido multiviewer system in offline mode. If you 
need to build more than one system, you can keep working with the same database, and 
use the backup tool to save the data for each system separately. To further work on a 
specific system you would then use the restore backup tool. See Managing Multiple 
Databases Efficiently on page 41 for an overview of the recommended workflow.

Key Concepts
The name used in the Kaleido Software to represent a multiviewer model is shown in 
Representation of Multiviewer Models in Kaleido Software, on page 23. See the Kaleido 
Multiviewer Product Comparison Guide for detailed information about the capacities of each 
multiviewer model. See the multiviewer’s Installation & Service Guide for the multiviewer’s 
specifications. See Related Documentation, on page 11. 

Term Description

System A Kaleido system represents a grouping of equipment, including one or 
more multiviewers that use the Kaleido Software, and a number of 
peripheral devices such as automation systems. In XEdit, you work on 
one multiviewer at a time. Each multiviewer is stored as a separate 
database.

Kaleido-IP The Kaleido-IP can monitor and display UHD, HD and SD television 
programs distributed over IP, across two UHD or HDTV displays — or, in 
the case of a Kaleido-IP VM, through one streaming output. It supports a 
variety of compressed and uncompressed video and audio formats over 
IP.
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XEdit XEdit is the Kaleido Software’s layout editor, a software that is run on a 
remote computer. Its purpose is to define your Kaleido multiviewer 
system components, including external devices, create rooms, logical 
sources, layouts, and RCP user definitions, and perform all the 
configurations required for successful operation of the multiviewer. 
XEdit has two modes of operation: you can work offline in a local 
workspace and then apply your changes by exporting them to the 
multiviewer, or you can connect to a multiviewer and work in online 
mode, directly on the system. Changes made in online mode take effect 
immediately on the monitor wall.

Database Layouts and related configurations for your Kaleido multiviewer system 
are created in XEdit. All this information is stored in a database. When 
you work in offline mode, you load the appropriate database in a local 
workspace on the PC where XEdit is used. XEdit can export this database 
to a multiviewer, or import the current layouts and configurations from a 
multiviewer into the local workspace on your PC. For changes you make 
in offline mode to take effect on the monitor wall, you must export the 
database to a multiviewer. Conversely, any configuration change you 
make in online mode must be imported from the multiviewer into your 
local workspace if you want to be able to make further changes in offline 
mode.

Logical source A logical source (called a channel, in earlier versions of the software and 
documentation) refers to a group of physical audio, video, or metadata 
sources, and text attributes. A logical source can be used as a whole, and 
assigned to a virtual monitor. See Logical Sources on page 71, for details.

Calibration Calibration refers to the configuration of different card attributes. For 
example, an output card’s Brightness and Contrast attributes can be 
calibrated, or an input card’s Silence threshold attribute. See Calibrating 
the Kaleido Software on page 89, for details.

Peripheral devices A peripheral device is an external piece of equipment, such as a router or 
production switcher, that can be connected to the multiviewer.

Term Description
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Representation of Multiviewer Models in Kaleido Software
The name used in Kaleido Software to represent a multiviewer model is shown in the table 
below.

In XEdit Select In XAdmin Select To represent

Kaleido-IP-2 Kaleido-IP-2 A Kaleido-IP X300, or X100 frame with two LAN 
connections

Kaleido-IP-4 Kaleido-IP-4 A Kaleido-IP X120, X110, X320, X310, or X300 
frame with four LAN connections

Kaleido-IP-6 Kaleido-IP-6 A Kaleido-IP X320, X310, or X300 frame with six 
LAN connections
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Opening XEdit Software
When using XEdit offline, you work inside a workspace located on your client PC. When you 
first open XEdit, a window will prompt you for the location for this workspace. It is 
recommended to consider this workspace as a sandbox into which you will always first 
import the database you want to work on during the current session, and from which you 
will export the database at the end of the session.

To open XEdit
1 Double-click the XEdit icon on your desktop: .

A startup screen appears, followed by the Database Location window.

2 When prompted to specify the database location, click Browse.

Note: If you have installed multiple versions of 
XEdit, the launcher icon on your desktop opens 
the last version you installed. To open a specific 
version of XEdit, use the launcher icon on the Start 
menu (under All Programs).
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3 In Select the database location, locate an appropriate directory for your workspace, 
and then click Open.

If this is not the first time you open XEdit, and you are satisfied with the location of your 
local workspace, then select the Don’t ask next time check box, to avoid being 
prompted every time you open XEdit.

4 Click OK to close the Database Location window.
XEdit’s main application window appears. This may take a few seconds.
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When first opening XEdit in offline mode, the database contains the default 
configuration for a Kaleido-X (7RU) system, including a fully-populated frame (all cards 
present) and a set of predefined logical sources.

To customize the layout of the XEdit application window
• Resize the window, and its three panes, by dragging the window’s borders, corners, and 

pane splitters.
• Move the Tips, Tools, and Properties panes between the left and right panes, and 

reorder them, by clicking their handle and dragging them to their final location.
• Close the Tips, Tools, and Properties panes by clicking their × button.
• Undock the Tips, Tools, and Properties panes from the main window, by clicking their 

square button.

To restore the default application layout
1 Dock the Tips, Tools, and Properties panes, if they are undocked, by clicking their × 

button.
2 On the View menu, point to Panes and tabs, and then click Restore default window 

settings.

To close XEdit
• On the File menu, click Exit. Alternatively, click the × button in the upper right corner of 

the main application window.

× button Handle Square button

Splitter
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Difference between Online and Offline Modes 
When using XEdit in online mode, any changes made are applied and stored directly on the 
multiviewer and any change you make to your multiviewer’s configuration takes effect 
immediately on the multiviewer itself; your local database is not involved. The online mode 
is not limited to basic system configuration; changes can also be made to existing logical 
sources, rooms, layouts, RCP users, etc.

When using XEdit in offline mode, all changes are stored locally on your PC, and the 
database must be exported to the multiviewer for the changes to take effect.

Note: In the case of a Kaleido-IP, you must work in online mode at least 
once, to obtain the list of programs and elementary streams under each 
transport stream.
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Using XEdit in Online Mode
Once XEdit is open, proceed as follows.

Connecting to a Multiviewer
To connect to a multiviewer

1 On the Configure menu, click Connect.

2 In Connect to Multiviewer, Enter the management IP address for the multiviewer you 
want to configure or select a multiviewer from the drop-down list, and then click OK.
Your recent connections, and all the multiviewers that are on the same subnet as your 
PC are automatically included in the list.

3 If access control is enabled for this multiviewer, then XEdit prompts you for a password. 
Type the password associated with the RCP user “Admin”, and then click Log on.

The selected system’s hierarchical list appears in XEdit’s main pane, showing the 
multiviewer model, system name and IP address, and the status bar shows the 
connection status.

Connection status Multiviewer model System name System IP address
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It is also possible to verify which version of the Kaleido Software is installed on this 
multiviewer, by moving to pointer to the system name in the System list. A tip appears, 
showing this information.

Disconnecting from a Multiviewer
To disconnect from a multiviewer

• On the Configure menu, click Disconnect.
XEdit switches to its local workspace, and displays the OFFLINE status on the status bar.

Enabling Access Control in XEdit
XEdit supports a simple authentication mechanism to prevent unauthorized users from 
connecting or exporting to a multiviewer. When access control is enabled, the password 
associated with the RCP user Admin (see Changing an RCP User’s Name or Password on 
page 285) is enforced.

To enable access control in XEdit
1 Connect to the multiviewer you want to protect (see Connecting to a Multiviewer on 

page 28).
2 On the Configure menu, select the Access control check box.

XEdit prompts you for a password.

3 Type the password associated with the RCP user Admin, and then click Log on.
Access control is now enabled for this multiviewer.

Notes

• When using XEdit in online mode, some database functions, such as 
Export, Import, and Restore backup, are not available. Any changes made 
by the user are not kept locally on the user’s PC, but applied directly on the 
multiviewer. To retrieve the data set from the multiviewer, either 
disconnect from the multiviewer, and then use the Import function, or use 
the Create backup function to save a copy of the database. A database can 
be restored from a backup repository to your local workspace later. 
See Managing Multiple Databases Efficiently on page 41 for a description 
of the recommended workflow.

• It is not recommended to have two or more users simultaneously 
connected online to the same multiviewer system for editing.
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Disabling Access Control in XEdit
To disable access control in XEdit

1 Connect to the multiviewer you want to unprotect (see Connecting to a Multiviewer on 
page 28).
XEdit prompts you for a password.

2 Type the password associated with the RCP user Admin, and then click Log on.
3 On the Configure menu, clear the Access control check box.

Access control is now disabled for this multiviewer.
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Importing a Database
XEdit must be offline from the multiviewer to import a database. See Working offline, on 
page 41 for more information about the offline mode. See Disconnecting from a 
Multiviewer, on page 29 to set the offline mode.

To import a database
1 On the Configure menu, point to Database, and then click Import.

The Import from Multiviewer window appears, prompting you for the IP address of the 
multiviewer whose database you want to import.
Your recent connections, and all the multiviewers that are on the same subnet as your 
PC are automatically included in the list.

2 Select the multiviewer from the list (if present), or type the appropriate IP address in 
the box, and then click OK.
A window appears, prompting you to confirm that you really want to import the 
database from the multiviewer.

3 Click Yes.
A progress window appears, followed by a message stating whether the import 
succeeded or not.

4 Click OK.
The imported data has replaced the former content in your local workspace. The 
originating system’s multiviewer model and IP address now appear in the System list.

Multiviewer model IP address
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Exporting a Database
XEdit must be offline from the multiviewer to export a database. See Working offline, on 
page 41 for more information about the offline mode. See Disconnecting from a 
Multiviewer, on page 29 to set the offline mode.

Exporting a Single-Multiviewer Database
To export a single-multiviewer database

1 On the Configure menu, point to Database, and then click Export.
The Export to Multiviewer window appears, prompting you for the IP address of the 
multiviewer to which you want to transfer the database.
Your recent connections, and all the multiviewers that are on the same subnet as your 
PC are automatically included in the list.

2 Select the multiviewer from the list (if present), or type the appropriate IP address in 
the box, and then click OK.
A window appears, prompting you to confirm that you really want to export data to the 
multiviewer.

3 Click Yes.
4 If access control is enabled for this multiviewer, then XEdit prompts you for a password. 

Type the password associated with the RCP user “Admin”, and then click Log on.

A progress window appears, followed by a message stating whether the export 
succeeded or not.

5 Click OK.
All data on the remote system is now replaced with content from the local workspace.
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Creating a Backup
Use the Create backup and Restore backup functions to manage copies of your system 
database on your PC. This is equivalent to the usual Save as and Open functions, and is 
useful not only for data recovery purposes but also on sites where more than one system 
must be maintained.

Backing Up the Current Database
To back up the current system database

1 On the Configure menu, point to Database, then to Create backup and click All.
The Create Backup window appears.

2 In Create Backup, select the location on your PC where you want to save a backup copy 
of the current database content, and then click Save.
The database is saved as a ZIP file.

Backing Up Resolutions
To back up resolutions from the current system

1 On the Configure menu, point to Database, then to Create backup and click 
Resolutions.
The Create Backup window appears.

2 In Create Backup, select the location on your PC where you want to save a backup copy 
of the resolutions from the current database, and then click Save.
The resolutions are saved as an XEdit collection file, with a .xcol extension.

Backing Up Audio Scales
To back up audio scales from the current system

1 On the Configure menu, point to Database, then to Create backup and click Audio 
scales.
The Create Backup window appears.

2 In Create Backup, select the location on your PC where you want to save a backup copy 
of the audio scales from the current database, and then click Save.
The audio scales are saved as an XEdit collection file, with a .xcol extension.



34

Managing Kaleido Multiviewer Systems
Restoring a Backup

Restoring a Backup

Restoring a Database from a Backup

To restore a backup database
1 On the Configure menu, point to Database, and then click Restore backup.

The Select Backup window appears.
2 In Select Backup, navigate to the appropriate backup file on your PC (a ZIP archive, in 

the case of a full database backup), select it, and then click Open.
A message appears prompting you to confirm your choice.

3 Click Yes.
4 Once the operation has completed, click OK to continue.

The former content of the local workspace is entirely replaced with data from the 
backup.

Restoring Resolutions or Audio Scales from a Backup
To restore resolutions or audio scales from a backup

1 On the Configure menu, point to Database, and then click Restore backup.
The Select Backup window appears.

2 In Select Backup, navigate to the appropriate backup file on your PC (an XEdit 
collection file, with a .xcol extension), select it, and then click Open.
The content of the local workspace is updated with data from the backup.

Note: When XEdit restores a database backup, it replaces the content of the 
local workspace with data from the backup (saved as a file on your PC). This 
cannot be undone. Always create a backup of the current data before 
restoring data from a different source. See Managing Multiple Databases 
Efficiently on page 41 for an overview of the recommended workflow.

Note: XEdit will not prompt for confirmation.
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Creating a Single Multiviewer System
When first opening XEdit in offline mode, the database contains the default configuration 
for a Kaleido-X (7RU) system, including a fully-populated frame (all cards present) as a 
starting point. If you have a different multiviewer model that is not a Kaleido-X (7RU) 
system, then you must replace this initial configuration with one that matches your actual 
system with the following procedure.

To create a system with a single multiviewer
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
The main pane displays the System hierarchical list, and the Tools pane displays the 
equipment library when the root of the System list is selected.

3 Right-click the current multiviewer in the System list, and then select the appropriate 
multiviewer model, from the replace with options on the menu.

Notes

• The name used in Kaleido Software to represent a multiviewer model 
is shown in Representation of Multiviewer Models in Kaleido Software, 
on page 23.
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The name used in Kaleido Software to represent a multiviewer model is shown in 
Representation of Multiviewer Models in Kaleido Software, on page 23.
A message appears, prompting you to confirm your choice.

4 Click Yes.
The next message prompts you about populating the database with a factory-default 
configuration for the selected multiviewer model. 

5 Click Yes to have the system populated with factory defaults for the selected 
multiviewer model. See Restoring the Factory-Default Configuration on page 39 for 
more information.
Click No, if you want to reuse the current room and layout configuration with the new 
multiviewer model.

Notes

If you are working in the online mode, the available multiviewer models 
shown in the menu varies according to the current model. If the current 
model is a Kaleido-IP, then only other Kaleido-IP models can be selected.

Conversely, if the current model is not a Kaleido-IP, then none of the 
Kaleido-IP models can be selected.

See Using XEdit in Online Mode, on page 28 and Managing Multiple 
Databases Efficiently, on page 41 for more information about the online and 
offline modes.
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6 Select the relevant peripheral devices in the equipment library and drag them onto the 
root of the System hierarchical list in the main window. Alternatively, right-click the list 
root, and then select the appropriate peripheral device from the “insert...” options on 
the menu.
All peripheral devices added to the system appear in the System list.

7 If you are going to control the multiviewer, from a device using one of the supported 
TCP/IP router protocols —SW-P-02, SW-P-08, Network Modular, or NVEP Router 
(NP0016) —, then configure the router level to be controlled: click the multiviewer in 
the System list, and then, in the Properties pane, specify the logical router and level 
you want to control, by selecting the appropriate values in the Router and Router level 
lists under TCP/IP Router control.

8 On the File menu, click Save. Alternatively, click the toolbar’s Save button.
Changes to the system are saved.

IMPORTANT
Databases created for different multiviewer models are incompatible with 
each other. It is important to select the proper model at this stage for the 
actual hardware you are using.

Notes

• As of version 5.00 of the Kaleido Software, the router selected by default 
for TCP/IP control is the KX Router logical router

• To control the KX Router logical router from an external device or 
application, this device or application must support the NVEP Router 
(NP0016) protocol (see Built-in Communications Protocols on page 359, 
for more information).
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Configuring the System Representation
• The Kaleido-IP has two, four, or six LAN connections, depending on the model, and two 

multiviewer outputs. The multiviewer’s output can optionally be output over IP 
streaming. Configuring your Kaleido-IP’s system representation in XEdit involves 
adding or removing transport streams until the representation matches the set of 
transport streams you want to monitor. See Managing Sources in a Kaleido-IP System 
on page 43, for details.

• The Kaleido-IP VM has a single multiviewer output over IP streaming, associated with 
output Head 1, in the system representation. Configuring your Kaleido-IP VM’s system 
representation in XEdit involves adding or removing transport streams until the 
representation matches the set of transport streams you want to monitor. 
See Managing Sources in a Kaleido-IP System on page 43, for details.
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Restoring the Factory-Default Configuration
A number of predefined rooms and layouts are available on the multiviewer when you first 
receive your system. This is the factory-default configuration. If after modifying the 
multiviewer’s configuration, you are not satisfied with the results, there are the following 
methods to revert the multiviewer’s configuration back to the factory-default configuration 
in order to start over. 

• A menu option allows you to directly restore the multiviewer’s factory-default 
configuration. See To restore the XEdit factory defaults for a multiviewer model, on 
page 39.

Restoring the factory database does not modify the multiviewer's current IP addresses and 
system name. If these parameters need to be changed, it must be done using XAdmin. See 
the multiviewer’s Installation & Service Manual. See Related Documentation, on page 11. 

To restore the XEdit factory defaults for a multiviewer model

For this procedure, XEdit can be online with the multiviewer or offline from the multiviewer. 
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then select the multiviewer that you want to 

restore to its factory-default configuration.
3 On the Configure menu, click Database and then Restore factory default. 

IMPORTANT
If you already have layouts that you want to keep, make sure to back up the 
XEdit database or export the layout before restoring the factory defaults. See 
Creating a Backup, on page 33 and Exporting Layouts, on page 182.

Note: If XEdit is offline from the multiviewer and the current model of 
multiviewer in XEdit does not match the actual multiviewer model, then you 
can replace the current configuration with one that matches your actual 
system and restore the multiviewer’s factory-default configuration at the 
same time using the replace with option. See Creating a Single Multiviewer 
System, on page 35.
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XEdit then prompts you to confirm that you want to restore the factory defaults for the 
selected multiviewer model.

4 Click Yes.
The configuration of the selected multiviewer model is reset to the factory default. 

5 The local layout must be refreshed on the multiviewer’s wall. See Refreshing a Layout, 
on page 321.

The multiviewer’s wall is now showing the factory-default configuration.
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Managing Multiple Databases Efficiently
To avoid mistakes in managing databases, especially when multiple multiviewers are 
involved, it is recommended to follow the rules below:

• Back up the database for each system to a central repository, separate from the local 
workspace you use when working in XEdit offline.

• When using XEdit, limit yourself to a single workspace. When working online, the local 
workspace is not used. When working offline, first either import the database from the 
appropriate multiviewer into your XEdit workspace, or restore the latest backup for the 
system you want to work on.

• When your work session in XEdit is complete, always create a new backup of the 
database, regardless of whether you were working online or offline.

The next sections describe three typical situations, summarized below:

Working online
If you are connected to a multiviewer, and working online in XEdit, you are actually editing 
the database that is located inside the multiviewer’s file system. There is one database per 
multiviewer. When you have completed your changes, create a backup of the current 
system and store it in a secure location on your PC.

To back up the current Kaleido multiviewer system
1 On the Configure menu, point to Database, to Create backup, and then click All.
2 Browse to the secure location on your PC where you store all your database backups 

(for example, multiviewerDatabaseBackups), and type a name for the new backup, 
preferably a name that includes the multiviewer name and the date (for example, 
KX_A&B_08_12_02.zip).

Working offline
When using XEdit offline, you work inside a workspace located on your client PC. You set 
the location for this workspace when you first opened XEdit. It is recommended to consider 
this workspace as a “sandbox” into which you import the database you want to work on 
during this session, and from which you export the database at the end of the session.

Online Offline System restore from backup (offline)

1 Work in XEdit. 1 Import database from multiviewer 
into local workspace.

1 Restore backup from central 
repository into local workspace.

2 Back up 
database from 
multiviewer to 
central 
repository.

2 Work in XEdit. 2 Work in XEdit, if needed...
...and then back up database from 
local workspace to central 
repository.

3 Back up database from local 
workspace to central repository.

4 Export database from local 
workspace to multiviewer.

3 Export database from local 
workspace to multiviewer.
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See Importing a Database on page 31, for instructions on how to import the database from 
a specific multiviewer into your workspace. Once the import is completed, you can work 
locally, in your XEdit workspace. When you have completed your changes, export the 
database from the workspace, back to the multiviewer.

Applying a backup database to the multiviewer
To restore a backup database, you must use XEdit in offline mode. A backup database must 
first be restored to your local workspace before it can be exported back to the appropriate 
multiviewer.

To restore a backup database
1 On the Configure menu, point to Database, and then click Restore backup.

A window appears, prompting you to locate a backup database.
2 Navigate to your central backup storage area, select the backup database you want to 

restore, and then click Open.
A message appears prompting you to confirm your choice.

3 Click Yes.

Once the operation completes, your XEdit workspace area will contain the restored 
database. You can now work on this database in offline mode, or export it back to the 
multiviewer.

TIP
Once you are satisfied with the location of your local workspace, on the 
Configure menu, point to Database, and then select the Do not prompt for 
the database path check box, to avoid being prompted every time you 
open XEdit.
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Introduction
In order to obtain the list of programs and elementary streams under each transport 
stream, you must connect to your Kaleido-IP / Kaleido-IP VM in online mode (see Using 
XEdit in Online Mode on page 28).

The supported stream types are:
• Any-Source Multicast (ASM)
• Source-specific multicast
• Source-filtered multicast (filtering limited to a single source IP in include mode only)
• Unicast
• RTSP
• RTMP
• HTTP Live Streaming (HLS)
• Uncompressed ST 2022-6 and ST 2110

Input Types - Network Sources Versus Virtual Inputs Explained
As of Kaleido Software version 9.20, Virtual Inputs are a new concept that has been added 
to Kaleido-IP multiviewers that differs from the traditional network Sources concept in a 
few ways. 

In XEdit, both network Sources and virtual inputs are found in the main window, under the 
System tab, and then the Description/Calibrations on the second level tab bar as shown 
below.

The differences between network Sources and virtual inputs are described below.

What is a Network Source?
Sources are representations of streams that are available to the Kaleido-IP multiviewer. In 
XEdit, sources are placed into folders labeled LAN1 to LAN6. Each of these folders 
corresponds to one of the multiviewer’s physical network adapter interfaces. Each physical 
network adapter interface is connected to an independent LAN (Local Area Network or IP 
switch) on which the source stream is made available. 

Network Sources
Virtual Inputs
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Once a stream has been added to a LAN, the Kaleido-IP multiviewer will periodically join 
the stream to analyze its structure (for example, to determine the amount and type of 
elementary streams and their associated PIDs) to make the information available in XEdit to 
allow users to make logical sources out of them. Typically, there is one monitoring logical 
source per video program, so a stream consisting in a Multi-Program Transport Stream 
(MPTS) with four video programs will need to be spread over four logical sources. Another 
example is a HLS stream consisting in four compression profiles. Each profile can be 
monitored by associating it with its own logical source.

Note that the Kaleido-IP multiviewer cannot discover the existence of a stream. The 
multicast address, unicast receiving port or HTTP URL must be manually specified or 
imported through a spreadsheet (for more information, see Importing an Input 
Configuration from a Spreadsheet, on page 58).

When a source is associated with a logical source, and that logical source is assigned to a 
monitor on the monitor wall, the stream becomes active. The transport stream is joined or 
HTTP downloads begin (depending on the type of source) and alarms like TS Loss are valid. 
Individual elementary streams composing the transport stream are only decoded if a 
corresponding monitor is present on the wall, in which case associated alarms are also 
valid. If an elementary stream is not displayed on the wall through a monitor, its alarms are 
in the pending state (unknown).

A network Source does not support uncompressed streams.

Adding Network Source Streams to the Multiviewer - Overview
If you have connected your Kaleido-IP to more than one Media Network, or you want to 
monitor sources from Unicast streams or from other types of transport streams, or more 
sources from Multicast streams, then you need to add transport streams to the basic system 
configuration. See:

• To add Any-Source Multicast (ASM) transport streams, see Adding Any-Source Multicast 
Transport Stream Sources on page 46.

• To add Source-Specific Multicast or Source-Filtered Multicast (SSM or SFM) transport 
streams, see Adding Source-Specific or Source-Filtered Multicast Transport Stream 
Sources on page 48.

• To add unicast transport streams, see Adding Unicast Transport Stream Sources on 
page 50.

• To add HTTP Live Streaming (HLS) playlists, see Adding HLS Playlist Sources on page 51.
• To add RTSP streams, see Adding RTSP Transport Stream Sources on page 53.
• To add RTMP streams, see Adding RTMP Transport Stream Sources on page 54.

What is a Virtual Input?
A virtual input is like a physical input of traditional SDI multiviewers. It represents a port 
that receives a stream and decodes it. 

A virtual input must be associated with a logical source to be able to view it on the wall. 
Typically, there is one logical source per virtual input. 

When using virtual inputs, the Kaleido-IP multiviewer does not know the existence of a 
stream until it has been instructed to join it, at which point it becomes immediately active 
(joined immediately) whether the logical source is viewed on the wall through a monitor or 
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not (this behavior is different from a Network Source). Some alarms like stream presence are 
immediately valid, whereas other alarms are pending until the stream is displayed on the 
wall.

To add uncompressed ST 2022-6 / ST 2110 stream Inputs, see Adding Virtual Inputs on 
page 64. 

Migration from Software Versions prior to Kaleido Software Version 9.20.
Virtual inputs were first introduced in Kaleido Software version 8.40. Prior to Kaleido 
Software version 9.20, they were configured in XEdit as NMOS DEVICES, found in the main 
window, under the System tab, and then the Description/Calibrations on the second level 
tab bar. When upgrading to Kaleido Software version 9.20 or higher, any NMOS DEVICES are 
converted into INPUTS. Such an upgrade will bring changes that are not backwards 
compatible with Kaleido Software versions earlier than 9.20. If a user installs Kaleido 
Software version 9.20 or higher and then decides to downgrade to a Kaleido Software 
version earlier than 9.20, the INPUTS folder will be empty and you will have to recreate the 
inputs or see Workaround below. The same applies to a user that exports a database from 
Kaleido Software version 9.20 (or higher) to a Kaleido Software version earlier than 9.20. 

Workaround: Before upgrading to Kaleido Software version 9.20 (or higher), make a 
database backup. When downgrading to a Kaleido Software version earlier than 9.20, 
restore this database backup to the multiviewer.

Kaleido-IP Multiviewer Ethernet Port Usage
For non-virtual machine (VM) Kaleido-IP multiviewers, refer to the multiviewer’s Installation 
& Service Manual for the correct multiviewer Ethernet port wiring connections. See Related 
Documentation, on page 11.

Default Kaleido-IP Network Source Configuration in XEdit
The default configuration for a Kaleido-IP system includes eight predefined any-source 
multicast (ASM) streams, located under LAN2. Before you can use these streams, you must 
adjust their settings to match the actual transport streams you want to monitor. To modify 
previously configured streams and playlists, see Modifying transport streams and HLS 
playlists on page 55. 

To remove streams from your system configuration, see Removing transport streams and 
HLS playlists on page 57.

Configuration Prerequisites
A URL path can be used to identify a source located on a remoter server to access HTTP, 
RTSP, RTMP, or Input streams. When using a URL, the multiviewer’s DNS server configuration 
must have been previously configured in XAdmin to allow the multiviewer to be able to 
resolve the URL to the stream server’s current network IP address. 

To configure the multiviewer’s DNS setting, open XAdmin, and navigate to DNS and proxy 
configuration under System configuration. Refer to Configuring a Multiviewer’s IP, Date, and 
Time Settings with XAdmin in the multiviewer’s Installation & Service Manual. See Related 
Documentation, on page 11.
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Configuring Network Sources
For more information about a Virtual Input, see What is a Network Source?, on page 43.

Adding Any-Source Multicast Transport Stream Sources
To add an Any-Source Multicast (ASM) Transport Stream

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second level tab bar.

2 Expand the System hierarchical list, and then click the appropriate LAN element, for the 
stream you want to add. See also Kaleido-IP Multiviewer Ethernet Port Usage, on 
page 45.
The supported stream types (Multicast, Unicast, HTTP, RTSP, RTMP) are listed on the 
Tools pane. 

3 Drag Multicast from the Tools pane onto the LAN adapter.

The Multicast Stream Configuration window appears.
4 In Multicast Stream Configuration, to replace the default stream name if necessary, 

select the appropriate protocol (RTP, UDP), and type the multicast group address and 
port number associated with the transport stream you want to add.

Notes

• The Kaleido Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.
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5 If the stream you want to add is constrained to a virtual LAN, select Virtual LAN 
tagging, and then type the appropriate VLAN identifier.

6 Click OK.
The Kaleido-IP establishes a connection with the selected stream. All programs that are 
part of the stream, and the elementary streams included in these programs, 
automatically appear under the transport stream element in the System list.

7 Repeat this procedure until you have added all required ASM transport streams to your 
system configuration.

8 On the File menu, click Save. Alternatively, click the toolbar’s Save button.
Changes to the system are saved.

Note: VLAN adapter settings must have been previously configured in 
XAdmin. See Configuring Virtual LAN Adapters on a Kaleido-IP in the 
Kaleido-IP’s Installation & Service Manual for more information. See 
see Related Documentation on page 11.

Note: Under the LAN elements, transport streams are listed in alphabetical 
order.

Transport stream
Program 1
Elementary streams (audio)

Elementary stream (video)

Group address

Protocol
Port number (or range)

Program 2
Elementary stream (video)

Elementary streams (audio)
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Adding Source-Specific or Source-Filtered Multicast Transport Stream 
Sources

To add a source-specific, or source-filtered multicast (SSM/SFM) transport stream
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate LAN element, for the 

stream you want to add. See also Kaleido-IP Multiviewer Ethernet Port Usage, on 
page 45.
The supported stream types (Multicast, Unicast, HTTP, RTSP, RTMP) are listed on the 
Tools pane.

3 Drag Multicast from the Tools pane onto the LAN adapter.

The Multicast Stream Configuration window appears.

4 In Multicast Stream Configuration, to replace the default stream name if necessary, 
select the appropriate protocol (RTP, UDP), and type the multicast group address and 
port number associated with the transport stream you want to add.

Notes

• The Kaleido Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.
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5 Select the Source specific multicast (SSM) check box, and then type the IP address 
associated with the specific source you want to monitor in the Source IP address box.

6 If the stream you want to add is constrained to a virtual LAN, select Virtual LAN 
tagging, and then type the appropriate VLAN identifier.

7 Click OK.
The Kaleido-IP establishes a connection with the selected SSM/SFM stream. All 
programs that are part of the selected stream, and the elementary streams included in 

Note: In the case of streams that are available from the same multicast 
group address and port number, you must enter the source IP address 
associated with a stream before you can add the next one.

Note: VLAN adapter settings must have been previously configured in 
XAdmin. See Configuring Virtual LAN Adapters on a Kaleido-IP in the 
multiviewer’s Installation & Service Manual for more information. See 
see Related Documentation on page 11.
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these programs, automatically appear under the transport stream element in the 
System list.

8 Repeat this procedure until you have added all required SSM/SFM transport streams to 
your system configuration.

9 On the File menu, click Save. Alternatively, click the toolbar’s Save button.
Changes to the system are saved.

Adding Unicast Transport Stream Sources
To add a unicast transport stream

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second level tab bar.

2 Expand the System hierarchical list, and then click the appropriate LAN element, for the 
stream you want to add. See also Kaleido-IP Multiviewer Ethernet Port Usage, on 
page 45.
The supported stream types (Multicast, Unicast, HTTP, RTSP, RTMP) are listed on the 
Tools pane.

3 Drag Unicast from the Tools pane onto the LAN element.

The Unicast Stream Configuration window appears.

Note: Under the LAN elements, transport streams are listed in alphabetical 
order.

Transport stream
Program 1
Elementary streams (audio)

Elementary stream (video)

Group address

Protocol
Port number (or range)

Program 2
Elementary stream (video)

Elementary streams (audio)

Source IP address
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4 In Unicast Stream Configuration, to replace the default stream name if necessary, 
select the appropriate protocol (RTP, UDP), type the port number associated with the 
transport stream you want to add, and then click OK.

The Kaleido-IP establishes a connection with the selected stream. All programs that are 
part of the stream, and the elementary streams included in these programs, 
automatically appear under the transport stream element in the System list.

5 Repeat this procedure until you have added all required unicast transport streams to 
your system configuration.

6 On the File menu, click Save. Alternatively, click the toolbar’s Save button.
Changes to the system are saved.

Adding HLS Playlist Sources

To add an HLS playlist
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate LAN element, for the 

stream you want to add. See also Kaleido-IP Multiviewer Ethernet Port Usage, on 
page 45.
The supported stream types (Multicast, Unicast, HTTP, RTSP, RTMP) are listed on the 
Tools pane.

Notes

• The Kaleido Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.

• Under the LAN elements, transport streams are listed in alphabetical order.

Note: Make sure the multiviewer’s DNS and proxy settings are properly 
configured for your network, and that NTP synchronization is enabled. Refer 
to the Kaleido-IP Installation & Service Manual for more information. See 
Related Documentation, on page 11.
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3 Drag HTTP from the Tools pane onto the LAN element.

The HTTP Stream Configuration window appears.

4 In HTTP Stream Configuration, to replace the default stream name if necessary, type 
the URL of the playlist you want to monitor, provide the appropriate authentication key 
if required, and then click OK.
In the URL, include the HTTP prefix: http://, for example: 
http://example.com/stream

The Kaleido-IP establishes a connection with the stream provider. In the System list, a 
master playlist element including all media playlists specified in the master playlist 
automatically appears under the LAN elements. All programs that are part of a media 
playlist, and the elementary streams included in these programs, automatically appear 
under the media playlist element.

Notes

• The Kaleido Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Both HTTP and HTTPS protocols are supported. If HTTPS is used, there 
must be a valid certificate for the connection to be established.

• Under the LAN elements, HLS master playlists and media playlists are 
listed in alphabetical order.

Program
Elementary stream (audio)
Elementary stream (video)

Source URL

Media
Master playlist element

playlists
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5 Repeat this procedure until you have added all required HLS playlists to your system 
configuration.

6 On the File menu, click Save. Alternatively, click the toolbar’s Save button.
Changes to the system are saved.

Adding RTSP Transport Stream Sources

To add an RTSP transport stream
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate LAN element, for the 

stream you want to add. See also Kaleido-IP Multiviewer Ethernet Port Usage, on 
page 45.
The supported stream types (Multicast, Unicast, HTTP, RTSP, RTMP) are listed on the 
Tools pane.

3 Drag RTSP from the Tools pane onto the LAN element.

The RTSP Stream Configuration window appears.

4 In RTSP Stream Configuration, to replace the default stream name if necessary, type 
the URL of the stream you want to monitor, select the appropriate protocol (RTP, UDP), 
and then click OK.
In the URL, include the RTSP prefix: rtsp://, for example: 
rtsp://example.com/stream

The Kaleido-IP establishes a connection with the selected stream. All programs that are 
part of the stream, and the elementary streams included in these programs, 
automatically appear under the transport stream element.

Note: Make sure the multiviewer’s DNS and proxy settings are properly 
configured for your network. Refer to the Kaleido-IP Installation & Service 
Manual for more information. See Related Documentation, on page 11.
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5 Repeat this procedure until you have added all required RTSP transport streams to your 
system configuration.

6 On the File menu, click Save. Alternatively, click the toolbar’s Save button.
Changes to the system are saved.

Adding RTMP Transport Stream Sources

To add an RTMP transport stream
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the appropriate LAN element, for the 

stream you want to add. See also Kaleido-IP Multiviewer Ethernet Port Usage, on 
page 45.
The supported stream types (Multicast, Unicast, HTTP, RTSP, RTMP) are listed on the 
Tools pane.

3 Drag RTMP from the Tools pane onto the LAN element.

The RTMP Stream Configuration window appears.

Notes

• The Kaleido Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.

• Under the LAN elements, transport streams are listed in alphabetical order.

Note: Make sure the multiviewer’s DNS and proxy settings are properly 
configured for your network. Refer to the Kaleido-IP Installation & Service 
Manual for more information. See Related Documentation, on page 11.
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4 In RTMP Stream Configuration, to replace the default stream name if necessary, type 
the URL of the stream you want to monitor, and then click OK.
In the URL, include the RTMP prefix: rtmp://, for example: 
rtmp://example.com/stream

The Kaleido-IP establishes a connection with the selected stream. All programs that are 
part of the stream, and the elementary streams included in these programs, 
automatically appear under the transport stream element.

5 Repeat this procedure until you have added all required RTMP transport streams to 
your system configuration.

6 On the File menu, click Save. Alternatively, click the toolbar’s Save button.
Changes to the system are saved.

Modifying transport streams and HLS playlists
You may need to modify previously created stream information:

• One or more transport streams or HLS playlists have been added to a LAN element.
• The default configuration for a Kaleido-IP system includes eight predefined any-source 

multicast (ASM) streams, under LAN2. Before you can use these streams, you must 
adjust their settings to match the actual transport streams you want to monitor.

To modify transport stream or HLS playlist settings 
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then navigate to the transport stream or 

master playlist you want to modify found under a LAN network interface. For example, 

Notes

• The Kaleido Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Under the LAN elements, transport streams are listed in alphabetical order.



56

Managing Sources in a Kaleido-IP System
Modifying transport streams and HLS playlists

a default multicast transport stream found under LAN2. See also Kaleido-IP Multiviewer 
Ethernet Port Usage, on page 45.

The settings for the selected stream or master playlist appear in the Properties pane.

Source settings (example showing settings for an any-source multicast stream)

Source settings (example showing settings for an HLS master playlist)

3 Replace the stream name if necessary and then, depending on the stream type:
• Select the appropriate protocol (RTP, UDP).
• Enter the multicast group IP address (in the case of a multicast stream) and port 

number associated with the actual transport stream you want to monitor.
• In the case of an SSM (or SFM) stream, enter the IP address associated with the 

specific source you want to monitor in the SSM source IP address box.
• In the case of a multicast stream constrained to a virtual LAN, enter the appropriate 

VLAN identifier.

• In the case of an HLS master playlist, RTSP stream, or RTMP stream, enter the 
new URL.

Note: VLAN adapter settings must have been previously configured in 
XAdmin. Refer to Configuring Virtual LAN Adapters on a Kaleido-IP in the 
Kaleido-IP Installation & Service Manual for more information. See Related 
Documentation, on page 11.
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The Kaleido-IP establishes a connection with the stream provider. In the case of an HLS 
playlist, a master playlist element including all media playlists specified in the master 
playlist automatically appears under the LAN elements, in the System list. All programs 
that are part of a transport stream or specified in a media playlist, and the elementary 
streams included in these programs, automatically appear under the transport stream 
or media playlist element.

Example showing programs and elementary streams for a single-source multicast stream

4 Repeat this until you have completed the required configuration changes to match the 
set of transport streams you want to monitor.

5 If there are default transport streams left, which you will not use, see Removing 
transport streams and HLS playlists, on page 57. 

6 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

Removing transport streams and HLS playlists
To remove transport streams or HLS playlists from your system configuration

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second level tab bar.

2 Expand the System hierarchical list, and then navigate to the master playlist or 
transport stream you want to remove.

3 If you want to remove multiple transport streams and master playlists in a single 
operation, then extend your selection by using the multi-selection Shift+click or 
Ctrl+click keyboard shortcuts.

Notes

• The Kaleido Software supports UTF-8 encoded stream names. The only 
characters, which cannot be used in a stream name are: @ / \ ' and ".

• Verify the protocol you selected. Registering an RTP stream as UDP instead 
of RTP may result in the decoded video appearing jerky or accelerated on 
the monitor wall.

• For HLS playlists, both HTTP and HTTPS protocols are supported.
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4 Right-click the selection, and then click Remove.

5 When prompted to confirm, click Yes.
6 On the File menu, click Save.

Changes to the system are saved. If you are not planning on adding the removed 
streams back to your system, then you might now want to remove logical sources that 
were based on them: see Removing logical sources for removed programs in a 
transport stream on page 74.

Importing an Input Configuration from a Spreadsheet
This feature only applies to creating Network Sources.

If you need to monitor a large number of programs, you may find it convenient to import 
related configuration information from a spreadsheet in XLS or XLSX format. Once this file 
has been imported, the logical sources associated with the programs specified in the 
spreadsheet will be automatically added to the sources table. A sample spreadsheet is 
available. See Software and Firmware Updates, on page 12.

Preparing a spreadsheet with stream lineup information
The spreadsheet file must contain the following:

• information about the programs you want to monitor, and the transport streams to 
which they belong,

• information about the logical sources that will be added to the sources table for these 
programs, including any static text levels you may want to add.

WARNING
Grass Valley recommends making a backup of your system before importing 
stream configuration information from a spreadsheet. When you import 
streams from a spreadsheet, this erases all previously imported streams and 
associated logical sources. It may also overwrite streams that you had 
manually added (and logical sources) if they have the same name or index as 
a stream whose configuration is being imported.

Notes

• Kaleido-IP X320, X310, X120 and X110 multiviewers support 6000 logical 
sources.
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The spreadsheet is organized as follows:
• Two heading rows. The first heading row divides the spreadsheet into four main areas:

• Programs. This area occupies the first column (A).
• Transport streams. This area spans columns B – G.
• Logical sources. This area spans columns H – J.
• Additional static text levels (optional). This area starts at column K, and can extend 

to as many columns as you need. Text you enter on the second heading row in this 
area will be imported.

• One row for every program you want to monitor.

To prepare the spreadsheet file
1 Using your spreadsheet software, either open a copy of the sample spreadsheet file or 

create a new spreadsheet.
2 Enter the information about a program, and the transport stream to which it belongs:

• In the case of the Kaleido-IP X300, to support more than 1500 sources, or 
to be able to use Kaleido Software version 7.90 or higher, the multiviewer’s 
RAM must be upgraded to 24 GB. To order an upgrade kit, contact Grass 
Valley Technical Support, on page 360 and order part number KIP-X300-
MEMORY-UPGRADE. The document Kaleido-IP X300 Memory Upgrade 
(M926-9907) procedure is supplied with the kit.

• The Kaleido-IP X100 is limited to 1500 sources. To be able to use Kaleido 
Software version 7.90 or higher, the multiviewer’s RAM must be upgraded 
to 16 GB. To order an upgrade kit, contact Grass Valley Technical Support, 
on page 360 and order part number KIP-X100-MEMORY-UPGRADE. The 
document Kaleido-IP X100 Memory Upgrade (M926-9807) procedure is 
supplied with the kit.

• RTSP, RTMP, HTTP or HTTPS streams cannot be imported from a 
spreadsheet.

In this column... Enter this information...

A Program number The program number (MPEG ID), for the program you want to 
monitor.

B Stream name A name to identify the transport stream that includes this 
program. Alternatively, you can leave this cell blank, in which 
case a default name will be created. Stream names that only 
contain digits and have decimal positions that are all zeros must be 
preceded with an apostrophe in the spreadsheet.

C Multicast group 
IP address

The multicast group IP address. In the case of a unicast stream, 
leave the cell blank.

D Port number The appropriate port number.

E SSM/SFM source 
IP address

In the case of a source-specific multicast (SSM) or source-filtered 
multicast (SFM) transport stream, enter the source IP address.

Notes (continued)
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Sample spreadsheet: Programs, and Transport streams areas

3 Enter the information that will be used to create the logical source associated with this 
program:

F Protocol RTP or UDP.

G NIC The LAN identifier: see Kaleido-IP Multiviewer Ethernet Port 
Usage, on page 45 for Ethernet port usage information. 
The number of LANs varies depending on the Kaleido-IP model 
(see Representation of Multiviewer Models in Kaleido Software 
on page 23).

In this column... Enter this information...
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Sample spreadsheet: Logical sources area

In this column... Enter this information...

H Index If your system involves a control panel from which you control 
your multiviewer as a router, set a source number for the logical 
source associated with this program to be available through the 
KX Router logical router, by entering the appropriate number in 
this column. Source numbers must be unique.

I Category Text in this column can be used to group related logical sources 
together, when you sort the sources table in XEdit (see Sorting 
the Sources Table on page 85). The category text can have up to 
200 characters.

J Name The name of the logical source. Names are limited to 
48 characters. Logical source names that only contain digits and 
have decimal positions that are all zeros must be preceded with an 
apostrophe in the spreadsheet.
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4 Optionally, use the columns, starting at column K, to add static text levels. Enter the 
level name on the second heading row.

Sample spreadsheet: Additional static text levels area

Static text level names and data that only contain digits and have decimal positions that 
are all zeros must be preceded with an apostrophe in the spreadsheet.

5 Repeat this procedure until you have added the required information for all the 
programs you want to monitor.

To import a set of streams from a spreadsheet file
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 On the File menu, click Import.

XEdit prompts you for confirmation.

3 Click OK to continue, if you are confident that you have a backup so that you can 
restore your system if needed - see Creating a Backup, on page 33.

4 Navigate to the spreadsheet file you want to import, select it, and then click Open.
XEdit validates the following: IP address range, LAN number, protocol, consistency of 
stream name vs. stream information (group and source IP addresses + port), duplicate 
stream names, duplicate logical source information (category + name), duplicate 
logical source index, and will report any error. If no errors were found, then the 
following message appears.
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5 Click OK to continue.
The streams appear under the specified LANs.

Example showing streams imported from the sample spreadsheet file.

After a few minutes, if XEdit is connected to the multiviewer, all programs included in 
the transport streams are discovered.

In addition, logical sources for the programs listed in the spreadsheet you imported are 
automatically added to the sources table. If XEdit is not connected to the multiviewer, 
then the new sources’ video levels appear in red in the sources table. In such case, the 
sources table will be updated when you work in online mode once you have exported 
the database to the multiviewer.

Should you want to add audio, dynamic text, alarm and time code levels to these 
logical sources, you may complete all physical assignments for one logical source, 
which you can then designate as the template. By applying the template, you will be 
able to populate the remaining levels in a single operation. See Defining Physical 
Assignments on page 79, for more information.

Note: The set of discovered programs does not necessarily match the 
programs listed in the spreadsheet. The discovery being a dynamic process, 
it may find more (or less) programs.

Imported streamsImported streams

Logical sources created
from imported programs
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Configuring Virtual Inputs
For more information about a Virtual Input, see What is a Virtual Input?, on page 44.

Adding Virtual Inputs 
Add virtual inputs to an INPUT element as follows.

To add an Input device
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and then click the INPUTS element.
3 Drag Input Device from the Tools pane onto the INPUTS element. 

4 In Insert virtual input(s), set the quantity of virtual inputs to create, and then click OK. 

A predefined Input device skeleton appears under INPUTS, in the System list. The 
source stream must be configured for each individual INPUT.

5 Expand the System hierarchical list and select a numbered input. 

The settings for the selected input appear in the Properties pane.
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6 Click Edit in the Properties pane.
The Virtual Input Configuration screen opens.

7 Configure the input streams for video, audio channels, and teletext sources.
Certain multiviewers support uncompressed input streams.

Refer to the multiviewer’s Installation & Service Manual for how to configure it to use 
uncompressed streams, if applicable. See Related Documentation, on page 11. 

Virtual Input Configuration settings 

Kaleido-IP X310 / X110 Kaleido-IP X320 / X120 Kaleido-IP VM
 

Parameter Description

URL Enter the URL (in the form rtp://<ip_address>:<port>) associated with 
the transport stream you want to monitor. When the multiviewer has 
been configured to use NMOS, this parameter can be remotely 
controlled through IS-05 so that the virtual input will pickup an SMPTE 
ST 2022-6 / ST 2110 streams. Refer to the multiviewer’s Installation & 
Service Manual for how to configure it to use NMOS. See Related 
Documentation, on page 11.

Label Optionally enter a descriptive label for the stream.

LAN Select the LAN port (and the network) that has IP connectivity to the 
stream’s source. See also Kaleido-IP Multiviewer Ethernet Port Usage, 
on page 45.
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8 Click OK.
The configuration information for this input is shown in the Properties pane.
The Kaleido-IP starts receiving the stream. Stream elements that are present are shown 
in black. Unavailable elements are grayed out.

Example showing the programs and elementary streams of a Virtual Input

Once an input has been created for each source, you can assign these logical sources to 
monitors in a layout.

Media type The transport standard used by the stream:
• Receiver: VIDEO

• ST2022-6: Standard to transport video over an IP network.
• MPEG-TS: Use MPEG transport stream mapping. 
• ST2110-20 (video): Standard to transport video over an IP network.

• Receiver: AUDIO_x
• ST2110-30 (audio): Standard to transport audio over an IP network. 

Multiple audio streams can be configured to support, for example, 
stereo audio (AUDIO_1), another for surround sound (AUDIO_2), and 
yet another for a second language (AUDIO_3).

• Receiver: DATA_ANC
• ST2110-40: Standard to transport ancillary data over an IP network 

(for example, Ancillary Timecode (ATC), EIA-708, OP-47 Teletext).
Note: The corresponding video stream (ST 2110-20) also must be 
joined in order to display the metadata properly.

Program 
number

The program number (MPEG ID), for the program you want to monitor.
This is only shown with the MPEG-TS option

Channels Set the number of audio channels for the stream (1, 2, 4, 6, 8, or 16 
channels). For example, use 2 for stereo, and 6 for surround sound (5.1).

Frequency Set the audio sampling rate frequency. This is always 48 kHz.

Clear Click to deallocate this virtual input. This stops the currently-configured 
stream from using network bandwidth.

Parameter Description

Stream elements

Stream
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Modifying Virtual Inputs
You may need to modify previously created virtual inputs that have been added to an 
INPUT element.

To modify virtual inputs settings 
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second level tab bar.
2 Expand the System hierarchical list, and under INPUTS, navigate to the virtual input 

you want to modify.

The settings for the selected virtual input appears in the Properties pane.

3 Click Edit in the Properties pane.
The Virtual Input Configuration screen opens.
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4 Configure the input stream’s source.
Certain multiviewers support uncompressed input streams.

Refer to the multiviewer’s Installation & Service Manual for how to configure it to use 
uncompressed streams, if applicable. See Related Documentation, on page 11. 

Virtual Input Configuration settings 

Kaleido-IP X310 / X110 Kaleido-IP X320 / X120 Kaleido-IP VM
 

Parameter Description

URL Enter the URL (in the form rtp://<ip_address>:<port>) associated with 
the transport stream you want to monitor. When the multiviewer has 
been configured to use NMOS, this parameter can be remotely 
controlled through IS-05 so that the virtual input will pickup an SMPTE 
ST 2110 stream. Refer to the multiviewer’s Installation & Service 
Manual for how to configure it to use NMOS. See Related 
Documentation, on page 11.

Label Optionally enter a descriptive label for the stream.

LAN Select the LAN port (and the network) that has IP connectivity to the 
stream’s source. See also Kaleido-IP Multiviewer Ethernet Port Usage, 
on page 45.
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5 Click OK. 
The configuration information for this input is shown in the Properties pane.
The Kaleido-IP starts receiving the stream. Stream elements that are present are shown 
in black. Unavailable elements are grayed out.

Example showing the programs and elementary streams of a Virtual Input

6 Repeat this until you have completed the required configuration changes to match the 
set of virtual inputs you want to monitor.

Media type The transport standard used by the stream:
• Receiver: VIDEO

• ST2022-6: Standard to transport video over an IP network.
• MPEG-TS: Use MPEG transport stream mapping. 
• ST2110-20 (video): Standard to transport video over an IP network.

• Receiver: AUDIO_x
• ST2110-30 (audio): Standard to transport audio over an IP network. 

Multiple audio streams can be configured to support, for example, 
stereo audio (AUDIO_1), another for surround sound (AUDIO_2), and 
yet another for a second language (AUDIO_3).

• Receiver: DATA_ANC
• ST2110-40: Standard to transport ancillary data over an IP network 

(for example, Ancillary Timecode (ATC), EIA-708, OP-47 Teletext).
Note: The corresponding video stream (ST 2110-20) also must be 
joined in order to display the metadata properly.

Program 
number

The program number (MPEG ID), for the program you want to monitor.
This is only shown with the MPEG-TS option

Channels Set the number of audio channels for the stream (1, 2, 4, 6, 8, or 16 
channels). For example, use 2 for stereo, and 6 for surround sound (5.1).

Frequency Set the audio sampling rate frequency. This is always 48 kHz.

Clear Click to deallocate this virtual input. This stops the currently-configured 
stream from using network bandwidth.

Parameter Description

Stream elements

Stream
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7 If there are virtual inputs left which you will not use, see Removing Virtual Inputs, on 
page 70. 

8 On the File menu, click Save. Alternatively, click the Save button on the toolbar.
Changes to the system are saved.

Removing Virtual Inputs
To remove virtual inputs from your system configuration

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second level tab bar.

2 Expand the System hierarchical list, and then navigate to the virtual input you want to 
remove.

3 If you want to remove multiple virtual inputs in a single operation, then extend your 
selection by using the multi-selection Shift+click or Ctrl+click keyboard shortcuts.

4 Right-click the selection, and then click Remove.

5 When prompted to confirm, click Yes.
6 On the File menu, click Save.

Changes to the system are saved. If you are not planning on adding the removed 
streams back to your system, then you might now want to remove logical sources that 
were based on them: see Removing logical sources for removed programs in a 
transport stream on page 74.
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Introduction
This chapter explain how to configure logical sources for your multiviewer system.

Key Concepts

Term Description

Logical source A logical source (called a channel, in earlier versions of the Kaleido 
Software user interface, and related documentation) refers to a group of 
physical audio, video, or metadata sources, and text attributes. A logical 
source can be used as a whole, and assigned to a virtual monitor. The 
Kaleido Software supports up 7000 logical sources.
Notes:
• Kaleido-IP X320, X310, X120, and X110 multiviewers support up to 

6000 logical sources. 
• If you choose to configure your multiviewer system with a large 

number of logical sources (for example, more than 1500), you should 
disable global alarm contribution for all alarm levels in the sources 
table (see Global Alarms on page 118), to improve the system 
performance. When you save the sources table, if there are more than 
1500 sources, XEdit prompts you to let it disable these contributions for 
you.

Level Within a logical source, attributes are organized by levels belonging to 
either of the following categories: Source info, Video, Audio, Text, Alarm, 
Time code, and Color. For example, the video level category may 
comprise multiple levels, each representing a specific physical part of a 
video signal.

Incremental copy Once a logical source (channel) is configured, it is possible to use 
incremental copy to automatically propagate appropriate physical 
assignments to other adjacent logical sources. For instance, if the current 
logical source’s levels are assigned from Video 1, then the incremental 
copy tool will automatically assign corresponding physical elements 
from Video 2 to the next logical source’s levels, and so on. Alternatively, if 
only one or a few specific levels are to be similarly configured, it is 
possible to use incremental copy on the corresponding level column 
only.

Incremental copy 
handle

In the sources table, the incremental copy handle is indicated by a small 
square  at the bottom right of the selected cell.
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Creating and Configuring Logical Sources
When opening XEdit in offline mode, the initial database is populated with the default 
configuration for a Kaleido-X (7RU) system, including a fully-populated frame (all cards 
present) and a set of predefined logical sources. The KX Router logical router is also created 
as a 96 × 80 router where the 96 inputs are the multiviewer’s logical sources, the first 48 
outputs are those from the two router cards, and the last 32 outputs are monitor wall 
destinations.

Likewise, when you replace the initial Kaleido-X (7RU) with the appropriate multiviewer 
model that matches your actual system, you can choose to have your local database 
populated with a default set of logical sources and a preconfigured KX Router logical router.

Automatically Adding Logical Sources
A set of logical sources based on external video router sources or on multiviewer inputs can 
be added to the sources table, as a single operation, by clicking Create logical sources on 
the menu that appears when you right-click supported elements in the filtered system list. 

Alternatively, in the case of a Kaleido-IP, a set of logical sources is also automatically created 
if you import the stream lineup from a spreadsheet file (see Importing an Input 
Configuration from a Spreadsheet on page 58).

About Automatic Sources Creation
From the same menu, you can also set Activate automatic sources creation if you want the 
multiviewer to create new logical sources automatically with the same settings as existing 
programs when the multiviewer detects new program elements as they become available 
in the transport stream. Similarly, when sources are added or modified in a router’s own 
configuration environment, logical sources will be added or updated automatically in the 
multiviewer’s sources table.

The Activate automatic sources creation option only creates new logical sources from newly 
detected program streams. When a program stream is no longer present, or when a router 
source is no longer present, this feature does not automatically remove the corresponding 
logical source that was automatically created. You must do this manually. See Removing 
logical sources for removed programs in a transport stream, on page 74. Only remove 
logical sources for programs that you know will never return, as a rediscovered program 
stream will be created with a new internal ID that will not match up with the ID of the first 
instance. This means that you will have to reassign the channel/sources to the monitors. 

To define logical sources for a transport stream

This procedure shows how to add “On Demand” Network Sources and “On Demand” 
Router Sources which are activated only when they are displayed through a logical source. 
See also Logical Sources, on page 18

A Kaleido-IP multiviewer is used to illustrate the following procedure, however, the same 
procedure applies to all types of multiviewer inputs, including inputs from “On Demand” 
Router Sources.

1 In the main window, click the Channels/Sources tab.
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2 On the Tools pane, expand the multiviewer, and navigate to the transport stream for 
which you want to define logical sources.

3 Right-click the transport stream, and then click Create logical sources on the menu. 
See also About Automatic Sources Creation, on page 72.

Logical sources are automatically created for every program signal found in the 
selected transport stream.

4 Repeat until you have added logical sources for every stream you want to monitor.
5 If your system involves a control panel from which you will control your multiviewer as 

a router, then configure source numbers for the KX Router logical router, by typing the 
appropriate numbers in the first column (#) under Source info, and using the 
incremental copy tool as needed.

Notes
• Under Source info, dynamic and static names resulting from the Name 

level assignments are limited to 48 characters and automatically 
truncated as needed.

• If the case of router sources, if the router is subject to frequent dimension 
changes, then you may want to select Activate automatic sources 
creation.

• Auto detected Level assignments follow reference “template” channel, 
identified by a “T” icon.
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6 On the File menu, click Save.

Managing Logical Sources Associated with Programs in a Transport Stream
In the case of a Kaleido-IP system, you may need to add or remove sources, from time to 
time, when programs are added or removed from a transport stream.

Adding logical sources for new programs in a transport stream
To add a logical source for a new program in a transport stream

1 Connect XEdit to the Kaleido-IP (see Using XEdit in Online Mode on page 28), and then 
click the Channels/Sources tab.

2 On the Tools pane, navigate to the transport stream that includes the new program.
3 Right-click the program, and then click Create logical sources on the menu.

A new entry appears in the sources table, with all assignments based on the logical 
source template (see Defining Physical Assignments on page 79).

4 On the File menu, click Save.

Removing logical sources for removed programs in a transport stream

To remove logical sources associated with programs that are not present anymore
1 Connect XEdit to the Kaleido-IP (see Using XEdit in Online Mode on page 28) and then 

click the Channels/Sources tab.

Note: Under Source info, dynamic and static names resulting from the 
Name level assignments are limited to 48 characters and automatically 
truncated as needed.
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Logical sources associated with programs that have been removed from a transport 
stream will have elements marked in red.

2 Select these sources (using the multi-selection Shift+click or Ctrl+click keyboard 
shortcuts to extend your selection as needed).

3 Right-click the selection, and then click Delete selected sources on the menu.

4 On the File menu, click Save.
5 Click the Layouts tab, open the appropriate layouts, locate any monitors that included 

assignments based on the sources you just deleted, and update their configuration as 
required (see Assigning Logical Sources or Monitor Wall Destinations to Monitors on 
page 185).

Manually adding a Logical Source
To add a logical source

1 Click the Channels/Sources tab in the main window.
The sources table appears.



76

Logical Sources
Manually adding a Logical Source

2 On the File menu, click New.
Alternatively right-click the Channels/Sources column heading, and then click Add 
source on the menu.

A logical source is added at the bottom of the sources table.

Note: The sources table is preconfigured with a set of default assignments, 
including at least one level under each level category.

Notes
• Under Source info, you can change the logical source name and path, 

resulting from the Name and Cat. level assignments. For example, 
“Channel 1” can be renamed “Cam 1” or assigned a dynamic name. You 
can group related logical sources together, by adding static or dynamic 
text elements to the Cat. level, and then sorting the table as needed, to 
suit your purposes (see Sorting the Sources Table on page 85). You can 
also apply a filter to the table, so that sources that do not match the filter 
be hidden from view (see Filtering the Sources Table on page 85).
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3 On the File menu, click Save.
The sources table is saved.

Managing Levels

Adding a level

To add a level
1 Click the Channels/Sources tab in the main window.

The level categories Video, Audio, Text, Alarm, Time code, and Color appear as main 
column headings in the sources table.

2 Right-click the appropriate level category, and then click Add level on the menu.

A new level appears under the selected category.

3 If you want to change the level name, click the level header, and then, in the Properties 
pane, type the new name in the Level name box.

• When a logical source’s name or category changes, the row header is 
updated accordingly.

• When applying an overall incremental copy (from the row header), the 
Source info columns and the Video levels are excluded. These columns 
must be incremented individually. The overall incremental copy features 
relies on a video level having been populated first.

Note: To be able to monitor a 3D stereoscopic signal, you must first add a 
second video level to your logical sources (so you have a level for each eye), 
and then for each video monitor or composite you want to use for 
3D monitoring, you must assign the left-eye and right-eye levels.

Level
categories

Add level
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In the case of an alarm level, you may also set its contribution to your system’s global 
alarms. See Configuring an alarm level’s contribution below.

4 On the File menu, click Save.
The sources table is saved.

Configuring an alarm level’s contribution
You can select which alarm levels contribute to the global alarm associated with every 
logical source (see Global Alarms on page 118), and rank their individual contribution.

To configure an alarm level’s contribution to your system’s global alarms
• In the sources table, click the column header for the level you want to configure.

The Properties pane shows the name of the selected alarm level, and its current 
contribution settings.

• If you want to exclude alarms in this level from the global alarm calculation, then 
clear the Include in global alarm check box.

• To rank this level’s contribution to your system’s global alarms, click the Global 
alarm contribution box, and then select the appropriate value from the list.

• Passthrough: This is the default value. Alarms in this level will pass their status 
unaltered to the global alarms.

• Critical, Major, Minor, Disabled: It is possible to override the error status of 
alarms when they are triggered. This is useful when, for example, a device is 
only able to report a status of either normal or error, but you want the error 
condition to be considered as minor in the global alarm calculation.

• Invert: Alarms in this level will pass the opposite of their status to the global 
alarms. This can be used, for example, to report alarms from GPI inputs, or to 

Selected alarm level
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handle cases where an error is expected, and not seeing an error is a sign that 
something probably went wrong. See Inverting an alarm, on page 128.

• Faults only: Alarms in this level will be mapped to normal unless their status is 
one of the fault statuses—usually critical, major, and minor.1

Defining Physical Assignments
Once you have created a logical source, you must make the physical assignments. This is 
required before you can create a layout.

To make the physical assignments for a logical source
1 In the sources table, click the cell that corresponds to the level you want to define for 

this logical source.
2 On the Tools pane, expand the filtered System list, and then drag the appropriate 

element from the list, to the selected level in the sources table.
For a typical logical source, you will normally start by making a video assignment, set 
the appropriate category and source ID (under Source info) if you want to control your 
multiviewer system as a router, and then proceed with the audio, text, alarm, time code, 
and color levels. See, for example, Configuring text level assignments, on page 80, 
Configuring alarm level assignments, on page 80, Configuring logical sources based on 
external alarm providers, on page 81, and Configuring color level assignments, on 
page 82.

Sources table with a selected cell in the Video level category for Channel1

3 Repeat this procedure until all required physical assignments are completed for this 
logical source.

4 If you want to be able to use this logical source as a template, right-click the source 
header and then click Set source as template on the menu.

1.The list of fault status can be modified by scripting.

Note: Under Source info, dynamic and static names resulting from the 
Name level assignments are limited to 48 characters and automatically 
truncated as needed.
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Once you have added the required number of logical sources, and made appropriate 
video assignments, you will be able to populate remaining levels in a single operation 
by applying the template. If you have enabled automatic sources creation for an 
external router, then automatically-created logical sources will be based on the 
template.

Configuring text level assignments

To assign a text element to a logical source’s text level
1 Click the Channels/Sources tab in the main window.
2 In the sources table, click the cell that corresponds to the logical source and text level 

you want to configure.
3 Expand the filtered System list on the Tools pane, locate the text element, and then 

drag it onto the selected cell in the sources table.

4 On the File menu, click Save.
The sources table is saved.

Configuring alarm level assignments

To assign an alarm to a logical source’s alarm level
1 Click the Channels/Sources tab in the main window.
2 In the sources table, click the cell that corresponds to the logical source and alarm level 

you want to configure.

Note: Under Source info, dynamic and static names resulting from the 
Name level assignments are limited to 48 characters and automatically 
truncated as needed.
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3 Expand the filtered System list on the Tools pane, locate the alarm, and drag it onto the 
selected cell in the sources table.

4 On the File menu, click Save.
The sources table is saved.

Configuring logical sources based on external alarm providers
To have access to alarms and text elements from an external alarm provider, you must have 
specified this provider in your multiviewer system configuration (see Managing Alarm 
Providers on page 126).

To assign an alarm or a text element from an external provider
1 Open a GSM alarm browser associated with the alarm provider you want to use.

For example, after opening iControl Navigator, click General status managers on the 
View menu. Refer to the iControl User Guide for more information. See Related 
Documentation, on page 11.

2 In XEdit, click the Channels/Sources tab in the main window.
3 In the GSM alarm browser, navigate to the element you want to assign, and then drag it 

onto the cell that corresponds to the alarm or text level you want to configure in the 
sources table.
In the selected cell, the prefix “EXT” indicates that the assignment is from an external 
source and is followed with information such as the device class and a name.
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4 On the File menu, click Save.
The sources table is saved.

Configuring color level assignments
You may configure sources with color levels so that you can distinguish them at a glance on 
the monitor wall. For example, your sources could have three color levels: one that you 
would apply to a monitor’s border color, one to a UMD’s background, and one to the UMD 
text.

To configure a logical source’s color levels
1 Click the Channels/Sources tab in the main window.
2 In the sources table, double-click the cell that corresponds to the logical source and 

color level you want to configure.
The color picker window opens.

3 In Colors, click the tab that corresponds to the color space you want to use, and then 
choose the color that will be associated with the selected source and color level.

Notes
• You can select multiple elements in the GSM alarm browser (by pressing 

Shift+click or Ctrl+click as needed) and assign them to consecutive logical 
sources at once, by dragging the multiple selection to the appropriate 
level for the first logical source you want to configure. The elements are 
inserted in the same order you selected them.

• Drag an alarm folder to an alarm level to monitor the folder’s status. 
Dragging an alarm folder to a text level is not supported.

• GSM alarms are not available as triggers for background actions 
(see Creating Background Actions on page 267).

• Incremental copy is not supported in the case of assignments from 
external providers (see Making Further Assignments by Incremental Copy 
on page 83).
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4 Click OK to close the color picker window.
The color you chose appears in the sources table.

5 Repeat from step 2 until you have configured all color levels for this source.
6 On the File menu, click Save.

The sources table is saved.

Making Further Assignments by Incremental Copy
Once done with a first logical source, if the next logical source is to be similar to the first 
one, it is possible to use incremental copy to automatically create it. Alternatively, if only 
one or a few specific levels are to be similarly configured, it is possible to use incremental 
copy on the corresponding level column only.

To use the incremental copy tool to propagate physical assignments to adjacent logical 
sources

1 Click the row header for the logical source whose assignments you want to propagate.
A small square, the incremental copy handle, appears in the bottom right corner of the 
header cell.

Note: Color levels are not subject to incremental copy.
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2 Move the pointer to the incremental copy handle. The pointer changes to crosshairs.

3 Click and drag to propagate the selected logical source’s physical assignments to the 
next logical sources’ levels.
The source cells are highlighted with a green border and the target cells with a red 
border.

4 Release the mouse button once you have reached the last logical source to be 
configured.
The level cells are now populated with “incremented” physical assignments.

Note: It is possible to drag the incremental copy handle up, or down. The 
physical assignments will be decremented or incremented accordingly.

Incremental copy handle
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Sorting the Sources Table
To sort the sources table

• Right-click the heading of the column you want to sort by (for example,, either by 
Source ID, or any of the level headings), and then click Sort on the menu.

The sources table is sorted, based on the elements in the selected level.

Filtering the Sources Table
To filter the sources table

• Type in the Cat./Name filter box, located above the sources table.

Logical sources with categories and names that do not match the text or regular 
expression are hidden as you type.

Notes

• The filter is not applied to new logical sources that have yet to be saved. 
They will remain visible, until you saved the sources table.

Cat./Name
filter

Filter text

Example: Type “input f” 
to view only the sources 
that belong to Input F.
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Resizing the Sources Table’s Columns
To resize a column manually

• In the category or level heading row, point the column boundary you want to move 
until the pointer becomes a resize pointer ( ), and then drag the boundary to resize.

To resize a column to the width of its content
• In the category or level heading row, point either boundary for the column you want to 

resize to fit, until the pointer becomes a resize pointer ( ), and then double-click.
The column width is adjusted to fit the content.

To resize all columns to the width of their content
• In the category or level heading row, point any column boundary until the pointer 

becomes a resize pointer ( ), and then triple-click.
All columns are resized to fit their content.

• It is always possible to apply the template source to other logical sources, 
even when this specific source is hidden.

• Apply template to all sources affects all logical sources, regardless of 
filtering.

• The incremental copy tool affects visible sources only.

Notes (continued)

Note: If there are more than 250 rows in the sources tables, when you 
double- or triple-click, the columns are adjusted to fit the content of the 
currently visible rows only.
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Monitoring Internal-Router Outputs on the Monitor Wall (Sample 
Scenario)

It is possible, for specific monitoring purposes, to configure a video monitor so that it 
displays the current signal at a physical output from the multiviewer's internal router, by 
assigning this router output to a logical source’s video level.

To configure a monitor to follow an internal-router output on the monitor wall
1 Click the Channels/Sources tab in the main window.
2 Add a logical source to the table (see Manually adding a Logical Source, on page 75).
3 In the new logical source row, click the cell that corresponds to the first video level.
4 Expand the filtered System list on the Tools pane, locate the router output you want to 

monitor, and then drag it onto the selected cell in the sources table.
5 On the File menu, click Save. 

The sources table is saved.
6 Click the Layouts tab, and open the appropriate layout.
7 From the Channel/Sources list on the Tools pane, drag the new logical source onto the 

monitor you want to configure, and then save the layout.

Once such a logical source is available, you can also assign it to other composite or 
video monitors, directly on the monitor wall, and their video window will dynamically 
follow the video signal sent to that router output.

Note: The current version of the Kaleido Software does not support 
monitoring of the associated audio signal.
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Introduction
A Kaleido multiviewer system includes a number of cards or modules that process a variety 
of signal types. This section explains how to calibrate features related with the different 
signal types.

Key Concepts

Profiles

IMPORTANT

Calibration changes are applied immediately
Unlike other elements in a multiviewer configuration, system calibrations do 
not need to be saved.
• When using XEdit in online mode, calibration changes become 

immediately effective.
• When using XEdit in offline mode, calibration changes are applied to the 

system representation in your local workspace.

Calibration changes are synchronized
When you export a database to a multiviewer, the latest calibrations prevail 
(for example, if the database you export is from a backup that included 
earlier calibration changes, or if calibrations were changed by using XEdit in 
offline mode, then any calibrations that were also changed in the meantime 
on the multiviewer itself, by using XEdit in online mode, will remain effective 
after the export).

Profile With the current version of the Kaleido Software, profiles are available 
for Kaleido-IP multiviewers only. A profile is a group of calibrations that 
you configure for a specific purpose, and then apply to specific 
elementary streams, or transport streams, as needed. A default audio 
profile, a default video profile, a default teletext profile, a default SCTE 35 
profile, and a default transport stream profile are available with set 
calibrations. You may add custom profiles to your system, and configure 
them as needed. See Managing Calibration Profiles on page 93.

Video profile Video profiles include video input calibrations: alarm debouncing, 
metadata holding time, and presence timeout parameters.

Audio profile Audio profiles include audio input calibrations: a zero VU reference level 
calibration, alarm threshold calibrations, alarm debouncing, and 
loudness calibrations.
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Multiviewer Input Calibrations

Alarm Debouncing
Alarm debouncing allows the filtering of false alarms. Two parameters can be calibrated: 
the time required for an alarm event to be present before the system considers it to be valid 

Teletext profile Teletext profiles include calibrations for page selection, subtitling 
holding time, alarm debouncing, and text presence timeout parameters.

SCTE 35 profile SCTE 35 profiles include calibrations for digital program insertion (DPI) 
signaling (for example, splice events, DTMF break sequences, timing 
information), and a signaling timeout calibration.

Transport stream 
profile

Transport stream (TS) profiles include calibrations for TR 101 290 first- 
and second-priority fault-reporting indicators.

Aspect ratio Unlike HD signals where aspect ratio information, when available, always 
follows the SMPTE ST 2016 standard, there are different standards for 
encoding aspect ratio information in SD signals. The AFD & WSS 
calibrations determine which standard will be applied by default to SD 
signals feeding the selected multiviewer input. The aspect ratio of video 
windows on the monitor wall can then be automatically adjusted, based 
on the current source assignment. See Calibrating Aspect Ratio 
Decoding on page 105.

Subtitling/closed 
captioning

Presence alarms can be configured for up to four preset Teletext (WST) 
subtitle pages for each input signal. There are also subtitling calibrations 
for the CEA-608 CC and the DTVCC alarms. See Calibrating 
Subtitling/Closed Captioning on page 107.

Metadata holding 
time

The holding time parameters determine the delay after which decoded 
metadata such as closed captions, teletext subtitles, or XDS metadata 
will be cleared. This requires the CC/XDS option to be enabled (see the 
multiviewer’s Installation & Service Manual for more information). See 
Calibrating Metadata Holding Time, on page 107 for details.

Zero VU (dBFS) The Zero VU (dBFS) parameters determine the reference level to be 
applied to the selected digital (embedded, or from ABT) audio signal. 
dBFS stands for decibels full scale. Zero dBFS corresponds to the 
maximum possible level. By default the reference level for it is set to 
-20 dBFS, on a range of -24 dBFS to -8 dBFS. See Calibrating Zero VU 
Reference Levels for Embedded Audio Sources, on page 104 for details.

Audio loudness A measure of the perceived loudness of a group of audio channels (an 
audio program). Various measurement modes are available depending 
on the hardware being used. It is possible to configure an alarm that will 
be triggered when the measured loudness deviates too far from a target 
specified either by a standard or by your organization.
• Compliant with recent standards (EBU R128, ATSC A/85, ARIB TR-B32) 

and provide two measures (short term, and momentary) per audio 
program. The Kaleido-IP supports loudness probing of audio streams 
with a sampling rate of 48 kHz only.
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(to avoid false triggering of alarms), and the time required for an alarm state to be normal 
before the system actually clears the alarm (to avoid false releasing of alarms).

An alarm is triggered when a probe is in a continuous error state for the number of seconds 
specified in the Set duration debouncing parameter. In most cases, the alarm status will 
revert to normal by default, as soon as the probe returns a normal state. To delay the 
releasing of an alarm, you can change its Clear duration parameter.

• For TR 101 290 fault-reporting indicators, the default debouncing parameters are as 
follows:

• For all other alarms, the default debouncing parameters are as follows:

Attribute Default value Range Description

Set duration 0 seconds 0 s – 300 s By default, TR 101 290 faults are reported as 
soon as they are detected.

Clear duration 5 seconds 0 s – 90 s Once the fault condition is no longer 
detected, this is the time interval to wait 
before resetting the alarm.

Attribute Default value Range Description

Set duration 15 seconds 0 s – 300 s This is the time interval to wait before 
triggering an alarm once a probe has been in a 
continuous error state.

Clear duration 0 seconds 0 s – 90 s Once a probe has returned to a normal state 
(the alarm condition is no longer detected), 
this is the time interval to wait before 
resetting the alarm.

Notes

• In the case of video freeze alarms, the default debouncing settings are 
appropriate for most purposes, when the intention is to detect a freeze. 
Note, however, that it may take up to one second (two seconds, in the case 
of a Kaleido-IP) more than the value of the Set duration parameter to 
trigger a video freeze alarm. On the other hand, if your situation requires 
detecting movement (e.g, to detect that nothing is put on air during an off-
air period) then you may need to set an appropriate reset delay for this 
alarm (such as 5 seconds) by using the Clear Duration parameter.

• In the case of video black, video luma too high, and teletext presence alarms, 
it may take up to one second more than the value of the Set duration 
parameter to trigger these alarms, and it may take up to one second more 
than the value of the Clear duration parameter before the system clears 
them.

• In the case of V-chip loss alarms, the Set duration parameter should be at 
least 3 seconds, in order to avoid false alarms.
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See Configuring Alarm Debouncing on page 101, for more information.

• As of version 6.60 of the Kaleido Software, the former Occurrences and 
Detection window debouncing parameters have been removed. You may 
need to revise your system’s alarm debouncing calibrations when you 
upgrade to version 6.60 (or later) from version 6.50 (or earlier). Refer to the 
upgrade instructions in the Installation & Service Manual, for details. See 
Related Documentation, on page 11.

Notes (continued)



93

Kaleido Software
User’s Manual

Managing Calibration Profiles

Creating Calibration Profiles
To create a calibration profile

1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 
on the second-level tab bar.

2 On the File menu, click Add TS profile, Add video profile, Add audio profile, Add 
teletext profile, or Add SCTE 35 profile depending on the type of calibration profile 
you want to create.
The new profile appears on the Tools pane.

3 Click the profile to rename it as necessary.

Deleting Calibration Profiles
To delete a calibration profile

1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 
on the second-level tab bar.

2 On the Tools pane, click the profile you want to delete.
3 On the File menu, click Delete profile.

Configuring Calibration Profiles
To configure a calibration profile

1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 
on the second-level tab bar.

2 On the Tools pane, click the profile you want to configure.
A hierarchical list representing all applicable calibrations appears in the main window.

3 Navigate to the element you want to calibrate, and select it.
The related attributes appear in the Properties pane.

• See Configuring Alarm Debouncing on page 101, if you need to change 
debouncing parameters for teletext, audio, video, or transport stream alarms, and 
see Configuring Alarm Thresholds on page 96, to adjust alarm thresholds.

• For a TS profile:
• See Transport Calibration, on page 99, if you need to change alarm thresholds 

for TR 101 290 fault indicators.
• For an audio profile:

• See Audio Calibrations, on page 98, if you need to change audio alarm 
thresholds.

• See Calibrating Loudness Measurement on page 103, for detailed instructions 
on calibrating loudness measurement.

• See Calibrating Zero VU Reference Levels for Embedded Audio Sources on 
page 104, if you need to change the Zero Vu reference level for all sources 
associated with the current profile.
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• For a video profile:
• See Calibrating Metadata Holding Time on page 107, if you need to change the 

holding time for XDS metadata, CC or DTVCC captions.
• See Metadata Calibration, on page 99, if you need to change the presence 

timeout value for DTVCC services and text.
• For a teletext profile:

• See Calibrating Metadata Holding Time on page 107, if you need to change the 
holding time for teletext subtitles.

• See Calibrating Subtitling/Closed Captioning on page 107, to configure the 
teletext page selection parameters.

• For a SCTE 35 profile:
• See Metadata Calibration, on page 99, if you need to change the presence 

timeout value for SCTE 35 signaling.
• See Calibrating DTMF Tone Sequences on page 110, to register the out-of-

network, and in-network DTMF sequences you need to monitor.
• See Calibrating SCTE 35 Event Reporting Duration on page 111, if you want to 

adjust the delay after which alarms triggered when SCTE 35 commands are 
detected return to normal.

4 Repeat step 3 until the profile is properly configured for your purposes.

Assigning Calibration Profiles
To assign a calibration profile

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar. The main pane displays the System hierarchical list.

2 Navigate to the elementary stream, or transport stream you want to calibrate and 
select it.

3 In the Properties pane, click Profile, and then select the calibration profile you want to 
apply to this stream.

Elementary stream profile assignment example

Transport stream profile assignment example
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4 To apply the same profile to all elementary streams of a compatible type (such as all 
audio elementary streams), click Apply to all.
Alternatively, you can drag a profile from the Tools pane, onto an elementary stream, or 
transport stream in the System list.
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Configuring Alarm Thresholds

To configure the threshold for an alarm
1 Connect to the multiviewer you want to configure, if you want to apply the changes in 

real time (see Connecting to a Multiviewer on page 28).

2 In the main window, click the System tab, and then click Calibrations (Kaleido-IP) on 
the second-level tab bar, select the appropriate calibration profile on the Tools pane, 
and then click the alarm whose threshold you want to calibrate in the main pane.

A transport stream profile

Elementary stream profiles

3 In the Properties pane, set the relevant values under Calibration.

Note: The Kaleido-IP supports threshold calibrations for audio, teletext, 
SCTE 35, and TR 101 290 alarms.

Note: If this step is omitted, then you will need to export the database to 
apply the calibration changes.
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Video Calibrations

Black detection 
threshold

Set the level (in IRE, sample values, or mV) below which the signal will 
be considered to be black. By default the threshold is set at 8 IRE, or 
0 mV, depending on the multiviewer model.

Note: The IRE scale assumes a 7.5 IRE setup.

Freeze sensitivity Freeze detection is done by comparing successive frames. Noise in 
the signal could disrupt this process, so filtering is added to remove it. 
Adjust the sensitivity according to the signal being monitored, on a 
range of 0 (for a noisy signal) to 16 (for a clean signal). By default the 
sensitivity is set at 8, and the alarm will be triggered after at least 15 
seconds of continuous freeze. Once the alarm is triggered it will only 
be released if no other freeze condition is detected over the period 
determined by the Clear duration parameter (by default, there is no 
delay), to avoid unwanted alarm flickering that could be caused by 
glitches on the signal.

Note that when setting the Clear duration parameter to any value 
other than 0, it may happen that the freeze alarm will only be released 
after a long time (longer than the value of the period determined by 
the Clear duration parameter) if the video has short-duration freezes 
during this period.

SD/HD detection 
zone

Determine the video window area to be monitored for Freeze and 
Black detection. Two detection zones can be configured: one for SD 
signals, one for HD signals.

Luma too high 
detection 
threshold

Set the level (in IRE, sample values, or mV) above which Luma too high 
will be reported. By default the threshold is set at 100 IRE, or 700 mV, 
depending on the multiviewer model.

Note: The IRE scale assumes a 7.5 IRE setup.
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Audio Calibrations

Silence 
left/right/center

Select the level (in dB or dBFS for digital audio sources, in dB or dBu 
for analog audio sources) below which the audio signal will be 
considered silenced. The default value is –55 dBFS, on a range of -63 
to 0.

All silent / All silent 
program 2

Select the level (in dB or dBFS for digital audio sources, in dB or dBu 
for analog audio sources) below which an audio signal will be 
considered silenced. An alarm is raised if all available channels are 
below the threshold. The default value is –55 dBFS, on a range of -63 
to 0.

Overload left/right Select the level (in dB or dBFS for digital audio sources, in dB or dBu 
for analog audio sources) above which the audio signal will be 
considered overloaded. The default value is –5 dBFS, on a range of -63 
to 0.

Overall audio 
overload

Select the level (in dB or dBFS) above which an audio signal will be 
considered overloaded. An alarm is raised if any available speaker is 
above the threshold. The default value is –5 dBFS, on a range of -63 
to 0. Available for Kaleido-IP only.

Out of phase Select the sensitivity level below which the audio signal will be 
considered out of phase. The sensitivity is a value between -1 and +1, 
where -1 means completely out of phase and +1 means perfectly in 
phase. The default value is 0.

Mono An audio source is considered to be mono if the left and right signals 
are perfectly in phase (that is, more likely to be the same). Select the 
sensitivity level above which audio will be considered mono. The 
sensitivity is a value between -1 and +1, where -1 means that 
everything is considered to be mono, and +1 means that only 
perfectly in phase audio will be considered mono. The default value is 
1 (Perfectly in phase).
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Metadata Calibration

Transport Calibration

DTVCC service 
presence timeout

Set the delay (in seconds) after which a Service loss alarm will be 
triggered, if the multiviewer has not received any DTVCC data blocks 
for the given service. This calibration applies to the six standard 
services. The default value is 30 seconds, on a range of 1 to 360.

DTVCC text 
presence timeout

Set the delay (in seconds) after which a Text loss alarm will be 
triggered, if the multiviewer has not received any characters for the 
given service. This calibration applies to the six standard services. The 
default value is 30 seconds, on a range of 1 to 360.

Teletext/subtitling 
text loss

Set the delay (in seconds) after which a Text loss alarm will be 
triggered for the configured WST subtitling page. The default value is 
30 seconds, on a range of 1 to 360.

SCTE 35 loss Set the delay (in minutes) after which a SCTE 35 loss alarm will be 
triggered to report that no new SCTE 35 messages were detected 
during this much time. The default value is 60 minutes, on a range of 
1 to 360.

1.3a PAT timeout Set the delay (in millisecond) after which a timeout alarm will be 
triggered to report that no Program Association Table (PAT) was 
found in the transport stream during this much time. The default 
value is 500 ms, on a range of 10 to 2500.

1.5a PMT timeout Set the delay (in millisecond) after which a timeout alarm will be 
triggered to report that no Program Map Table (PMT) was found on 
the Packet Identifier (PID) specified in the PAT during this much time. 
The default value is 500 ms, on a range of 10 to 2500.

1.6 PID error Set the delay (in millisecond) after which an alarm will be triggered to 
report that the data stream associated with a PID has not occurred in 
the transport stream during this much time. The default value is 
5000 ms, on a range of 10 to 25000.
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2.3a PCR 
repetition error

Set the delay (in millisecond) after which an alarm will be triggered to 
report that the interval between two consecutive Primary Clock 
Reference (PCR) values has exceeded the specified time. The default 
value is 40 ms, on a range of 10 to 200.

2.5 PTS error Set the delay (in millisecond) after which an alarm will be triggered to 
report that no Presentation Time Stamp (PTS) was found in the 
transport stream during this much time. The default value is 700 ms, 
on a range of 10 to 3500.
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Configuring Alarm Debouncing
To configure alarm debouncing

1 Connect to the multiviewer you want to configure, if you want to apply the changes in 
real time (see Connecting to a Multiviewer on page 28).

2 In the main window, click the System tab, and then:
• In the case of a Kaleido-IP, click Calibrations (Kaleido-IP) on the second-level tab 

bar, select the appropriate calibration profile on the Tools pane, and then click the 
alarm whose debouncing you want to calibrate in the main pane.

A transport stream profile

Elementary stream profiles

• For all other multiviewer models, click Description/Calibrations on the second-
level tab bar, navigate to the alarm whose debouncing you want to calibrate, by 
expanding the appropriate multiviewer input, one of its Video elements, and then 
the alarm-related elements (or the ABT element, and then one of the ABT’s audio 
elements).

Note: If this step is omitted, then you will need to export the database to 
apply the new calibrations to the multiviewer.
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3 In the Properties pane, under Debouncing, set appropriate values (see page 90) for the 
Set duration and Clear duration attributes.
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Multiviewer Input Calibrations
To calibrate your multiviewer inputs, you navigate a hierarchical representation of your 
system in XEdit, and set parameters to match your monitoring purposes.

• In the case of a Kaleido-IP, default audio, video, teletext, SCTE 35, and transport stream 
profiles are available with preset calibrations, which cannot be modified. You can add 
custom profiles, and configure them as needed, from XEdit’s Calibrations (Kaleido-IP) 
tab. You can apply a profile to an elementary stream in the Description/Calibrations 
tab. See Profiles on page 89.

• For all other multiviewer models, you can modify calibrations for every multiviewer 
input, from the System list in XEdit’s Description/Calibrations tab. To apply a specific 
calibration to all inputs at once, click the corresponding Apply to all button.

Calibrating Loudness Measurement
To calibrate loudness measurement

1 Navigate to the appropriate input’s Loudness element in the System list or audio 
profile, and select it. See Navigating to the loudness calibration in a Kaleido-IP 
calibration profile, on page 104.

2 In the Properties pane, set the appropriate values for your installation.

The following values are involved:

Parameter Description

Mode Select the loudness standard you want to apply: EBU R128, 
ATSC A/85, or ARIB TR-B32. Alternatively, you can define a custom 
mode to gain more control.

Short term window This parameter determines the integration time of the short term 
loudness measurement. It is configurable when using ATSC A/85 or a 
custom measurement mode, with a value on a scale ranging 
between 1 and 15 seconds.

Max. lower 
deviation

The Max. lower deviation parameter determines the tolerated 
excursion range of the short term loudness below the target value. 
The measured short term loudness and the encoded dialnorm can be 
compared against each other and against a standard or your 
organization's target value, and alarms will be triggered in case of too 
much deviation. In custom mode, possible values range from -70 dB 
to 0 dB.1
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Navigating to the loudness calibration in a Kaleido-IP calibration profile

To navigate to the loudness calibration in a Kaleido-IP calibration profile
1 In XEdit’s main window, click the System tab, and then click Calibrations (Kaleido-IP) 

on the second-level tab bar.
2 On the Tools tab, select the audio profile whose loudness measurement you would like 

to calibrate.
A hierarchical list representing all applicable calibrations for this profile appears in the 
main window.

3 Expand the list, and then click Loudness.

Calibrating Zero VU Reference Levels for Embedded Audio Sources
To calibrate a Zero VU reference level

1 In the main window, click the System tab, and then:
• In the case of a Kaleido-IP, click the Calibrations (Kaleido-IP) tab, select the audio 

profile you want to configure, and then click Zero VU.

Max. upper 
deviation

The Max. upper deviation parameter determines the tolerated 
excursion range of the short term loudness above the target value. 
The measured short term loudness and the encoded dialnorm can be 
compared against each other and against a standard or your 
organization’s target value, and alarms will be triggered in case of too 
much deviation. In custom mode, the possible values range from 0 dB 
to 15 dB.

Target Type the appropriate loudness value for your custom standard, in the 
box, or set it using the slider. The default value is -24, on a scale of 
-70 LUFS/LKFS to 0 LUFS/LKFS.2 This value can then be compared 
against the measured loudness, and against the encoded dialnorm 
found in the VANC audio metadata (SMPTE ST 2020-A).

1.Setting this parameter to its lowest value (-70 dB) will prevent the short term/Target alarm from 
being triggered when silence is detected.

2.On the monitor wall, loudness monitors using a custom measurement mode have their scale 
labeled LU, or LUFS. There is no functional difference between the LU vs. LK, or LUFS vs. LKFS 
scales.

Parameter Description
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• For all other multiviewer models, click Description/Calibrations on the second-
level tab bar, expand the appropriate input, then one of its embedded audio 
elements, and select Zero VU.

2 In the Properties pane, set the reference level to the appropriate value (in dBFS), using 
the Zero VU slider, under Calibration.
Alternatively, type the value directly in the Zero VU box.

Calibrating Aspect Ratio Decoding

Note: This section applies to multiviewers that are used to monitor 
SD signals. In the case of HD signals, since the AFD information always 
follows AFD 2016, no calibration is needed. No calibration is needed for the 
Kaleido-IP either, since it supports decoding of a signal’s aspect ratio from 
AFD metadata only. See Aspect ratio, on page 90 for more information.
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Aspect ratio information can be encoded following different standards: AFD 2016, AFD VI, 
or WSS. The following table shows the different standards and their availability according to 
the signal type:

AFD VI information can be encoded as 4 bits or 3 bits (legacy).

To select the AFD source for an SD signal
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose inputs you want to calibrate.
3 Expand the appropriate input, and then click AFD & WSS.

4 In the Properties pane, select Legacy AFD 3 bits to support the legacy AFD 3-bit 
format for the video index, if appropriate.

5 Select the appropriate value from the SD AFD source list.

The default value is Auto, which means that the multiviewer will automatically detect 
what is present in the signal and use it to report AFD. If more than one AFD type is 
present in the signal, and SD AFD source is set to Auto, then the AFD type is selected in 
this order: (1) AFD 2016, (2) AFD VI, or (3) WSS.

Signal type AFD 2016 Video index (AFD VI) Wide screen signaling (WSS)

HD Yes — —

SD 525 Yes Yes —

SD 625 Yes Yes Yes
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Calibrating Subtitling/Closed Captioning
In the case of a Kaleido-IP, presence alarms can be configured for up to eight preset Teletext 
(WST) subtitle pages for each input signal and all eight teletext pages (page A to page H) 
can be decoded. 

The subtitling page selection parameters determine which pages will be monitored. 

This requires the CC/XDS option to be enabled (see the multiviewer’s Installation & Service 
Manual for more information). 

Configuring Teletext/Subtitling Page Selection for a Kaleido-IP

To configure Teletext/Subtitling page selection for a Kaleido-IP
1 In the main window, click the System tab, and then click the Calibrations (Kaleido-IP) 

tab.
2 Select the teletext profile you want to configure, expand the Page A element, and then 

click Page selection.

3 In the Properties pane, type the page number you want to be the default selection for 
Page A, in the Teletext page A selection box. Alternatively, use the slider to set the 
page number.

4 If you want to enable or disable teletext decoding for this page, then select or clear the 
Enabled check box accordingly.
Only decoding of Page A is enabled by default.

5 Repeat this procedure for the Page B, to Page H elements.

Calibrating Metadata Holding Time
To calibrate metadata holding time

1 In the main window, click the System tab, and then:

Note: Alarms can be configured for all eight preset pages (see Configuring 
Alarm Debouncing on page 101 for instructions on how to configure the 
alarms).
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• In the case of a Kaleido-IP, click the Calibrations (Kaleido-IP) tab, select the video 
or teletext profile you want to configure, and then click CC Caption holding time, 
XDS filtering, DTVCC holding time (for a video profile), or Subtitling holding time 
(for a teletext profile).

• For all other multiviewer models, click Description/Calibrations on the second-
level tab bar, expand the appropriate input module, then the video input you want 
to calibrate, and select the metadata element whose holding time you want to 
configure.

2 In the Properties pane, set the value by typing it directly in the box, or by using the 
slider (refer to the table below as needed).
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Subtitling holding time Set the delay (between 5 and 360 seconds, default value is 
16 seconds) after which subtitles are cleared.

XDS filtering Set the holding time (between 5 and 360 seconds, default 
value is 30 seconds) for each XDS metadata element (APS, 
ASB, CGMS-A; channel number; elapsed time; network 
name; program description, ID, name, length, and type; 
station ID; TSID name; time of day; time zone; V-chip 
rating).
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Calibrating DTMF Tone Sequences
The Kaleido-IP can detect 16 specific DTMF sequences in a SCTE 35 stream, to trigger up to 
8 DTMF break alarms and to return their status to normal. Define the sequences, matching 
those used in the actual programs you want to monitor.

To calibrate out-of-network, and in-network DTMF tone sequences
1 In the main window, click the System tab, and then click the Calibrations (Kaleido-IP) 

tab on the second-level tab bar.
2 On the Tools pane, select the SCTE 35 profile you want to configure, and then click 

DTMF break 1 sequences.

CC holding time Set the delay (between 5 and 360 seconds, default value is 
16 seconds) after which closed captions (608) are cleared.

DTVCC holding time Set the amount of time (between 15 and 360 seconds, 
default value is 30 seconds) during which DTVCC closed 
captions (708) should persist on the monitor wall, if the 
multiviewer has not received a clear message block for 
the corresponding DTVCC service. When this delay expires 
the text is forcibly cleared on the monitor wall.
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3 In the Properties pane, set the appropriate values for the out-of-network, and in-
network DTMF sequences.

Allowed characters: 0–9, A–D, *, and #.
4 Proceed in the same fashion with DTMF break 2 sequences to DTMF break 8 

sequences, as needed, to define the remaining DTMF sequences you want to monitor.

Calibrating SCTE 35 Event Reporting Duration
When the Kaleido-IP detects a SCTE 35 command in a transport stream, it momentarily 
triggers the corresponding alarm. The alarm status returns to normal after a delay, which 
you can configure for your specific purposes if needed.

To calibrate SCTE 35 event reporting duration
1 In the main window, click the System tab, and then click the Calibrations (Kaleido-IP) 

tab on the second-level tab bar.
2 On the Tools pane, select the SCTE 35 profile you want to configure.
3 In the main pane, click Splice received, Splice null received, Time signal received, or 

Unsupported command received.

4 In the Properties pane, set the relevant values under Calibration.
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Splice received 
timeout

Set the delay (in seconds) after which the splice received alarm will be 
cleared. The splice received alarm is triggered immediately whenever 
the Kaleido-IP detects a splice insert command. The default value is 
120 seconds, on a range of 1 to 3600.

Splice null 
received timeout

Set the delay (in seconds) after which the splice null received alarm will 
be cleared. The splice null received alarm is triggered immediately 
whenever the Kaleido-IP detects a splice null command. The default 
value is 60 seconds, on a range of 1 to 3600.

Time signal 
received timeout

Set the delay (in seconds) after which the time signal received alarm 
will be cleared. The time signal received alarm is triggered 
immediately whenever the Kaleido-IP detects a time signal command. 
The default value is 60 seconds, on a range of 1 to 3600.

Unsupported 
command 
received timeout

Set the delay (in seconds) after which the unsupported command 
received alarm will be cleared. The unsupported command received 
alarm is triggered immediately whenever the Kaleido-IP detects a 
command that does not belong to the set of supported commands. 
The default value is 60 seconds, on a range of 1 to 3600.
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Multiviewer Output Calibrations

Calibrating the Audio Monitoring Color
When the Monitoring indicator check box is selected (see Configuring Audio Monitors, on 
page 207), a color-keyed rectangle is shown below the VU meter that is the same color set 
below in Audio Monitoring Color when that display head is being monitored. See also 
Triggering Audio Monitoring by Using the mouse, the RCP-200, or the Kaleido-RCP2, on 
page 342.

To calibrate the audio monitoring color
1 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar.
A hierarchical list representing the current system appears.

2 In the list, expand the multiviewer whose output heads you want to calibrate.

3 Expand the appropriate output module.
The expanded module will show the output heads. (Depending on the multiviewer 
model, other items may also appear.)

4 Select the head you want to calibrate.
5 In the Properties pane, click the Audio Monitoring Color box, and then click the 

button that appears at the end of the line.

Click to open the
color picker window
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The color picker window opens.

6 In Colors, click the tab that corresponds to the color space you want to use, and then 
choose the color that will be associated with the selected output head.

7 Click OK to close the color picker window.
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Introduction
Your Kaleido multiviewer system can help you monitor alarm conditions efficiently. This 
section describes how to configure alarm detection and alarm sharing parameters for your 
system. This configuration is made in XEdit.

Key Concepts

Alarm
An alarm is a report on a single, defined condition (generated by a device or service) within 
a multiviewer system. A multiviewer analyses the signals that pass through it, and can 
detect and flag problems by raising alarms. Each alarm can be individually configured. Most 
alarm definitions specify detection thresholds, a set duration, and a clear duration, in order 
to exclude transient events. See Configuring Alarm Thresholds on page 96, and Configuring 
Alarm Debouncing, on page 101.

When XEdit is connected to a multiviewer in online mode, alarms generated by the current 
multiviewer are displayed in the System list and you can review their status in real time. You 
can manage additional alarms, including health monitoring alarms, or alarms generated by 
external devices, by using an alarm browser such as iControl’s GSM alarm browser or the 
alarm browser pane in XEdit’s Build Virtual Alarm window (see Virtual Alarm on page 119).

As part of the alarm calibration process, you can specify that an alarm, when triggered, be 
sent as an SNMP trap. See Simple Network Management Protocol (SNMP) on page 120.

General Status Manager (GSM)
The general status manager (GSM) is the service responsible for central management of all 
alarm conditions within a monitoring and control system. Every Kaleido multiviewer has a 
GSM and can be configured to share GSM information with other multiviewers and iControl 
systems. For example:

• Display alarm status information from Densité cards on the monitor wall.
• Display alarms detected within a Kaleido multiviewer system on an iControl Web page.
• Display EdgeVision alarms along with the stream coming from the EdgeVision on a 

Kaleido-IP multiviewer.
• Display alarm status information in XEdit (online mode).
• Create virtual alarms that combine a number of alarm statuses, not only within a single 

system, but also from different devices within multiple Kaleido multiviewers and 
iControl systems. See Creating Virtual Alarms on page 128.
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In addition, as of version 6.40 of the Kaleido Software, it is possible to assign elements from 
any GSM alarm browser to alarm levels in the sources table, directly, by a drag-and-drop 
operation (see Configuring logical sources based on external alarm providers on page 81).

Alarm Logging
As part of the alarm calibration process, you can specify that an alarm, when triggered, be 
logged to an iControl application server. This requires adding a log plug-in to your 
multiviewer’s GSM configuration (see Adding a GSM log plug-in on page 136). As of version 
6.50 of the Kaleido Software, alarms logged to an iControl application server include time 
code information from the corresponding video signal (ATC or VITC, depending on the 
signal format).

• By default, native alarms are not logged. See Enabling logging for a native alarm on 
page 139.

• Virtual alarms are logged by default. See Disabling logging for a virtual alarm on 
page 140. When a virtual alarm status changes, then the native sub-alarms that 
triggered the change are logged even if logging is disabled for these sub-alarms.

• Global alarms are always logged. It is possible, however, to disable alarm logging for a 
global alarm, by editing the corresponding plug-in from the iControl application 
server’s GSM alarm browser. Refer to the iControl User Guide, for more information. See 
Related Documentation, on page 11.

Alarm Browser
The alarm browser is a window, accessible from within iControl Navigator and other 
iControl applications. XEdit’s Build Virtual Alarm window features an alarm browser pane. 
The information that appears in the Alarm Browser is generated by a specific GSM. The 
alarm browser displays a hierarchical view of all the alarms that have been discovered by 
the GSM. The alarms may be related to Grass Valley devices, or other supported third-party 
devices, and are organized into folders. The current status of each alarm is shown as an icon 
next to its name. These status are dynamically updated.

Alarm Status
The current status of an alarm determines the color of the LED-like icon to the left of its 
name, in XEdit, in GSM alarm browsers, and in iControl log viewers. Video monitors, UMDs 
and alarm monitors have alarm reporting features (such as border color and thickness, blink 
mode, latch) that can be customized in XEdit, when you create a layout.

Each possible alarm status is represented by a color. Alarm statuses are dynamically 
updated. The following alarm status values are supported as described in the table below: 
pending, normal (or OK), warning (or minor), major, critical, unknown, nonexistent, and 
disabled. In a multiviewer’s System list and on the monitor wall, nonexistent and unknown 
alarms are considered disabled.
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A multiviewer alarm status is only visible in iControl’s GSM alarm browser when at least one 
of the following conditions apply:

• The alarm is already monitored on the monitor wall.
• Someone navigated to this alarm by expanding the System list in iControl or XEdit.
• The alarm is associated with a background action.
• The alarm contributes to a virtual alarm.

When navigating a multiviewer’s GSM, by using the alarm browser in iControl, some alarm 
folders may show a disabled (black) status, until you expand them to reveal the alarms they 
contain, at which point the folder color will be updated to reflect the status of the alarms.

In the case of a Kaleido-IP, alarm status and text information for a source is available only 
when the corresponding source is being monitored on the wall. For SCTE 35 alarm status 
and text information to be available (and logged to iControl, if applicable), make sure to 
assign at least one text or alarm level from every SCTE 35 stream you want to monitor, to UMD 
components (tally or text) on the monitor wall layout. Alarms associated with sources that 
are currently not assigned to any layout element on the monitor wall appear with a 
pending (white) status in a Kaleido-IP System list or GSM alarm browser.

Status Color Description

Pending White Alarm exists but was not reported yet: The software is waiting for 
the hardware or driver to update the alarm.

Normal (or OK) Green No error detected.

Warning (or 
Minor)

Yellow Supported for Gateway alarms only (see Gateway on page 263).

Major Orange Supported for Gateway alarms only (see Gateway on page 263).

Critical Red Error detected.

Unknown Gray Could not get status: Failed to communicate with device to get 
status. It could happen for example, if the network connection is 
lost. Another example is a loss of signal that would trigger a 
critical alarm for signal presence while the alarm state for all 
other parameters would become unknown. The freeze or black 
status is disabled if the signal is not present.

Nonexistent Blue Alarm that has been removed (or was never added): It can 
happen if the alarm reference in XEdit does not exist on the 
multiviewer. All associated alarms will disappear from the GSM 
and become disabled on the multiviewer.

Disabled Black No alarm assigned to the status indicator: Alarm exists but is 
disabled at the source by the user. The Kaleido Software has the 
ability to deactivate some alarms on the multiviewer hardware 
itself.

TIP
Create a virtual alarm, based on the alarms whose status you want to be able 
to monitor in real time. See Virtual Alarm on page 119.
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External Alarm Provider
Once you have declared a device (such as an iControl application server, an EdgeVision 
quality of experience monitoring system, another multiviewer) as an external alarm 
provider to your multiviewer system, any alarms registered with this device’s GSM, in 
addition to the alarms generated by the current multiviewer system, can contribute to your 
monitoring and control purposes. See Managing Alarm Providers on page 126.

Lookup Service
Grass Valley’s monitoring and control products implement a lookup service for discovery 
and information sharing over a network. A program on one device can use a lookup service 
to obtain information from remote applications or devices, including alarm-related 
information from a device’s GSM. By default, every multiviewer has a lookup service and can 
therefore be considered a lookup server. For example, before you can use an RCP-200 control 
panel to operate your monitor wall, the multiviewer must be specified as a lookup server in 
the RCP-200’s configuration (see Specifying lookup servers for the RCP-200 in the multiviewer’s 
Installation & Service Manual for more information).

Alarm Suppression
Alarms that are not relevant—momentarily or on a recurrent basis—can be squelched, 
either manually or by defining schedules, so that only meaningful alarm information 
remains to be monitored. A schedule can put an alarm in either of the following operational 
modes: offline, in maintenance, or inverted.

Global Alarms
A logical source comprises different level categories, including alarms (see Logical source 
on page 71). Each logical source can include multiple alarm levels: one for each alarm state 
that can be reported to the Kaleido multiviewer system. In many cases, a single, combined 
status, based on all the alarms in every alarm level for a logical source, is more useful than 
having to individually assess each and every alarm condition detected. Such a global alarm 
combines all the individual alarm statuses into an overall status, where the most critical 
events take precedence.

IMPORTANT
iControl application server requirement
In the case of an iControl system involving multiple application 
servers, there will typically be only one or two of the servers with a 
lookup service enabled. To qualify as an external alarm provider, an 
iControl application server must have its lookup service enabled (that 
is, it must be a lookup server). Refer to the iControl User Guide for more 
information. See Related Documentation, on page 11.

Note: A background action triggered by an alarm is executed, regardless of 
the alarm’s operational mode (see Creating Background Actions on 
page 267).
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Example: Three alarms occur, two of which can be acknowledged without further 
action, while the other one is considered an Error. In such a case, the overall alarm status 
would be Error.

The Kaleido Software creates one global alarm for every logical source. The global alarms 
are not directly exposed in the Channels/Sources tab, but you can configure which alarm 
levels contribute to them (see Configuring an alarm level’s contribution on page 78). If you 
have disabled global alarm contribution for all alarm levels, then the global alarms are not 
generated.

In the Layouts tab, you can assign a global alarm to a layout element that supports alarm 
reporting, like a UMD or an alarm monitor: in the Properties pane, the lists of alarm levels 
that can be assigned to a monitor include the item GlobalAlarm, along with all the 
individual alarm levels.

You can select this global alarm not only as an alarm status, but also as a text label. When an 
individual alarm is in Error, its friendly name will contribute to the global alarm text value. 
When the global alarm level is assigned to an alarm monitor, the text values for all 
contributing alarms currently in Error will be visible.

See Configuring Video Monitors, on page 191, Configuring UMDs, on page 224, 
Configuring Alarm Monitors, on page 231, and Configuring Subtitling Monitors, on 
page 235), for detailed instructions.

Virtual Alarm
A virtual alarm allows you to derive a result from the status of one or more existing alarms. 
Any alarms — including other virtual alarms — can be combined together to form a new, 
higher-level virtual alarm. Since a virtual alarm can be composed of virtual alarms other 
than itself, there can be many levels of virtual alarms within a particular virtual alarm. At this 
time there is no limit to the number of levels that a virtual alarm can have. See Creating 
Virtual Alarms on page 128.

Note: If you choose to configure your multiviewer system with a large 
number of logical sources (for example, more than 1500), you should disable 
global alarm contribution for all alarm levels in the sources table, to improve 
the system performance.

Notes

• Do not include the reserved text GlobalAlarm in a virtual alarm name.

• Creating a virtual alarm that includes itself as a sub-alarm, directly or 
indirectly, creates a circular reference. XEdit does not automatically check 
for this dependency. Your multiviewer will, however, perform cycle 
validation and will record an error in vroom.log if such a condition is 
detected.
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Sub-Alarm
A sub-alarm is an alarm that contributes to the status of a higher-level virtual alarm. The 
effect of a sub-alarm’s contribution is determined by the way in which the higher-level 
alarm is configured.

Alarm Monitor
Alarm monitors help you see the status of global and virtual alarms, but their use is not 
limited to this type of alarms. When any alarm level is assigned to an alarm monitor, the 
status of this alarm will be shown. When using the global alarm at the text label level, it will 
display the text value of the alarm, which is a readable name. See Configuring Alarm 
Monitors on page 231, for more information.

Simple Network Management Protocol (SNMP)
Certain multiviewers support at least one SNMP agent, which is capable of sending SNMP 
traps to notify external SNMP managers of significant events. Within your multiviewer 
system, these significant events are reported as alarms (see Alarm on page 115).

For a Kaleido-IP multiviewer, the SNMP status for an alarm is only valid if the corresponding 
source is monitored on the monitor wall.

SNMP traps
Setting up your multiviewer’s SNMP trap process involves the following actions:

• Identify the targets (SNMP managers) to which SNMP traps will be sent (see Identifying 
Target SNMP Managers on page 141).

• Choose the traps that will be sent to the selected SNMP managers (see Enabling SNMP 
Traps on page 142). Not available for Kaleido-IP.

Traps are automatically sent for all logical sources’ global alarms (see Global Alarms on 
page 118), and for virtual alarms (see Virtual Alarm on page 119). Each trap contains a 
cause, and the name of the logical source. Kaleido-IP X100 and Kaleido-IP X300 
multiviewers cannot send health-related SNMP traps. To send health-related traps, a 
Kaleido-IP X120, X110, X320, or X310 requires advanced server configuration, for which you 
will need assistance from Technical Support (Grass Valley Technical Support, on page 360).

TIP
To make text status available to SNMP managers
1 In XEdit, add the text status element from the appropriate source signal to 

a logical source (channel).
2 Assign the logical source to a UMD.
3 Load the layout that includes this UMD on the monitor wall.

TIP

Create virtual alarms based on health-related alarms from your Kaleido-IP to 
make this information automatically available to your target SNMP 
managers.

To make Kaleido-IP health-related status available to SNMP managers
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MIB documents
Before you can use a network management system (NMS) to send SNMP requests (such as 
Get, GetNext, Set) to your multiviewer, and to process the multiviewer’s responses and 
traps, you need to download the appropriate MIBs from your multiviewer, and then load 
them into the NMS.

To obtain MIBs from your multiviewer, point your browser to the URLs indicated below.

Kaleido-IP

To manage these multiviewers (through port 161), or process any SNMP traps they might 
send, NMSs require both Kaleido-IP-MIB, and MIRANDA-MIB.

• http://<your multiviewer’s IP address>/pub/Kaleido-IP-MIB.mib
• http://<your multiviewer’s IP address>/pub/MIRANDA-MIB.mib

In addition, health-related status information from a Kaleido-IP X320, Kaleido-IP X310, 
Kaleido-IP X120, or Kaleido-IP X110 multiviewer is available through port 1161, for which 
your NMS will need the basebrd7_v5.mib MIB.

• http://<your multiviewer’s IP address>/pub/basebrd7_v5.mib

Health-related status information from a Kaleido-IP X300, or Kaleido-IP X100 multiviewer 
is available through port 1161, for which your NMS will need the SUPERMICRO-HEALTH-
MIB, and SUPERMICRO-SMI MIBs.

• http://<your multiviewer’s IP address>/pub/SUPERMICRO-HEALTH-MIB.my
• http://<your multiviewer’s IP address>/pub/SUPERMICRO-SMI.my

In the case of a Kaleido-IP, publishing signal/service probing alarms to SNMP managers is 
not fully supported. Kaleido-IP-MIB is a subset of KALEIDO-KX-MIB. The Kaleido-IP can 
report service/signal status to an SNMP manager through the Kaleido-IP-MIB file's 
kxVirtualAlarmTable. This table includes entries for all virtual alarms and logical sources 
created in XEdit for your multiviewer. For each logical source, the global alarm and 
associated text information is available. Refer to the MIB-embedded descriptions for 
exceptions.

1 Connect XEdit to the Kaleido-IP.

2 On the Tools menu, click New virtual alarm.

3 In Build Virtual Alarm, select your Kaleido-IP from the list in the left-hand 
part of the GSM alarm browser pane.

4 In the right-hand part of the alarm browser pane, expand the 
MULTIVIEWER OUTPUTS element to navigate to the health-related alarms 
you want to monitor.

5 Proceed with the creation of the new virtual alarm (see Creating Virtual 
Alarms on page 128, for detailed instructions).

Note: The Kaleido Software does not support the SNMP v2 GetBulk 
command. Performing a GetBulk on kxVideoTable returns “There is no 
such instance in this MIB” instead of the data for the table.

TIP (continued)
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Teletext, Subtitles, and Closed Captions

Teletext may comprise up to 799 pages of displayable data (numbered from page 100 to 
899). Teletext subtitles are decoded as described by the ETSI EN 300 472 V1.3.1 (2003-05) 
standard (for Kaleido-IP) or ETSI ETS 300 706 (for other multiviewer models). The Kaleido-IP 
can decode up to eight pages from a DVB teletext stream, and monitor teletext, subtitle, 
and text presence for each of the selected pages. See Setting a Video Monitor’s Text Mode, 
on page 201, and Displaying Subtitles and Closed Caption Text, on page 326, for more 
information.

Decoding Precedence
The CEA-708 standard supports legacy CEA-608 data. In the case of an HD-SDI source 
carrying both 708 captions and 608 legacy caption data, the multiviewer will display the 
708 captions, and automatically fall back to displaying the 608 captions only if the 708 data 
becomes unavailable.

In the case of a Kaleido-IP, when a video or subtitling monitor’s text mode is set to Auto 
sense, and the associated source carries more than one type of captioning, teletext or 
subtitling data, decoding precedence is a follows: DVB subtitling, SCTE 27 subtitling, DVB 
teletext (WST), CC (608). For example, DVB teletext is only decoded if there is no DVB 
subtitling, and no SCTE 27 subtitling available.

For the other multiviewer models, the following table shows which of captioning, teletext, 
or subtitling data is decoded by default for each supported video format, when a video 
monitor’s text mode is set to Auto sense: DTVCC (708), CC (608), teletext (RDD 8/OP-47, 
ST 2031, or WST).

TIP
If an iControl Application Server is available to your system, configure it to 
relay your Kaleido-IP alarm status information to the target devices. 
See General Status Manager (GSM) on page 115, and refer to iControl and 
SNMP in the iControl User Guide, for more information. See Related 
Documentation, on page 11.

Multiviewer Supports

Kaleido-IP Can monitor teletext and subtitling from DVB streams, and 
subtitling from SCTE 27 streams. The lines of text extracted from a 
DVB subtitling stream compliant with ETSI EN 300 743 V 1.2.1 
(2002-10), or from a SCTE 27 subtitling stream can be displayed 
within the corresponding video window, or in a subtitling monitor. 
In the case of DVB teletext streams, the lines of text are displayed 
within the corresponding video window.

Video format Decoded data Video format Decoded data

SDI 525 CC (608) 1080i59.94 DTVCC (708)

SDI 625 Teletext 1080PsF23.98 N/A
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CEA-608 CC Alarm Definitions

CEA-708 DTVCC Alarm Definitions

Dolby E/AC-3 Metadata
Dolby E and PCM audio levels can be displayed through audio monitors. 

• If multichannel audio (up to 8 channels) is coded in a Dolby E stream and transported 
over a single AES channel, metadata and audio levels are extracted from the Dolby E 
stream:

• no ABT support
• VU and Peak meters (8 channels), for each source
• Program configuration, for each source
• Dialnorm for program 1, for each source

• If multichannel audio (up to 16 channels) is transported as regular AES channels (up 
to 8) in the SDI embedded audio, metadata is extracted from VANC packets:

• Program configuration
• Dialnorm for program 1
• VU and Peak meters come from the AES in PCM

NTSCa CC (608) 1080PsF24 N/A

PALb Teletext 1080PsF25 Teletext

SECAM Teletext 1080PsF29.97 DTVCC (708)

720p24 N/A 1080p23.98 N/A

720p25 N/A 1080p24 N/A

720p29.97 DTVCC (708) 1080p25 N/A

720p50 Teletext 1080p29.97 DTVCC (708)

720p59.94 DTVCC (708) 1080p50 Teletext

1080i50 Teletext 1080p59.94 DTVCC (708)

a. All supported NTSC formats.
b.All supported PAL formats.

Line 21 loss CEA-608 preamble presence indicator

CC1 loss – CC3 loss Closed caption data presence indicators

Service loss Reports, after a configurable amount of time (see DTVCC service presence 
timeout on page 99), the absence of DTVCC data blocks in the video signal for 
the given DTVCC service

Text loss Reports, after a configurable amount of time (see DTVCC text presence timeout 
on page 99), the absence of characters for the given DTVCC service

Video format Decoded data Video format Decoded data
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Definitions

Audio Format
The format of each audio channel (PCM, Dolby AC-3, Dolby E, other or Unavailable) is 
reported as a text attribute, that can be assigned to a text level within a logical source.

Audio Metadata
The metadata extracted from the VANC and from the Dolby E is available as text in the XEdit 
hierarchical system list, and therefore can be exposed through any layout element capable 
of displaying text levels from logical sources (currently only UMDs).

Dialnorm is displayed as a numeric value between -31 and -1 dB. Program Config is 
displayed as the Dolby E Program Config description. Unavailable is displayed if the source 
is not being decoded, or is not Dolby E.

Logical Source Assignment
Logical source assignment is performed by dragging an AES pair onto a logical source’s 
audio level.

If the AES pair is calibrated as a Dolby E source, then the 8 channels are available to be 
displayed by an audio monitor. The channel displayed by the audio monitor depends on 
how the monitor was configured.

For Dolby VANC, if the audio monitor is set to Auto or Dolby VANC, the VANC metadata 
from the video of the assigned AES will be decoded. The audio monitor will have access to 
all amended audio peaks depending on VANC program configuration (regardless of which 
AES pair was assigned to the logical source).

SCTE 35 Digital Program Insertion (DPI) Signaling
The Kaleido-IP can monitor digital program insertion (DPI) signaling from SCTE 35 streams. 
It supports a splice break alarm, eight DTMF break alarms, and text information for logging 
purposes.

Term Definition

Dolby E stream A coded (compressed) 8-channel digital stream that fits inside an AES 
channel (L/R)

Dolby E metadata Metadata such as dialnorm and program config extracted from a 
Dolby E stream. Includes audio level data from encoded audio data

VANC metadata Audio metadata extracted from SMPTE ST 2020-A VANC packets. 
Audio level data is probed directly from the PCM AES signal

Embedded audio 
source or channel

Any of the 8 SDI or HD-SDI embedded audio AES signals

AES signal or source A bitstream for audio service

Multichannel audio Audio service or essence composed of more than 2 channels of audio 
(more than Left and Right)
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Bit Rate Measurement
The Kaleido-IP reports bit rate measurements as text values, for every type of elementary 
streams. Measurements are performed based on guidelines from ETSI TR 101 290. A 
188-byte packet format is assumed. (With the current version of the Kaleido Software, bit 
rate values reported for streams encoded with a 204-byte packet format are therefore not 
accurate.)

Transport Stream Monitoring
The Kaleido-IP reports TR 101 290 first- and second-priority faults, as alarms and text values, 
for every type of transport streams. Measurements are performed based on guidelines from 
ETSI TR 101 290. Second-priority indicator 2.5 (PTS_error) is available for video and audio 
elementary streams, only. Second-priority indicator 2.4 (PCR_accuracy_error) is not 
available.

Note: Do not confuse the video bit rate (measured value) with the bit rate 
reported under Video encoder metadata (extracted information).

Measured bit rate

Encoded bit rate

Note: Text values are not persisted and should not be displayed in monitor 
wall layouts. They are suitable for logging purposes only.
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Managing Alarm Providers
To add alarm providers to your Kaleido multiviewer system

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar.
A hierarchical list representing the current system appears.

2 Click the multiviewer whose alarm providers you want to define.
3 In the Properties pane, click the Alarm providers list box.

4 Click the button that appeared at the end of the box to open the External Alarm 
Providers Configuration window.

5 In External Alarm Providers Configuration, review the alarm providers list, and then 
add or remove devices, as required.

• To add a device to the providers list, select the device from the Host address list, or 
type the appropriate IP address in the box, and then click Add.

• To remove a device from the alarm providers list, select it, and then click Remove.
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6 Once you have added all devices required for your purposes, click OK to close the 
window.

7 On the File menu, click Save.

Note: To qualify as an external alarm provider, an iControl application 
server must have its lookup service enabled. See External Alarm Provider on 
page 118.
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Managing Virtual Alarms

Creating Virtual Alarms

Inverting an alarm
The Invert contribution allows performing a logical “NOT” calculation on sub-alarms. 
This feature can be used, for example, to report alarms from GPI inputs. It can also be 
used to handle cases where an error is expected, and not seeing an error is a sign that 
something probably went wrong. The table below describes the result of inverting sub-
alarms:

To create a virtual alarm
1 Connect XEdit to the multiviewer (see Using XEdit in Online Mode on page 28).
2 On the Tools menu, click New virtual alarm.

Alternatively, after clicking the Actions tab, or while a text or alarm level is selected in 
the sources table you can:

• Right-click Virtual alarms in the filtered System list, point to Virtual alarm, and 
then click New.

Sub-alarm status Inverted contribution

NORMAL ERROR

MINOR NORMAL

MAJOR NORMAL

CRITICAL NORMAL

NON-EXISTENT NON-EXISTENT

PENDING PENDING

DISABLED DISABLED

UNKNOWN UNKNOWN
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• Expand Virtual alarms in the filtered System list, right-click any existing virtual 
alarm, point to Virtual alarm, and then click New.

The Build Virtual Alarm window appears.

3 In the Status logic section, select one of the following three options:
Virtual alarm status is best status among selected alarms (AND) — Choose this 
option to have the contribution of the sub-alarms calculated using the optimistic 
version of the alarm logic tables.
Virtual alarm status is worst status among selected alarms (OR) — Choose this option 
to have the contribution of the sub-alarms calculated using the pessimistic version of 
the alarm logic tables. This is the most common option, since it brings changes in the 
status of any sub-alarms to the attention of the operators.
Virtual alarm status is critical if selected alarms differ (XOR) — Choose this option to 
have the contribution of the sub-alarms calculated using the XOR version of the alarm 

Alarm providers Alarm browser
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logic tables. This causes the virtual alarm to reflect whether or not all of its sub-alarms 
have the same status. If all sub-alarms are the same, the virtual alarm will be green. 
Otherwise, it will be red.
For a more detailed description of the difference between these options, refer to 
“Understanding the Alarm Logic Tables” in the iControl User Guide. See Related 
Documentation, on page 11.

4 In the Text logic section, determine what to include in this virtual alarm’s text attribute 
by selecting one of the following three options:
Ignore texts — No text logic (default).
Concatenate texts — Concatenate the text attributes from all sub-alarms.
List errors — List the text attributes from the sub-alarms that are in error.

5 Select the alarm provider you want to use from the list in the left-hand part of the GSM 
alarm browser pane.

6 In the right-hand part of the alarm browser, select the alarms that are to be sub-alarms 
of the new virtual alarm, and then click the large down arrow button to transfer them 
to the table in the bottom half of the window.

7 The table displays various details about the sub-alarms you have selected, including 
their contribution, which defines how a sub-alarm will pass its status on to the virtual 
alarm. The default contribution value is Passthrough, which means the sub-alarm will 
pass its status unaltered to the overall calculation of the virtual alarm.
It is possible to override the error status of sub-alarms when they are triggered. This is 
useful when, for example, a device is only able to report a status of either normal 
(green) or error (red), but you want the error condition to be considered as minor 
(yellow) in the virtual alarm calculation. To change a sub-alarm’s contribution, click in 



131

Kaleido Software
User’s Manual

the Contribution column, and then select the status you want the virtual alarm to use 
when an error occurs.

For example, if a sub-alarm goes from green to orange or red, but the selected 
contribution is yellow, the virtual alarm will “see” yellow (the virtual alarm’s overall 
status may still depend on other sub-alarms).
The Invert contribution allows performing a logical “NOT” calculation on sub-alarms. 
This feature can be used, for example, to report alarms from GPI inputs. It can also be 
used to handle cases where an error is expected, and not seeing an error is a sign that 
something probably went wrong. See Inverting an alarm, on page 128.
Selecting the Faults only contribution causes a sub-alarm to be mapped to NORMAL 
unless it is in one of the fault statuses—usually CRITICAL, MAJOR, and MINOR. Refer to 
the iControl User Guide for more information. See Related Documentation, on page 11.

8 Repeat from step 5, until you have added all the required sub-alarms.
9 Specify a name for the new virtual alarm in the Name box.

10 Optionally, change the default path as needed in order to logically group alarms 
together.

11 Configure logging behavior as required (see Alarm Logging on page 116):
• If you want to disable logging for this virtual alarm, then select Not logged.
• If you want to have occurrences of this virtual alarm logged as incidents, select This 

virtual alarm is an incident template. Refer to the iControl User Guide for more 
information. See Related Documentation, on page 11.

• To add relevant information for your logging purposes, click Edit metadata.
The Virtual Alarm Metadata window appears.

Note: If the sub-alarm’s fault condition is cleared, its contribution will 
always be green (NORMAL), unless the value specified in the Contribution 
column is black (DISABLED).

Note: Do not include the reserved text GlobalAlarm in a virtual alarm name.
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The information you provide for this virtual alarm can be used to sort and locate 
events and incidents in the iControl log viewers. For example, a meaningful Source 
ID may help you distinguish this virtual alarm’s sub-alarms from other alarms. Click 
OK to close the window.

12 Click OK.
The Build Virtual Alarm window closes and the newly created alarm appears at the 
specified path, under Virtual alarms, in your multiviewer’s filtered System list (such as 
when a text or alarm level is selected in the sources table).

If the multiviewer’s IP address was added to an iControl applications server’s Service 
and alarm discovery table2 you will also be able to manage your multiviewer’s virtual 
alarms from the multiviewer’s GSM, by using the iControl GSM alarm browser.

2.To access the iControl Lookup locations page, where you can review and update the Service and alarm 
discovery table, click System tools on the Startup page, and then click Edit service locations.
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Modifying Virtual Alarms
To modify a virtual alarm

1 In the sources table, select a text or alarm level.
Alternatively, click the Actions tab.

2 Expand the filtered System list, and navigate to the virtual alarm you want to modify.
3 Right-click the alarm, point to Virtual alarm, and then click Edit.

The Build Virtual Alarm window appears.
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4 Modify your virtual alarm, by adding or removing sub-alarms, changing their 
contribution, the alarm name or path, etc. See Creating Virtual Alarms, on page 128, as 
needed. For example:

• after selecting the sub-alarms you want to remove from the table in the bottom 
half of the window, click the large up arrow button.

• after selecting the appropriate alarm provider from the list in the left-hand part of 
the GSM alarm browser pane, select the sub-alarms you want to add, from the 
right-hand part of the alarm browser, and then click the large down arrow button 
to transfer them to the table in the bottom half of the window.

5 Once you have completed your changes, click OK to close the Build Virtual Alarm 
window.

Deleting Virtual Alarms
To delete a virtual alarm

1 In the sources table, select a text or alarm level.
Alternatively, click the Actions tab.

2 Expand the filtered System list, and navigate to the virtual alarm you want to delete.
3 Right-click the alarm, point to Virtual alarm, and then click Delete.
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XEdit prompts you to confirm.

4 Click Yes to proceed.
The selected virtual alarm is removed from your configuration.
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Managing Alarm Logging

Adding a GSM log plug-in
To add a log plug-in to your multiviewer’s GSM

1 Make sure your multiviewer is specified as a lookup server in the iControl application 
server’s configuration. See Specifying your multiviewer as a lookup server for iControl, 
below.

2 Open iC Navigator. Refer to Starting iC Navigator, in the iControl User Guide, if needed. 
See Related Documentation, on page 11.

3 On the View menu, click General status managers.
The General Status Managers window appears.

4 In the left pane, click your multiviewer’s GSM.
5 In the main pane, click the Admin tab, and then click Actions on the second-level tab 

bar.

6 Click Add global.
The New Action window appears.

7 Click Event and Incident log, and then click New.
The Event and Incident Log Configuration window appears.

8 In Host name (or IP address), type the iControl application server’s IP address.
9 Under Advanced options, clear Enable incident log.
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10 Click OK.
Your new log plug-in appears under Global actions.

11 Close General Status Managers.
In iControl Navigator, you may now open Event Log Viewer, and search the application 
server’s event log database for any relevant alarm information logged by your 
multiviewer. Refer to the iControl User Guide for more information. See Related 
Documentation, on page 11.

Specifying your multiviewer as a lookup server for iControl
To specify your multiviewer as a lookup server for iControl

1 Open a Web browser window, and enter the IP address or host name of the iControl 
application server whose event log you want to use, in the address bar.
iControl’s Startup page appears.
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2 Click iControl admin.
3 If the iControl admin login page appears, type the appropriate user name and 

password, and then click Log In.
The iControl admin page appears.

4 Click Lookup locations.

The Lookup location page appears.
5 In the Service and alarm discovery area, type your multiviewer’s IP address, and then 

click Add lookup.

Your multiviewer’s IP address appears as a lookup entry, at the bottom of the Service 
and alarm discovery area.

Lookup
locations
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Enabling logging for a native alarm
To allow an alarm to be logged to the GSM log plug-in configured for this system

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar.
A hierarchical list representing the current system appears.

2 Expand the multiviewer whose alarms you want to log, navigate to the appropriate 
alarm, and then click the alarm to select it.

3 In the Properties pane, select the Logging enabled check box to have the multiviewer 
publish this alarm to the application server’s log, each time this alarm is triggered.

4 Click Apply to all if you want to apply this setting to all other alarms with the same 
name, throughout the system.
In the example, clicking Apply to all will enable logging for the Video Loss alarm on 
every multiviewer input in your system.

5 Repeat this procedure until logging is enabled for all alarms that require it.
6 On the File menu, click Save.
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Disabling logging for a virtual alarm
To prevent a virtual alarm from being logged to the GSM log plug-in

1 In the sources table, select a text or alarm level.
Alternatively, click the Actions tab.

2 Expand the filtered System list, and navigate to the virtual alarm you want to modify.
3 Right-click the alarm, point to Virtual alarm, and then click Edit.

The Build Virtual Alarm window appears.
4 In the bottom area of the window, select Not logged.
5 Click OK to close the Build Virtual Alarm window.
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Publishing Alarms to SNMP Managers

Identifying Target SNMP Managers
To identify the target SNMP managers

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar.
A hierarchical list representing the current system appears.

2 Click the multiviewer whose SNMP trap targets you want to identify.
3 If your target SNMP managers filter traps based on a specific community string, then 

the Properties pane, click the Community box (which contains “public” by default), 
and type the appropriate string.

4 Click the Trap targets box.

5 Click the button that appeared at the end of the box 
to open the SNMP Configuration window.
The trap targets list shows all trap targets currently 
identified for the selected multiviewer.
SNMP Managers that are trap targets for this 
multiviewer are identified by their host address and 
port number.

6 Add, remove, or modify trap targets as needed, and 
then click OK to confirm and apply the changes, or 
click Cancel to close the SNMP Configuration 
window without saving your changes to the trap targets list.

To add a trap target to the list
1 In the Host address box, type the IP address of the device that has the target SNMP 

manager.
2 In the Port box, type the port number through which the SNMP manager will be 

accessed.
3 Click Add.
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The new trap target is added to the list.

To modify an existing trap target
1 Click the trap target you want to modify in the list.

It becomes highlighted and its host address and port 
number appear in the data boxes, and the Edit button 
is available.

2 Type new or revised data in the data boxes.
3 Click Edit.

The revised data appears in the target list.

To remove a trap target from the list
1 Click the trap target you want to remove in the list.

It becomes highlighted and its host address and port number appear in the data boxes.
2 Click Delete.

The trap target is removed from the list.

Enabling SNMP Traps
To choose the traps that will be sent to the selected trap targets for this system

1 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar.
A hierarchical list representing the current system appears.

2 Expand the multiviewer whose traps you want to enable, navigate to the appropriate 
alarm, and then click the alarm to select it.

3 In the Properties pane, select the Trap enabled check box to have the multiviewer 
issue an SNMP trap each time this alarm is triggered.

TIP
The host address and port number remain in the data boxes. Hence the trap 
target can easily be added back to the list, by clicking Add, if it was removed 
in error.
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4 Click Apply to all to apply this setting to all other alarms with the same name, 
throughout the system.
In the example, clicking Apply to all will enable Video Loss SNMP traps for every input 
in your system. This is particularly useful for audio input errors, because of the large 
number of channels arriving at the multiviewer.

5 Repeat this procedure until all required SNMP traps have been enabled.
6 On the File menu, click Save.
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Introduction
This section describes Kaleido multiviewer rooms and their configuration.

Key Concepts

Term Description

Room A room is a visual grouping of displays that represent the physical 
displays positioned and sized as they are installed in an actual room. 
Multiple operators can share the same room. Display grouping creates a 
large virtual monitor wall that operators see as a single large display. The 
room definition specifies display resolutions and sizes, as well as zones 
that are used to display full screen layouts. See Managing Rooms, on 
page 146.

UHD room A Kaleido-IP X320 / X120 uses displays to output one or two UHDTV 
mosaic images. See Creating a Room, on page 146. 

Display versus 
monitor

Within the XEdit workflow, a display refers to the representation of a 
physical display monitor (such as a flat screen display) within a room, 
whereas a monitor represents a physical signal within a layout: for 
example, a video monitor displaying a specific video signal.

Full screen zone A full screen zone is a sub-section of a room. It can be any size and it can 
be positioned on any of the displays in the room. A full screen zone can 
be associated with one or more full screen layouts assigned to specific 
users.

Display library A display library contains a collection of predefined displays that can be 
conveniently reused to configure your system’s rooms. More than one 
display library can exist.
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Managing Rooms
In XEdit, a room represents a grouping of displays on the monitor wall driven by your 
Kaleido multiviewer system. When creating a room, you add displays, and assign each of 
them an output head. You can also define full screen zones. 

Creating a Room
When the multiviewer feeds one or more individual displays, use the following procedure 
to configure each output head individually. Each display can have different resolutions and 
orientations. 

When configuring a Kaleido-IP X320 / X120 UHD multiviewer, configure it to use one or two 
displays that are later set to use the UHD display resolution parameter (UHDTV-1), which is 
available for this model’s HDMI outputs. See Changing Room Display Resolutions, on 
page 157.

To create a room
1 Click the Rooms tab in the main window.
2 On the File menu, click New.

An empty room with a black background appears in the main window.
3 Add the appropriate number of displays, and configure them to match your actual 

installation. See Adding Displays, on page 148, and Configuring Displays, on page 153.
4 Optionally add full screen zones (see Adding Full Screen Zones on page 151).
5 On the File menu, click Save.

The Save Room window appears.

6 Type a name for the new room, and then click Save.

Notes
• A room name cannot exceed 7 characters.
• A room can only be saved once every display has been assigned an output 

head (see Adding Displays on page 148).
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Opening Rooms
To open an existing room

1 Click the Rooms tab in the main window.
2 On the File menu, click Open.

The Open Room window appears.

3 Select the room you want to open, and then click Open.
The selected room appears in the Rooms tab.
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Closing Rooms
To close a room

• On the File menu, click Close. Alternatively, click the toolbar’s Close button .

Deleting Rooms
Before deleting a room, make sure you have exported any layouts you might want to save 
from that room (see Exporting Layouts on page 182), or that you have copied them to 
another room (see Copying Layouts on page 179).

To delete a room
1 Open the room you want to delete (see Opening Rooms on page 147).
2 On the File menu, click Delete. Alternatively, click the toolbar’s Delete button .

The system prompts you to confirm.

3 Click Yes to proceed.
The room and all the layouts that were associated with it are removed from your system 
configuration.

Adding Displays
To add a display to a room

1 Select a display from the display library and drag it onto the room area.
Alternatively, click the toolbar’s Display button , and then click the room area to add 
a custom display.

Notes

• When you have more than one room open, you can switch from one to 
another by clicking the tabs at the bottom of the window.
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2 Expand the filtered System list on the Tools pane, and then drag the appropriate 
output head onto the display in the Rooms tab.

The name of the output head is indicated on the display. 

Note: All currently open display libraries appear on the Tools pane. Custom 
display libraries are stored separately from the XEdit workspace. 
See Managing Display Libraries on page 161 for details.

Filtered Display Room Selected
selected displaySystem list library area display
Properties of the
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One output head cannot be assigned to more than one display at a time. When 
different displays are assigned the same output head, if the displays are part of the 
same room, then XEdit will issue an error message and prevent you from saving the 
room until the head assignment is corrected.
However, to facilitate room management, XEdit will let you assign the same head to 
displays that are located in different rooms, but such conflicting assignments will be 
marked in red in the filtered System list displayed on the Tools pane, and should be 
resolved by removing a conflicting display (see Removing Displays on page 151), or by 
deleting the conflicting room (see Deleting Rooms on page 148).

3 On the File menu, click Save.

IMPORTANT
Conflicting head assignments
Neglecting to resolve conflicting head assignments could result in 
distorted layout elements on the monitor wall (which would 
happen, for example, if the same output head is assigned to two 
displays with different resolutions).
To prevent this from happening, open the old room configuration, 
and look for red Head elements in the filtered System list that 
appears at the bottom of the Tools pane. Clear the unwanted head 
assignments, either by removing the corresponding displays from 
the room layout (see Removing Displays on page 151), or by 
completely deleting the old room configuration if you do not need 
it anymore (see Deleting Rooms on page 148).

Card slot letter (A, B, etc.)
Output head (1, or 2)

Co
nf

lic
ts

 a
re

 s
ho

w
n 

in
 re

d



151

Kaleido Software
User’s Manual

The updated room configuration is saved.

Removing Displays
Before removing a display, you might consider copying layout parts associated with this 
display to other display areas (see Display layout on page 165).

To remove a display from a room
1 Open the room that contains the display you want to remove (see Opening Rooms on 

page 147).
2 If there is a full screen zone associated with this display, click it, and then press Delete 

on your keyboard to remove it.
3 Click the display and then press Delete on your keyboard.
4 On the File menu, click Save.

The updated room configuration is saved.

Adding Full Screen Zones

To add a full screen zone to a room
1 Click the Full screen zone button  i5n the toolbar, and then click the room area to 

create the full screen zone.
2 Position and resize the zone as appropriate.
3 In the Properties pane, click the Friendly name box, and then type a name for the 

zone.

4 Press Enter on your keyboard to validate the new name, and then click Save on the File 
menu.
The room configuration is saved.

Notes
• Adding full screen zones to a room is optional.
• Do not span a full screen zone across more than one display; use spanned 

video monitors instead. See Spanning on page 170 for more information.



152

Setting Up Rooms
Removing Full Screen Zones

Removing Full Screen Zones
Before removing a full screen zone, make sure there are no full screen layouts associated 
with this zone in your system configuration. If there are still full screen layouts for this zone, 
then XEdit will issue an error message and prevent you from saving the room. See Deleting 
Layouts on page 176.

To remove a full screen zone from a room
1 Open the room that contains the full screen zone you want to remove (see Opening 

Rooms on page 147).
2 Click the full screen zone, and then press Delete on your keyboard.
3 On the File menu, click Save.

The updated room configuration is saved.
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Configuring Displays
The monitor wall driven by your Kaleido multiviewer system may include displays of 
various shapes and sizes, each with its specific characteristics. The displays you add to your 
rooms in XEdit must be configured to match the attributes of their physical counterparts. 
The Kaleido Software includes a set of predefined resolutions that cover most standard 
displays. Any custom resolutions you add to this set will be available throughout the 
system, and can be reused when configuring any display in any room.

You can manually configure display resolutions in two ways: either globally, from the Tools 
menu, or by clicking a specific display in a room.

In addition to monitor wall displays, your system can include other monitors connected to 
the multiviewer’s monitoring outputs (one for each output head). The monitoring output 
format on a given head depends on the resolution configured for the corresponding 
multiviewer output, and, in the case of a 1080-line resolution, on the selected scan format 
(interlaced, progressive) for this output head. 

Viewing Room Display Properties
To view the properties for one of the displays in a room

1 Click the display whose properties you want to view.
2 Review the attributes and values that appear in the Properties pane.

Configuring Custom Resolutions from the Tools Menu
To create a custom display resolution from the Tools menu

1 On the Tools menu, click Edit resolutions.
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The Edit Resolution Settings window appears.

2 Select the resolution you want to customize (or the one on which you want to base a 
new resolution), from the list at the bottom of the window.

3 Under either the Porch or the Modeline section—depending on whether you prefer to 
specify front porch, back porch, sync, and active values, or blank start, sync start, sync 
end and blank end—, set the refresh rate and other timing parameters so that they 
match those of the physical display you need to configure.

Note: When you modify one of the default resolutions, you can only save 
your changes as a new resolution. On the other hand, custom resolutions 
can be tweaked and saved repeatedly until the final configuration is 
achieved. However, make sure that the active width and active height values 
you specify match those of one of the default resolutions, otherwise your 
custom resolution will be ignored.
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4 Type a name for the new resolution in the Friendly name box, and then click Save as to 
close the Edit Resolution Settings window. Alternatively, if you are modifying an 
existing custom resolution, you can click the Save button.

Configuring a Custom Resolution from a Specific Display in a Room
To configure a custom resolution from a specific display in a room

1 Click the display whose resolution you want to configure.

Note: In XAdmin’s Status and Options page, these parameters are listed 
under the corresponding output card information, according to the 
blank/sync start/end modeline system, and with the sync polarity expressed 
as a number between 0 and 3. See Viewing a Multiviewer’s Status Information 
in the multiviewer’s Installation & Service Manual for more information.

Type a name
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2 Click the Display resolution box in the Properties pane, and then click the button that 
appeared on the right side of the resolution presets.

The Edit Resolution Settings window appears.

3 Under either the Porch or the Modeline section, depending on whether you prefer to 
specify front porch, back porch, sync, and active values; or blank start, sync start, sync 
end and blank end, set the refresh rate and other timing parameters so that they match 
those of the physical display you need to configure.

4 Type a name for the new resolution in the Friendly name box, and then click Save as to 
close the Edit Resolution Settings window. Alternatively, if you are modifying an 
existing custom resolution, you can click the Save button.

5 On the File menu, click Save.

Note: In XAdmin’s Status and Options page, these parameters are listed 
under the corresponding output card information, according to the 
blank/sync start/end modeline system, and with the sync polarity expressed 
as a number between 0 and 3. Refer to Viewing a Multiviewer’s Status 
Information in the multiviewer’s Installation & Service Manual for more 
information. See Related Documentation, on page 11.

Edit resolution 
settings button
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Changing Room Display Resolutions
To change the resolution for a display in a room

1 Click the display you want to configure.
2 In the Properties pane, expand the Display resolution list, and then select the 

appropriate resolution from the list.

For example, to configure a Kaleido-IP X320 / X120 multiviewer’s display for a UHD 
display DVI / HDMI output, select UHDTV-1 from the Display resolution list. 

3 On the File menu, click Save.

Scan Format
The scan format parameter determines if the video output is to be in interlaced or 
progressive scan format. 

To configure the scan format 
1 In the Room area, click the display associated with the multiviewer output head whose 

properties you want to configure.
2 Click the Scan format box, and then select the appropriate scan format: Progressive or 

Interlaced. 

3 On the File menu, click Save.

\Disabling the Dashboard
A room can be configured to prevent the dashboard from appearing on specific displays. 
For instance, in a production control room, or if the multiviewer is used in the studio 
backdrop you may not want the dashboard to pop up, regardless of alarm conditions.

Note: Even when a Kaleido-IP X320 / X120 multiviewer’s display output is 
set to UHD output resolution, the maximum streaming output resolution is 
HD (1920 × 1080p).

Scan format 
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To disable the dashboard for a specific display
1 Click the display on which you do not want the dashboard to appear, and then clear the 

Allow dashboard display check box in the Properties pane.

2 On the File menu, click Save.

Changing a Display’s Aspect Ratio

To change the aspect ratio of a display in a room
1 Click the display whose aspect ratio you want to set.
2 In the Properties pane, expand the Aspect ratio list, and then select the appropriate 

aspect ratio preset from the list.

Alternatively, type the ratio directly in the box.
3 On the File menu, click Save.

Changing a Display’s Diagonal Size
To change the diagonal size of a display in a room

1 Click the display whose size you want to configure.
2 Click the Diagonal size box in the Properties pane.

Note: Make sure the dashboard remains enabled on a least one display, in 
a room where alarm conditions can be monitored, since it is your only way 
to be notified in case of a card booting in offline mode, a duplicate 
IP address, a defective fan, a power supply alarm, etc.

Notes
• It is important to properly set the aspect ratio of a display, since this will 

affect the proportions of every component you will use to create layouts 
for this room. For instance, if the aspect ratio of a display does not match 
the aspect ratio of the actual display in the physical room, then a video 
window inside a layout will show distorted images.

• If you change the display aspect ratio later in the process, layouts created 
before the change will be broken.
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3 Select the appropriate unit of measurement from the list that appears inside the 
Diagonal size box, and type the size.

4 On the File menu, click Save.

Changing a Display’s Height
To change the height of a display in a room

1 Click the display whose height you want to configure.
2 Click the Height box in the Properties pane.

3 Select the appropriate unit of measurement from the list that appears inside the 
Height box and type the height.

4 On the File menu, click Save.

Changing a Display’s Width
To change the width of a display in a room

1 Click the display whose width you want to configure.
2 Click the Width box in the Properties pane.

3 Select the appropriate unit of measurement from the list that appears inside the Width 
box and type the width.

4 On the File menu, click Save.

Changing a Display’s Rotation
To change the rotation setting for a display in a room

1 Click the display you want to configure.
2 In the Properties pane, expand the Rotation list, and then select the configuration that 

matches the way the actual display is mounted in the physical room:
• normal
• rotated 90 degrees clockwise
• rotated 90 degrees counterclockwise
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3 On the File menu, click Save.
If you already had created layouts for the room associated with the display whose 
rotation setting you just changed, you may need to adjust layout elements in these 
layouts (see Creating Layouts on page 165).

Changing a Display’s Position
To change position of a display in a room

1 Click the display whose position you want to configure.
2 Click the Position box in the Properties pane, then click the button that appears inside 

the box.

The Specify Position window appears.

3 Type the appropriate values in the X (mm), and Y (mm) boxes, and then click OK.
The values appear in the Position box.

4 On the File menu, click Save.
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Managing Display Libraries
The default display library includes configurations for the most popular display models. You 
can also create your own display configurations, and add them to custom display libraries. 
All open display libraries appear on the Tools pane. The default display library is always 
open. Custom display libraries are stored separately from the XEdit workspace, and must be 
opened explicitly.

Creating Custom Display Libraries
To create a custom display library

1 Click the Rooms tab in the main window.
2 On the File menu, click New. Alternatively, click Open to open an existing room.
3 On the File menu, click New display library.

Alternatively, right-click anywhere inside the Tools pane’s display library area, and then 
click New display library on the menu.

The new display library appears below the default display library area on the Tools 
pane.

4 Right-click anywhere in the display library area, and then click Save Display Library on 
the menu.
The Save Display Library window appears.

5 Type a name for the new custom display library, and then click Save.
Custom display libraries are stored separately from the XEdit workspace. They have 
a.dlib extension.

New (empty) display library



162

Setting Up Rooms
Adding Displays to Custom Libraries

Adding Displays to Custom Libraries
To add a display to a custom display library

1 Click the Display button  on the toolbar, and then click the room background to add 
a display. Alternatively drag a display from a display library onto the room, or choose a 
display within an existing room.

2 Customize the display as needed, and then drag it onto the display library while holding 
the Ctrl key.

Removing Displays from Custom Libraries
To remove a display from a custom library

• Click the display you want to remove and then press Delete.
• Alternatively, right-click its icon and then click Delete entry on the menu.

Note: It is not possible to further customize a display once it is inside a 
library. Should you need to do so, drag the display to the room area, apply 
the required changes, and then Ctrl+drag the modified display to the 
display library. You can then remove the obsolete display from the library.

Ctrl+click to drag display
to custom library
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Closing Display Libraries
To close a display library

• Once the custom library is saved, you can right-click in the library area, and then click 
Close display library on the menu.

• Alternatively, click Close display library, on the File menu.

Opening Display Libraries
To open a custom display library

• On the Tools pane, right-click anywhere in the display library area, and then click Open 
display library on the menu.

• Alternatively, click Open display library, on the File menu.

Note: It is possible to have multiple custom libraries open at the same time.
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Introduction
This section describes layout elements and their purposes, and provides detailed 
configuration instructions.

Key Concepts

Layouts and Layout Elements
Layout elements

Term Description

Layout A layout is a visual grouping of monitors that appear on displays within a 
room. A layout includes different types of monitors in a variety of placements 
and sizes. There are two types of layouts: room layouts, and full screen layouts. 
See Managing Layouts on page 172.
Note: Before creating layouts, you may want to review your room 
configurations. Should a display be rotated in a room (see Changing a 
Display’s Rotation on page 159), some layout elements in your existing room 
layouts may require adjustments.

Display layout In a room layout, the parts that cover the room displays can be managed 
separately. You can consider each of these parts as a display layout. You can 
duplicate a display layout to another display area within the same layout, or 
to any other layout, in any room within your system. You can mix and match 
individual display layouts to create a new room layout.
Use the Copy layout to feature, to build a display layout library from your 
most useful display layouts. See Copying Layouts on page 179. If your system 
does not include a single-display room, you might consider momentarily 
creating one for this purpose. Alternatively, copy your display layouts, one by 
one, to Display 1, in separate room layouts. Once you have isolated a display 
layout to a separate room layout, consider exporting this room layout as a 
file, so you can reuse it in other multiviewer systems. See Exporting Layouts 
on page 182, Importing Layouts, on page 182, and Rearranging Layouts 
Across Displays, on page 180.

Monitor A monitor is an element that is part of a layout. The Kaleido Software 
supports several types of layout elements (such as clocks, video monitors, 
audio monitors, UMDs, time code monitors, etc.), as well as composite 
monitors. All layout elements, except for the video monitors and subtitling 
monitors are graphical layout elements. See Adding Monitors to a Layout on 
page 183.
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Video monitor A video monitor is a layout element used to define an 
area for displaying a video signal. It is represented in 
XEdit by the boundary box made visible by clicking 
the element.
Within a video monitor, the video window is the active 
area where the video signal is displayed, possibly 
including closed captions or teletext. The video 
window is represented in XEdit by the blue rectangle inside a video monitor. 
The video window does not necessarily cover the complete video monitor’s 
area. See Configuring Video Monitors on page 191.

Composite 
monitor

A composite monitor is a group of primary elements that can be seen as a 
single object within a layout. Composite monitors typically include a video 
window, one or more audio level meters, and a UMD with two tallies.

Time code 
monitor

A time code monitor displays the Ancillary Time Code (ATC) from an HD video 
signal, or the time code found in an embedded SDI video signal, part of the 
vertical interval of an analog signal (VITC), or other external Linear Time Code 
(LTC). This monitor also supports time code information from external 
providers (see Configuring logical sources based on external alarm providers 
on page 81). Time code monitors can be used for monitoring the duration of 
programs. See Configuring Time Code Monitors on page 216. 

Timer A timer can be slaved to a production timer, controlled from the 
Kaleido-RCP2 (with start, stop and reset control through GPI inputs), and/or 
used for monitoring the duration of programs.
Three timer modes are available: (1) UP: timer counts up starting from zero up 
to a preset time, (2) DOWN: timer counts down from a preset time to zero, 
and (3) REMAINING: timer counts down from the current time until it reaches 
a preset time.
A timer monitor is based on a timer defined within the Kaleido Software. 
Timers are defined and configured in XEdit. Timer monitors can be 
configured directly on the monitor wall. See Configuring Timers on page 218.

Audio monitor An audio monitor (also called audio level meter or ALM) is a graphical layout 
element that provides a visual representation of sound. See Configuring 
Audio Monitors, on page 207, and Configuring Audio Scales, on page 212.

Loudness 
monitor

A loudness monitor is a graphical layout element that provides a visual 
representation of the perceived loudness of an audio program. It provides 
two measures (short-term, and momentary loudness) per audio program. 
See Configuring Loudness Monitors on page 210.

UMD An under monitor display (UMD) has a text label that can be static or 
dynamically updated by a peripheral device. It can also have left and right 
tally indicators. The UMD typically indicates the name of the video source 
seen in a video monitor. See Configuring UMDs on page 224.

Alarm monitor Alarm monitors help you see the status of global and virtual alarms, but their 
use is not limited to this type of alarms. When any alarm level is assigned to 
an alarm monitor, the status of this alarm is shown. When using the global 
alarm at the text label level, the alarm monitor displays the text value of the 
alarm, which is a readable name. See Configuring Alarm Monitors, on 
page 231 and Alarm latch, on page 311 for more information. 

Term Description
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Aspect Ratio
Aspect ratio information can be encoded within a video signal following different 
standards: AFD 2016, AFD VI, or WSS. The Kaleido Software may use this information to 
render the video raster in the target video window on the monitor wall.

Subtitling 
monitor

A subtitling monitor defines an area for displaying subtitles extracted from a 
video signal. By using a subtitling monitor you can monitor subtitling from a 
specific DVB or SCTE 27 stream, independently from the associated video 
stream. This requires the CC/XDS option to be enabled (see the multiviewer’s 
Installation & Service Manual for more information). See Configuring 
Subtitling Monitors on page 235.
Note: With the current version of the Kaleido Software, the subtitling 
monitor supports DVB and SCTE 27 subtitles, from Kaleido-IP sources only.

Metadata 
monitor

A metadata monitor defines an area for displaying XDS, or digital content 
advisory descriptor (CAD) information compliant with CEA-766-D, extracted 
from a video signal. This requires the CC/XDS option to be enabled (see the 
multiviewer’s Installation & Service Manual for more information). 
See Configuring Metadata Monitors on page 240.

V-chip monitor The V-chip monitor provides a visual indication of the V-chip rating from the 
CC (608) metadata in an SD video signal, or from the CC (608) legacy caption 
data, when such data is present within an HD video signal. This requires the 
CC/XDS option to be enabled (see the multiviewer’s Installation & Service 
Manual for more information). See Configuring V-Chip Monitors, on 
page 242.

Clock A clock is the visual representation of time in a video or display. It can be 
based on a reference LTC signal or on the multiviewer system time. 
See Configuring Clocks on page 244. 

Monitor library A monitor library is a collection of predefined layout elements. Monitors from 
a library can be used to help construct a layout. Default monitor libraries are 
available from XEdit’s Tools pane. You can also create your own libraries. 
See Managing Monitor Libraries on page 259.
Note: As of version 7.40 of the Kaleido Software, two new 16:9, and 4:3 
composite monitor libraries with proportional elements are available. In these 
libraries, the primary monitors within each composite have all their 
dimensions defined as a percentage, which allows intuitive resizing, whereas, 
in the legacy maximum video area libraries, some primary monitors have fixed 
height or width, to allow more space for the video window. The new 
composite monitors with proportional elements suit most purposes. It is 
preferable to always use them, unless you specifically require monitors with 
fixed dimensions.

Term Description

Term Description

AFD VI Active format description encoded in the video index.

AFD 2016 Active format description encoded in the ancillary data (according to the 
SMPTE ST 2016 standard).
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The aspect ratio of video displayed on the monitor wall can be automatically adjusted. With 
multiple video players (monitors) on a monitor wall, in multiple formats/aspect ratios, this 
makes it easy to switch from one format to another in the same player. Automatic 
adjustment can be accomplished in two ways:

• Video monitor slaved to input: A video monitor can be slaved to the input format such 
that the video monitor will change its aspect ratio according to the input signal type 
(for example, SD, HD, DVI).

• Video raster follows AFD/WSS: A video monitor can be configured so that WSS, AFD VI, 
or AFD 2016 metadata is used to crop (and/or add black bars to) the video signal, giving 
the video raster the correct aspect ratio.

This metadata can be reported as text inside a UMD. Its presence can also be made 
available in alarms as well as through SNMP traps.

See Configuring Automatic Aspect Ratios on page 197, for more information.

Cropping Mode
This feature applies to:

The display of a video signal can be cropped to remove unwanted portions, or to zoom in 
on a specific portion of the image. In XEdit, you can configure a video monitor to display 
signals in underscan or overscan mode (see Video Cropping/Zooming on page 196).

Underscan: When a video window is in underscan mode, it displays the full signal without 
cropping any of the image.

Overscan: When a video window is in overscan mode, it displays a selected area of the 
image, typically zoomed and cropped to fit the window. By default, the overscan mode 
crops the left, right, top and bottom margins by 5% each.

Changing the underscan/overscan mode dynamically
It is possible to dynamically change the overscan/underscan mode based on the current 
feed assigned to a video monitor. For example, you can change logical sources in a video 
monitor using Gateway commands, where a video source requires the monitor to be in 
overscan mode but a graphics source requires the monitor to be in underscan mode to 
avoid cropping the image. A custom action script can make the monitor change its scan 

WSS Wide Screen Signaling.

Video raster Video signal that is displayed inside the video monitor on a monitor wall.

Note: Aspect ratio decoding can also be configured for each multiviewer 
input, based on decoded AFD or WSS metadata when such information is 
available within the input signal (see Calibrating Aspect Ratio Decoding on 
page 105).

Term Description

Kaleido-IP X320 / X120 Kaleido-IP VM
 
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mode depending on the format detected. For information on how to create such a script, 
contact Technical Support (Grass Valley Technical Support, on page 360).

Custom overscan
The amount of overscan applied can be customized to some extent, which will depend on 
the original signal resolution, relative to the size of the video window where the image is 
displayed. Excessive cropping may result in a loss of video image on the monitor wall. 
Likewise, when a layout has several monitors with heavy cropping settings on the same 
display head, some video windows may turn blank.

The examples listed below may be used as guidelines. Unless specified otherwise, these are 
based on a 1080p display resolution. Displays with a lower resolution can afford more 
cropping.
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Spanning
This feature applies to:

Graphical layout elements (UMDs, audio monitors, etc.) and video monitors can be made to 
span across multiple heads, on up to 4 displays, portrait or landscape, in any combination. 
On displays that fit perfectly side by side, this gives the impression of having one large 
screen. When any layout element is spanned across displays, an icon automatically appears 
in the top right corner.

To avoid pixel cropping on spanned monitors, you must position room displays so that 
there is no gap between them. Use XEdit’s Remove horizontal space and/or Remove 
vertical space buttons to make sure your displays are perfectly positioned for spanning.

You must also ensure that each display has the same pixel-per-inch (or -per-mm) ratio, 
calculated as horizontal resolution (pixels) divided by display width (inches or mm) and 
vertical resolution divided by display height. Ideally, you should use displays that have the 
same physical size and resolution.

The figure below shows two displays properly sized and positioned for monitor spanning.

Kaleido-IP X320 / X120 Kaleido-IP VM
 

Warning icon appears even if monitor
is one pixel over the edge

Video monitor spanned over two displays
with warning icon in top right corner

Horizontal: 1600 pixels ÷ 800 mm = 2 pixels/mm
Vertical: 1200 pixels ÷ 600 mm = 2 pixels/mm

Horizontal: 1366 pixels ÷ 683 mm = 2 pixels/mm
Vertical: 768 pixels ÷ 384 mm = 2 pixels/mm
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Notes

• Monitors can extend outside the edge of a display, but not completely.

• The use of a mouse is not completely supported with spanned video 
monitors.

• Do not span a layout element beyond a maximum of 3000 × 1800 pixels. 
When spanning or scaling video monitors in a layout, avoid heavy 
cropping settings (generally avoid exceeding 15% in any direction).

Maximum size of spanned video 
element = 3000 × 1800 pixels

Maximum horizontal 
cropping = 15%

Maximum vertical 
cropping = 15%
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Opening Layouts
To open an existing layout

1 Click the Layouts tab.
2 On the File menu, click Open. Alternatively, click the toolbar’s Open button .

The Open Layout window appears.

• Double-click Full screen layout, to open a full screen layout.
• Double-click Multihead layout, to open a room layout.

3 Double-click the appropriate room.

4 Click the layout you want to open.

Note: Before creating or modifying a layout for a Kaleido-IP system, review 
the guidelines listed in Network Considerations in the multiviewer’s 
Installation & Service Manual for more information.
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5 If you want to open multiple layouts in a single operation, extend your selection by 
using the multi-selection Shift+click or Ctrl+click keyboard shortcuts.

6 Click Open.
The selected layouts appear in the Layouts tab.
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Loading a Layout on the Monitor Wall
To load the current layout on the monitor wall, directly from XEdit, in online mode

• Click LOAD button on the toolbar.

The current layout appears on the monitor wall.

Closing Layouts
To close the current layout

• On the File menu, click Close. Alternatively, click the toolbar’s Close button .

Creating Room Layouts
To create a room layout

1 Click the Layouts tab in the main window.
2 On the File menu, click New.

TIP
When you have opened more than one layout, you can switch from one to 
another by clicking the tabs at the bottom of the window.



175

Kaleido Software
User’s Manual

The Create a New Layout window appears. It lists all the existing rooms and full screen 
zones in your system.

3 Click the name of the room where this layout will be displayed.

An empty layout appears.
4 Add at least one monitor to the layout (see Adding Monitors to a Layout on page 183).
5 Assign every monitor a logical source (see Assigning Logical Sources or Monitor Wall 

Destinations to Monitors on page 185).
6 On the File menu, click Save.

The Save Layout window appears.

7 Type a name for the layout, and then click Save.

Creating Full Screen Layouts
To create a full screen layout

1 Click the Layouts tab in the main window.
2 On the File menu, click New.
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The Create a New Layout window appears. It lists all the existing rooms and full screen 
zones in your system.

3 Click the name of the full screen zone in which this layout will be displayed.

An empty layout area appears.
4 Add at least one monitor to the layout (see Adding Monitors to a Layout on page 183).

If the full screen layout includes more than one composite monitor, you can designate 
one of them who will receive its source assignments from the monitor under the mouse 
pointer on the monitor wall, by selecting the Full screen layout monitor option in the 
Properties pane.

Make the appropriate assignments for the other elements in the layout (see Assigning 
Logical Sources or Monitor Wall Destinations to Monitors on page 185).

5 On the File menu, click Save.
The Save Layout window appears.

6 Type a name for the full screen layout, and then click Save.

Deleting Layouts

Deleting an open layout

To delete an open layout
1 If you have opened more than one layout (see Opening Layouts on page 172), select 

the layout you want to delete by clicking the appropriate tab at the bottom of the 
window.
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2 On the File menu, click Delete.
The system prompts you to confirm.

3 Click Yes to proceed.
The layout is removed from your system configuration.

Deleting layouts from the Open Layout window

To delete layouts from the Open Layout window
1 Click the Layouts tab.
2 On the File menu, click Open. Alternatively, click the toolbar’s Open button .

The Open Layout window appears.
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• Double-click Full screen layout, to delete a full screen layout.
• Double-click Multihead layout, to delete a room layout.

3 Double-click the appropriate room.

The layouts associated with the selected room appear.
4 Click the layout you want to delete.
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5 If you want to delete multiple layouts in a single operation, extend your selection by 
using the multi-selection Shift+click or Ctrl+click keyboard shortcuts.

6 Click the Delete button  on the toolbar.
The system prompts you to confirm.

7 Click Yes to proceed.
The selected layouts are removed from your system configuration.

8 Click Cancel to close the Open Layout window.

Copying Layouts
To copy a layout

1 Open the layout you want to duplicate.
2 On the File menu, click Copy layout to, point to the appropriate room, and then either 

select an existing layout from the list, or click Empty layout.

A two-pane window appears. The left pane represents the source layout, and the right 
pane represents the destination layout.
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3 Drag one head from the source pane to the destination pane.

4 Repeat until every part of the source layout you want to copy has been dragged onto 
the appropriate head in the destination pane, and then click Copy layout.

• If you selected an existing layout as your destination layout, the updated 
destination layout is automatically saved, and appears in the Layouts tab.

• If you selected Empty layout as your destination layout, the Save Layout window 
appears.

• In Save Layout, type a name for the new layout, and then click Save.
Alternatively, you can replace an existing layout with the new layout.

Rearranging Layouts Across Displays
In a room layout, the parts that cover the room displays can be managed separately. You 
can consider each of these parts as a display layout (see Display layout on page 165). In 
some situations, you might want to move these parts around, within a room layout, or from 
one room layout to another. The following procedure describes how to swap two display 
layouts.

To rearrange a layout
1 Open the layout you want to rearrange (see Opening Layouts on page 172).
2 On the File menu, click Copy layout to, point to the appropriate room, and then click 

the name of the current layout (that is, the layout you want to rearrange).
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A two-pane window appears. The left pane represents the source layout, and the right 
pane represents the destination layout.

3 Drag one head from the source pane to a head in the destination pane.

4 Repeat until every part of the source layout you want to copy has been dragged to the 
appropriate head in the destination pane, and then click Copy layout.
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Your rearranged layout is automatically saved, and appears in the Layouts tab.

Exporting Layouts
To export a room layout

1 Open the room layout you want to export (see Opening Layouts on page 172).

If you have opened more than one layout, select the layout you want to export by 
clicking the appropriate tab at the bottom of the window.

2 On the File menu, click Export to file.

The Export to File window opens.
3 Navigate to the location where you want to save the layout file, change the file name, if 

necessary, and then click Save.
The layout is saved to your file system as a Kaleido Room Layout (KRL) file. You can use 
this file as a backup, or reuse it by importing it to another room or to another system.

Importing Layouts
To import a layout

1 On the File menu, point to Import from file, and then click the room into which you 
want to import the layout.

Note: XEdit does not support exporting full screen layouts.

Note: Logical source and monitor wall destination assignment are not 
exported.
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The Import from File to Room window opens.
2 Navigate to the Kaleido Room Layout (KRL) file you want to import, click it, and then 

click Open.
The layout appears in the Layouts tab.
If the number of displays in the target room (or their position), does not match the 
original room configuration, the imported layout is mapped to the target room’s 
display areas, on a best effort basis. Layout elements associated with Display 1 in the 
originating room, appear on Display 1 in the target room, elements from Display 2 
appear on the target room’s Display 2 area, and so on.

3 Rearrange the different parts of your layout across the display areas, if needed 
(see Rearranging Layouts Across Displays on page 180).

4 Assign logical sources and monitor wall destinations to the monitors, if necessary 
(see Assigning Logical Sources or Monitor Wall Destinations to Monitors on page 185).

5 On the File menu, click Save to add the layout to the selected room.
Alternatively, use Save as, to save the layout under a different name.

Adding Monitors to a Layout

Monitor Limitations in a Layout

Notes

• When adding monitors to a layout, avoid overlapping graphical layout 
elements with one another. For example, making sure that there be no 
overlap between UMDs and audio monitors in a layout will ensure optimal 
performance.

• Before creating or modifying a layout for a Kaleido-IP system, review the 
guidelines listed in Network Considerations in the multiviewer’s 
Installation & Service Manual for more information.
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To add monitors to a layout
1 Drag components from the monitor libraries onto the layout, or create custom 

components, using the toolbar buttons ( ).

2 Resize, move and configure the monitors until you achieve the layout you want.
For detailed configuration instructions on the different monitor types, see:

• Configuring Video Monitors, on page 191
• Configuring Audio Monitors, on page 207
• Configuring Loudness Monitors, on page 210
• Configuring Time Code Monitors, on page 216
• Configuring Timers, on page 218
• Configuring UMDs, on page 224
• Configuring Alarm Monitors, on page 231
• Configuring Subtitling Monitors, on page 235
• Configuring Metadata Monitors, on page 240
• Configuring V-Chip Monitors, on page 242
• Configuring Clocks, on page 244
• Working with Composite Monitors, on page 249
• Managing Monitor Libraries, on page 259

Removing Monitors
To remove a monitor from a layout

• Click the monitor you want to remove, and then press Delete on your keyboard.

Duplicating Monitors
To duplicate a monitor within a layout

1 Click the monitor you want to duplicate.
2 On the Edit menu, click Duplicate. Alternatively, press Ctrl+D.

A copy of the monitor is added to the layout.

• In the case of the Kaleido-IP multiviewers, every output head supports up 
to 64 video monitors, across both the current layout and a full screen 
layout when used.

Note: All open monitor libraries appear on the Tools pane. See Monitor 
library on page 167.

Notes (continued)

TIP
To remove multiple monitors in a single operation, extend your selection by 
using the standard Ctrl+click keyboard shortcut.
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3 Move the new monitor to the appropriate position on the layout.
4 Press Ctrl+D again, and repeat until the number of copies of the monitor are added to 

the layout.
The new copies are automatically positioned at intervals matching the relative 
positions of the original monitor and its first duplicate.

Assigning Logical Sources or Monitor Wall Destinations to Monitors 
When you load a layout to the monitor wall, monitors that are not configured with a logical 
source assignment may be blank (until you manually set the assignment) but, if a monitor 
was configured as a monitor wall destination, then it will remember its last source 
assignment (if any). Keep in mind that, if two monitors are assigned the same monitor wall 
destination, they will both reflect source assignments made to any of them during 
operation. You may want to keep track of already assigned monitor wall destinations, if this 
is something you want to avoid, and carefully review any layouts you create or modify 
based on elements from other layouts.

The Tools pane includes lists from which you can make assignments by dragging logical 
sources and monitor wall destinations onto monitors (you do not need to select the 
monitor first).

To assign a logical source to a monitor
• Select a logical source from the Channels/Sources list, on the Tools pane, and then 

drag it onto the appropriate monitor.

To assign a monitor wall destination to a monitor
• Select a destination from the Monitor wall destinations list, on the Tools pane, and 

then drag it onto the appropriate monitor.

Type in the filter box located above the Channels/Sources, and Monitor wall destinations 
lists, to hide sources or destinations that do not match the filter text or regular expression.
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When assigning logical sources or monitor wall destinations to monitors in a layout, it may 
happen that the selection migrates to an adjacent element from the Channels/Sources or 
Monitor wall destinations list during the drag-and-drop operation. Once you selected a 
logical source or monitor wall destination from the corresponding list, dragging the 
selected element horizontally until the pointer exits the Tools pane, or performing a slower 
drag-and-drop may help.

To assign different monitor wall destinations to individual components within a 
composite monitor

1 Click the composite monitor.
The current assignments for this composite appear in the Properties pane.

2 Make sure Monitor wall destination is set to None.

3 Double-click the composite monitor to unlock it.
4 Click a component you want to configure as a monitor wall destination, within the 

unlocked composite. 
5 In the Properties pane, click the Monitor wall destination box, and then select the 

appropriate destination from the list.
6 Repeat from step 4 until you have made the required assignments for this composite.
7 Click outside the composite monitor to lock it.

Automatically Populating a Grid-Type Layout
Use the Auto-layout tool to quickly create a layout containing a grid of up to 256 identical 
composites. To use the Auto-layout tool, you first add a monitor to the layout. This first 
monitor is resized and replicated until the grid area is populated with the specified number 

Filter text

Example: Type “f” to 
view only the sources 
that belong to Input F.
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of monitors, spread over the area delimited by the upper left corner of the current monitor 
and the bottom right corner of the current head.

By assigning a channel or a Monitor Wall Destination to the first monitor, the channel 
number or monitor wall destination number will automatically increment as each monitor 
is added to the layout. If the current number of channels (as set in the Channels/Sources 
tab, see Creating and Configuring Logical Sources, on page 72) is insufficient for the 
number of monitors to be created by auto-layout, the remaining monitors will use the last 
available channel in the list.

To automatically populate a grid-type layout
1 Add a first monitor to the layout (see Adding Monitors to a Layout, on page 183, and 

Working with Composite Monitors, on page 249). Assign a channel number or a 
Monitor Wall Destination to the first monitor. See Assigning Logical Sources or Monitor 
Wall Destinations to Monitors, on page 185. 

2 Position the monitor so that its upper left corner marks the location where you want to 
start populating the grid.

3 Click the monitor, and then click the Auto-layout button  on the toolbar.
4 In the Auto-Layout window, type the total number of monitors you want to add to the 

layout, and then click OK.

Selecting a Background Image for a Layout
For some purposes, you may want to display a layout’s elements layered over a specific 
static image.

To select a background image for a layout
1 Click the Layouts tab, and open the layout whose background you want to set.
2 Click the display background on the layout.
3 In the Properties pane, click the Background image box, under Appearance, and then 

click the button that appeared at the end of the box.
The Select Image window appears.

Note: To undo this action, you will need to press Ctrl+Z twice: once to 
remove the copies, and then once more to restore the first monitor’s initial 
size.
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4 If the image you want to use is not already listed in Select Image, then click the Open 
button  to open the Browse Image window. Locate the image, select it, and 
then click Open.

The image is imported into the database.

5 In Select image, select the image from the Image selection list, and then click OK.

Notes

• The maximum size for each image is 256 KB, and the maximum overall size 
for all images is 10 MB. The image can be in PNG, GIF, or JPEG format. 
Images can be used on multiple layouts and only need to be imported to 
the database once.
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The image appears in the layout background.

Zooming and Panning a View
To adjust the portion of a layout or room that is shown in the main window

• Press and hold the Ctrl key, then press the plus key (+) to zoom in or the minus key (–) 
to zoom out.

• Press and hold the Ctrl key, then rotate the mouse wheel to zoom in or out.
• Type the zoom factor you want to apply (in the range of 2% to 1600%) directly in the 

zoom box.
• Press and hold the spacebar, then click and drag to pan.
• Use the scroll bars at the right side and bottom of the Layouts or Rooms tab.
• In the case of a layout view, click and drag the layout navigator’s red rectangle on the 

Tools pane.

Showing and Hiding the Layout Navigator
To show or hide the layout navigator

• On the View menu, click Navigator. Alternatively, press Ctrl+Shift+N.
The layout navigator will appear on the Tools pane if it was hidden, and vice versa.
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Layout navigator



191

Kaleido Software
User’s Manual

Configuring Video Monitors
In XEdit, you can configure several properties for a video monitor in a layout.

To configure a video monitor
1 In XEdit, click the Layouts tab, and then open a layout.
2 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 

Monitor on page 254).
3 Click the video monitor you want to configure.
4 To pre-assign a logical source to be monitored by default, to configure a video monitor 

as a monitor wall destination, or to configure reporting behaviors, see:
• Assigning Logical Sources or Monitor Wall Destinations to Monitors, on page 185.
• Setting Monitored Levels for a Video Monitor, on page 191.
• Setting a Video Monitor’s Text Mode, on page 201.
• Configuring a Video Monitor’s Alarm Reporting Behavior, on page 199.
• Configuring a Video Monitor’s Source Reporting Behavior, on page 200.

5 To configure dimensions, and resizing behavior, see:
• Resizing a Video Monitor, on page 192.
• Setting a Video Monitor’s Aspect Ratio, on page 192.
•  Adding Safe Area Markers, on page 193.
• Adding a Custom Safe Area Image, on page 193.
• Video Cropping/Zooming, on page 196.
• Configuring Automatic Aspect Ratios, on page 197.

6 Click outside the composite monitor to lock it, if applicable.
7 On the File menu, click Save.

Setting Monitored Levels for a Video Monitor
When a system’s logical sources include more than one level under a given category, the 
first level is selected by default for monitoring. In the case of a video monitor, you may 
change the default assignments for video, audio, and alarm levels.

To change the default levels selected for a video monitor
1 If your system’s logical sources include more than one video level (such as to monitor 

3D stereoscopic signals), select the ones you want to monitor from the Video level 
(left/mono), and Video level (right) lists.
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2 To monitor a different alarm level, or the source’s global alarm, select the appropriate 
level from the Border alarm level list.

3 If you want the default Monitor audio action associated with this video monitor to use a 
different audio level, select a level from the Audio level list.

Resizing a Video Monitor
To resize a video monitor

• Drag any of the corner handles, inwards or outwards.
The video monitor, and the associated video window, will become smaller or larger, 
and they will both keep their aspect ratio.

• Drag any of the side handles, inwards or outwards.
The bounds of the video monitor will change, while the video window will still keep its 
aspect ratio.

• Change the aspect ratio property of the video monitor. See Setting a Video Monitor’s 
Aspect Ratio below.
The video monitor will keep its bounds, and the video window will be resized to fill as 
much of the video monitor area as possible, given the new aspect ratio. Certain 
multiviewer models have limitations as to the minimum allowed monitor size. See 
Monitor Limitations in a Layout, on page 183.

Setting a Video Monitor’s Aspect Ratio
To set a video monitor’s aspect ratio

1 Click the video monitor whose aspect ratio you want to configure.

Video monitor with an aspect ratio of 16:9
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2 In the Properties pane, click the Current aspect ratio box, and then select the 
appropriate aspect ratio from the list.

The selected aspect ratio is applied to the video window, within the video monitor.

Video window’s aspect ratio changed to 4:3, within a 16:9 video monitor

To set a custom aspect ratio for a video monitor
1 In the Properties pane, click the Custom aspect ratio box.

The box becomes editable.
2 Type the appropriate aspect ratio, and then press Enter.

The new aspect ratio is applied to the video window, within the video monitor, and it is 
added to both the Current aspect ratio, and Custom aspect ratio lists.

Adding Safe Area Markers
To add safe area markers for a video monitor in a layout

• In the Properties pane, select the appropriate options, under Safe area markers.

Adding a Custom Safe Area Image
XEdit allows you to superimpose an image, such as a brand graphics, on top of a video 
monitor in such a way that a video signal will show through the transparent areas in the 

Note: Double-click the video monitor, if it is part of a composite monitor.

Note: The custom values are appended to the Custom aspect ratio list on 
an ongoing basis. They can then be applied to other monitors in other 
layouts. Current aspect ratio only lists the current custom ratio, if any, in 
addition to the default 16:9, and 4:3 values.
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graphics. This is accomplished by adding a free-form safe area image to the video monitor. 
The image can be in PNG, GIF, or JPEG format.

To add a free-form safe area image to a video monitor
1 In the Properties pane, select the Show markers check box, under Safe area markers.

2 Click the Custom safe zone image box.
A button appears inside the box.

3 Click the button to open the Select Image window.

4 If the image you want to use is not already listed in Select Image, then click the Open 
button  to open the Browse Image window. Locate the image, select it, and 
then click Open.

Notes

• The maximum size for each image is 256 KB, and the maximum overall size 
for all images is 10 MB. Images can be used on multiple layouts and only 
need to be imported to the database once.

• To ensure that the aspect ratio of the imported image is preserved, you 
should position the graphics on a fully transparent background with the 
same aspect ratio as the video monitor on which it is to appear.

Select image
button
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The image is imported into the database.
5 In Select image, select the image from the Image selection list, and then click OK.

6 The image appears on the video monitor.

7 To adjust the transparency level of the image, click the Unsafe zone transparency box, 
then move the slider or type a transparency value directly in the box. At 0% the 
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portions of the image that correspond to the unsafe area are opaque; at 100% the 
entire image is transparent.

Video Cropping/Zooming

To set the underscan/overscan properties of a video monitor
1 In the Properties pane, scroll down to the Underscan/Overscan section.

2 In the Mode list, select Underscan (to display the entire video signal) or Overscan (to 
display a cropped video signal).

3 To specify custom crop settings, click in the white area to the right of Custom overscan, 
then click the button that appears.

Note: When a custom safe zone image is selected, the following attributes 
are not available: Marker color, Safe title offsets, Safe zone aspect ratio, 
and Unsafe zone color.

Kaleido-IP X320 / X120 Kaleido-IP VM
 
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4 In the Custom Overscan window, specify new percentage values for Left, Right, Top, 
and Bottom overscan margins, then click OK.

When the layout is loaded on the monitor wall, the updated overscan/underscan 
properties become available.

Configuring Automatic Aspect Ratios
To slave a video monitor to the input signal aspect ratio

• In the Properties pane, select the appropriate value from the Automatic Aspect Ratio 
list.

• The default value is OFF.
• If the Automatic Aspect Ratio property is set to Follow Input Format, then the 

video monitor will change its aspect ratio based on the input feed’s format.

Note: Generally avoid exceeding 15% in any direction. You can click 
Restore defaults to enter the default overscan values (left, right, top and 
bottom = 5%). Safe title area and aspect ratio markers follow the video 
signal (for example, if the safe title is within 5% of top, left, right and bottom, 
then when the video is in default overscan mode, the safe title will not 
appear).
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• If the Automatic Aspect Ratio property is set to Follow Input Format and AFD 
Coded Frame, then the video monitor will change its aspect ratio according to the 
AFD coded frame. If there is no AFD present, the default value for the current 
format will be used (see Configuring the default aspect ratio for HD and SD signals 
on page 198):

• the default HD AFD value, if the input is HD;
• the default SD AFD/WSS value if the input is not HD;
• if the default value for the current input format is None, then the video 

monitor will change its aspect ratio based on the input feed’s format.

Configuring the default aspect ratio for HD and SD signals

To have a video raster follow a video signal’s AFD/WSS metadata
1 Click to put a check mark in the box labeled Follow AFD/WSS.

2 In the Default SD AFD/WSS value list, select the aspect ratio to use when there is no 
AFD or WSS in an SD signal. Select Keep Last to have the video window maintain the 
last decoded AFD or WSS value if the signal is paused.

3 In the Default HD AFD value list, select the aspect ratio to use when there is no AFD or 
WSS in an SD signal. Select Keep Last to have the video window maintain the last 
decoded AFD value if the signal is paused.
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Configuring a Video Monitor’s Alarm Reporting Behavior
To prevent users from missing temporary alarms on the monitor wall, monitors that are 
capable of displaying an alarm status (such as video monitors, subtitling monitors, UMDs, 
alarm monitors) can be configured with a latching mechanism. An alarm latch will keep the 
error state visible until someone acknowledges the associated alarm. Video monitors can 
provide alarm status information through their borders’ color and blinking behavior, and 
show the latched state as small indicators in each corner of the video window. See also: 
Configuring a Video Monitor’s Source Reporting Behavior, on page 200.

To set the alarm reporting features for a video monitor
1 In the Properties pane, scroll down to the Alarms/Tallies section.

2 Set the appropriate border color scheme and associated thickness attributes.
3 Click the Blink mode box, and then select the appropriate blinking behavior, for your 

purposes.

4 The Kaleido multiviewer supports the following blinking modes:

Blink mode selection
Display alarm latch check box
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5 Select the Display alarm latch check box to enable the latched status indicators in each 
corner of the video window.

Configuring a Video Monitor’s Source Reporting Behavior
To help you distinguish which sources are currently active on the monitor wall, monitors 
that are capable of displaying an alarm status (such as video monitors, subtitling monitors, 
UMDs, alarm monitors) can have their borders, background or text configured to appear in 
a specific color, based on their current source. Video monitors can provide this information 
through their borders’ color. See also: Configuring a Video Monitor’s Alarm Reporting 
Behavior, on page 199.

To configure a video monitor’s border colors for source reporting
1 In the Properties pane, scroll down to the Alarms/Tallies section.

2 Set the border thickness attributes as necessary.
3 Click the border color box for an alarm state you want associated with a distinctive 

color, based on the monitor’s current source.
4 Click the button that appeared at the end of the box.

5 In Colors, select the appropriate level from the Source color level list. See Configuring 
color level assignments on page 82, for more information.

Blink mode Description

Off The status indicator will never blink.

Follow Latch The status indicator’s blinking will follow the latch status. 
The indicator will blink until someone unlatches the 
alarm.

Critical The status indicator will blink when the current status is 
critical.

Critical or Major The status indicator will blink when the current status is 
critical or major.

Critical, Major and 
Minor

The status indicator will blink when the current status is 
critical, major or minor.
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6 Set the color’s transparency as necessary.
7 Set the color to be used for sources whose color levels might not be defined, by clicking 

the tab that corresponds to the color space you want to use, and then choose a color 
(see Configuring a Video Monitor’s Alarm Reporting Behavior on page 199, for more 
information).

8 Click OK to close the color picker window.
In the Properties pane, the name of the selected source-based color level appears next 
to the fallback color (and transparency, if used).

9 Repeat from step 3 for the remaining colors you want to set.

Setting a Video Monitor’s Text Mode

Notes

• Closed captioning/subtitling text services can be enabled by purchasing 
the CC/XDS option. This requires the CC/XDS option to be enabled (see the 
multiviewer’s Installation & Service Manual for more information).
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To set the subtitling properties of a video monitor
1 In the Properties pane, scroll down to the CC/Subtitling section.

2 Select the Text enabled check box.

3 Select a value from the Text mode list.

4 Select the appropriate option from the Text colors list.

• Auto: To display text in colors, as defined in the signal.
• Black & white: To display white characters against a black background, regardless 

of what is specified in the signal.
5 To adjust the transparency level of the text background, click the Text background 

transparency box, and then move the slider, or type a transparency value directly in 
the box.

• The Kaleido-IP supports extraction of CC/subtitling and XDS data 
(1 license/program). It is not possible to enable or verify the CC/XDS option 
in XAdmin’s Status and Options page, for this multiviewer model. Contact 
Technical Support for activation and configuration instructions (Grass 
Valley Technical Support, on page 360).

Notes (continued)
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At 0% the text will appear against an opaque background; at 100% the fully 
transparent background will let the text appear directly against the video. This applies 
to CEA-608, CEA-708 captions, WST, ST 2031, and RDD 8/OP-47 text.

6 Specify a CEA-708 service value, if necessary, and then click Apply.

7 In the case of a Kaleido-IP, if you want to pre-select a specific DVB teletext subtitling 
language for this monitor, select a page from the Subtitling page list.
Make sure the selected page is configured (see Configuring Teletext/Subtitling Page 
Selection for a Kaleido-IP on page 107). For other multiviewer models, make sure 
page A remains selected.

8 If you want to pre-select a specific DVB subtitling language for this monitor, click to 
expand the DVB subtitling language list and then select the appropriate language or 
DVB stream you want to monitor.
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The list of subtitling streams and languages contains the following:
• A series of DVB streams identified by their relative number: DVB stream 1 to DVB 

stream 12. Choose from this series if you want to always monitor the third available 
subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you want to monitor subtitling in a specific language.

When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.

Then, following DVB stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.
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9 If you want to pre-select a specific SCTE 27 subtitling language for this monitor, click to 
expand the SCTE 27 subtitling language list and then select the appropriate language 
or SCTE 27 stream you want to monitor.

The list of subtitling streams and languages contains the following:
• A series of SCTE 27 streams identified by their relative number: SCTE 27 stream 1 

to SCTE 27 stream 12. Choose from this series if you want to always monitor the 
third available subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you want to monitor subtitling in a specific language.

When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.
Then, following SCTE 27 stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.

10 If you want to see CC/subtitling text in a larger, more readable font size, select the 
Large font (experimental) check box.

Notes

• The current version of the Kaleido Software supports foreground colors for 
teletext (WST, OP-47) only. Closed captions (CC, DTVCC) will appear in 
white against a black background.

• If you do not need teletext to be displayed in colors, then you may find that 
selecting Black & white will improve your system’s performance.

• In the case of the Subtitling (WST) text services, the Kaleido-IP supports 
decoding of up to eight preset pages (page A to page H) per video signal 
on the monitor wall. The other multiviewer models support decoding of a 
single preset page (for example, page A) per video signal.

• In the case of CEA-608, only CC1 subtitles can be decoded.

• The current version of the Kaleido Software supports DVB and SCTE 27 
subtitles, from Kaleido-IP sources only.
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Note: The large font option is in a beta stage, and works best with an aspect 
ratio of 16:9.
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Configuring Audio Monitors

To configure an audio monitor
1 In the Layouts tab, click the audio monitor you want to configure.
2 In the Properties pane, click the Audio scale box, under Appearance, and then select 

the appropriate audio scale from the list.

3 The Monitoring indicator check box is selected by default. When enabled, a color-
keyed rectangle is shown below the VU meter that is the same color set for the display 
from which the audio is being monitored. To set a display’s color, see Calibrating the 
Audio Monitoring Color, on page 113. See also Triggering Audio Monitoring by Using 
the mouse, the RCP-200, or the Kaleido-RCP2, on page 342. Clear the check box to 
remove this rectangle.

4 If you want your audio monitor to include a stereo phase meter: under Phase meter, 
select the Meter check box, and then configure the threshold and colors as needed.

5 Under Assignments, click the Audio format box, and then select the appropriate 
format from the list: Auto, PCM, Dolby E or Dolby VANC.

Note: To decode Dolby E audio metadata, the Dolby E option is required. 
This requires this option to be enabled (see the multiviewer’s Installation & 
Service Manual for more information). 

Note: See Configuring Audio Scales on page 212 for more information.

Monitoring indicator check box

Meter check box
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By default, audio monitors added to a layout by using the toolbar button have this 
attribute set to Auto.

6 Choose an Audio level.

7 Choose a value from the Channels list to indicate which channel to display.

• If the Audio format is set to PCM, then the available choices are (L) Left, (R) Right, 
and Stereo.

• If the Audio format is set to Auto, Dolby E or Dolby VANC, then the available 
choices are (L) Left, (R) Right, Stereo, (S) Surround, (Ls) Left surround, (Rs) Right 
surround, (LFE) Low-frequency effects, (C) Center, (Bsl) Back surround left, (Bsr) Back 
surround right, (Le) Left extra, and (Re) Right extra.

8 If your monitoring purposes may involve decoding Dolby E audio metadata, then 
select the appropriate program number (1–8) from the Dolby program list.

9 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 
Destinations to Monitors on page 185).

10 Set the other attributes, as needed (see Creating Actions on page 261 for more 
information).

Notes
• If the actual audio source assigned to this audio monitor is not of the same 

format configured here, then the audio data will not be shown.
• In the case of a Kaleido-IP, the current version of the Kaleido Software 

does not support audio monitors configured to monitor PCM audio 
signals. For every audio monitor in your layout, the Audio format property 
should be set to Auto.

Note: The number of programs included in a Dolby E metadata bitstream 
depends on the program configuration. For example, a Dolby E stream with 
the 7.1 program configuration only has one program available for selection 
in its metadata bitstream; a 5.1+2 stream has two programs; a 8x1stream has 
eight program selections possible.
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11 On the File menu, click Save.
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Configuring Loudness Monitors
To configure a loudness monitor

1 In XEdit, click the Layouts tab, and then open a layout.
2 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 

Monitor on page 254).
3 Click the loudness monitor you want to configure.

4 In the Properties pane, click the Audio scale box, under Appearance, and then select 
the appropriate audio scale from the list.

Three predefined audio scales are available for loudness monitors:
• Full scale (default)
• EBU +9
• EBU +18

5 Choose the Audio level you want to monitor.

6 Make the appropriate source and destination assignments (see Assigning Logical 
Sources or Monitor Wall Destinations to Monitors on page 185).

7 Set other attributes, as needed (see Creating Actions on page 261 for more 
information).

Note: The audio scales applicable to loudness monitors have fixed upper 
and lower limits. Only the colors can be changed (see Configuring Audio 
Scales on page 212).
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8 On the File menu, click Save.
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Configuring Audio Scales
You can configure audio scales in two ways: either globally, from the Tools menu, or by 
clicking a specific audio monitor in a layout.

Configuring Audio Scales from the Tools Menu
To configure an audio scale from the Tools menu

1 On the Tools menu, click Edit audio scales:

The Edit Audio Scale window appears.

2 Select the audio scale you want to customize (or the one on which you want to base a 
new audio scale), from the list at the bottom of the window.

3 Click one of the Top color, Middle color, or Bottom color buttons, depending on the 
part of the audio scale you want to configure.
The color picker window appears.

Note: When you modify one of the default audio scales, you can only save 
your changes as a new audio scale. On the other hand, custom audio scales 
can be tweaked and saved repeatedly until the required configuration is 
achieved.
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4 In Colors, click the tab that corresponds to the color space you want to use, and then 
choose a color.
Swatches in the selected color appear under Preview.

5 Click OK to close the color picker window.
In Edit Audio Scale, the corresponding button and the corresponding part of the audio 
monitor preview show the selected color.

6 Repeat this procedure until all three colors are set.
7 Enter the audio thresholds in Upper limit and Lower limit.
8 Type a name for the new audio scale in the box at the bottom, and then click the Save 

as button. Alternatively, if you are modifying an existing custom audio scale, you can 
click the Save button.

Configuring an Audio Scale from a Specific Audio Monitor

To configure an audio scale from a specific audio monitor
1 In the Layouts tab, click the audio monitor you want to configure.
2 In the Properties pane, click the Audio scale box, under Appearance, and then click 

the button that appeared at the end of the box.
The Edit Audio Scale window appears.
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3 Click one of the Top color, Middle color, or Bottom color buttons, depending on the 
part of the audio scale you want to configure.
The color picker window appears.

4 In Colors, click the tab that corresponds to the color space you want to use, and then 
choose a color.
Swatches in the selected color appear under Preview.

5 Click OK to close the color picker window.
In Edit Audio Scale, the corresponding button and the corresponding part of the audio 
monitor preview show the selected color.

6 Repeat this procedure until all three colors are set.
7 Enter the audio thresholds in Upper limit and Lower limit.
8 Type a name for the new audio scale in the box at the bottom, and then click the Save 

as button.

Note: When you modify one of the default audio scales, you can only save 
your changes as a new audio scale. On the other hand, custom audio scales 
can be tweaked and saved repeatedly until the required configuration is 
achieved.
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Removing Audio Scales from the System

To remove a custom audio scale from the system
1 On the Tools menu, click Edit audio scales.

The Edit Audio Scale window appears.
2 In Edit Audio Scale, select the custom scale you want to remove, from the list at the 

bottom of the window, and then click Delete.

Note: The default audio scales cannot be removed from the system.
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Configuring Time Code Monitors
To configure a time code monitor in a layout

1 To add a time code monitor to a layout, click the “Time code monitor” button  on the 
toolbar, and then click and drag to draw a time code monitor on the layout.
Alternatively, you can drag a time code monitor from a monitor library to the layout.

2 Click the time code monitor you want to configure.
The time code’s attributes appear in the Properties pane.

• To replace the default name, type a new name in the Name box.

• If you want to assign a logical source, drag the appropriate element from the 
Channels/Sources list that appears on the Tools pane, to the time code monitor.

The selected logical source’s name appears in the Source box.

Note: The first time code level applies by default. If your system’s logical 
sources include more than one time code level, select the one you want to 
apply from the Time code level list.
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• If you want to assign time code information from an external provider 
(see Configuring logical sources based on external alarm providers on page 81), 
then select the appropriate text level from the Time code text level list.

If the time code monitor is configured with both a time code level and a text level, 
it will show the most recently updated value (for example, if the multiviewer 
received time code data, followed by a text update from the GSM, then the monitor 
will display the GSM alarm text). If a text value from the GSM does not meet the 
supported formats, then the value is ignored. The supported formats are:

• HH:MM:SS (showing the hours, minutes, and seconds, as 2-digit values)
• HH:MM:SS:FF (showing the hours, minutes, seconds, and frames, as 2-digit 

values)
• HH:MM:SS;FF (showing the hours, minutes, seconds, and drop frames, as 2-

digit values)

Note: With the current implementation of this feature, you may observe a 
200-270 ms delay, depending on your multiviewer system topology, and on 
the network load.
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Configuring Timers
Building a countdown timer involves defining the timer itself (name, behavior, time 
reference, etc.), and then creating one or more timer monitors to display the timer on a 
monitor wall. Timers can be created, modified, deleted, added to a layout, assigned to 
logical sources, rooms or individual RCP users, and controlled from the Kaleido-RCP2.

Adding Timers to the System
To define a timer

1 On the Tools menu, click Edit timers.

2 In Timer Editor, click New.

3 Type a name for your new timer in the Timer name box.

4 Choose the appropriate mode, from the Timer mode list.

Note: In addition to timer monitors, Gateway commands (see Gateway on 
page 263) can be used to interact with timers. Refer to the Kaleido Remote 
Control Protocol (Gateway) User’s guide. See Related Documentation, on 
page 11.
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• Up: The timer counts up starting from zero up to the Preset time.
• Down: The timer counts down from the Preset time to zero.
• Remaining: The timer counts down from the current time until it reaches the Preset 

time. This mode is a one-shot mode—the timer will not automatically restart the 
next day at the same start time. To restart it, you must either reset the timer 
monitor on the monitor wall, or set and specify a new start time.

5 Choose what happens when the timer reaches the end of its countdown period, from 
the Timer end list.

• Loop: The timer restarts and repeats its cycle (not available with the Remaining 
timer mode).

• Stop: The timer stops.
• Overrun: The timer counts through its specified end point, and then continues 

(when Overrun is specified, the timer always counts up).
6 If you chose Loop as a timer end mode, specify the number of times the loop should 

repeat.

7 Specify a Preset duration.

8 Specify a Start time.
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9 Choose a synchronization source from the Time code reference list— either an 
embedded time code signal from a video source, an LTC input (if available), or the 
internal clock time (default).

10 Click Save to save your new timer and close the Timer Editor window.
11 Under the Channels/Sources tab, create a new logical source to associate with the 

timer, and name it.

12 Click a cell in the time code level of the new logical source, and drag the timer you want 
to assign to this logical source from the filtered System list that appears on the Tools 
pane, to the selected cell in the sources table.

IMPORTANT
Before setting a timer’s start time in XEdit, review the following:

• If the selected time code reference includes time zone 
information, then make sure that the PC that has XEdit is 
configured for the same time zone.

• If the selected time code reference does not include time zone 
information, or you chose to bind the timer to the multiviewer’s 
internal clock, then the multiviewer's system time will apply. 



221

Kaleido Software
User’s Manual

13 Click Save.

Adding a Timer Monitor to a Layout
To create a timer monitor

1 In XEdit, open a layout and click the Timer button .
2 Click and drag to draw a timer monitor on the layout.

Alternatively, you can drag a timer monitor from the Timers library to the layout.
The timer’s attributes appear in the Properties pane.

3 Replace the default name, by typing a new name in the Name box.

4 If you want to assign a logical source, drag the appropriate element from the 
Channels/Sources list that appears on the Tools pane, to the timer monitor.
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The selected logical source’s name appears in the Source box, and the Timer source 
box shows the value of the corresponding time code level.

5 Click the button beside Timer source.

The Timer Editor window appears.
6 Choose a timer (see Configuring Timers on page 218) from the Timer List.

It is also possible to assign a timer to a timer monitor by dragging an existing logical 
source (containing a timer assignment) to the monitor.

7 Click Save.
8 Modify the timer’s Appearance properties as needed.

9 To attach an action to the timer, click the button beside Mouse click.

Note: The first time code level applies by default. If your system’s logical 
sources include more than one time code level, select the one you want to 
apply from the Time code level list.

Note: Each timer monitor is assigned to exactly one timer. Multiple timer 
monitors can be assigned to the same timer. Start/stop/reset or mode 
changes applied to one monitor affect all other monitors assigned to the 
same timer.

Assigned logical source name

Time code level value from assigned
logical source



223

Kaleido Software
User’s Manual

The Action Editor window appears.
10 Drag an action from the left pane to the middle pane, then specify the action’s behavior 

in the right pane.

For more information on creating actions, see Creating Actions, on page 261.
11 Click OK to save the action assignment and close the Action Editor window.
12 Click Save to save the layout with the new timer monitor.
13 Export the database to a Kaleido-IP multiviewer, and load the layout.

The interactive timer monitor appears on the monitor wall. See Using Timers, on 
page 336, Assigning a Timer to a Room, on page 279, and Assigning a Timer to an RCP 
User, on page 284, for more information.
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Configuring UMDs 
UMDs can serve various purposes: in addition to displaying the name of the video source 
seen in a video monitor, they can report operational status and error conditions in real time, 
by showing dynamic alarm and text attributes associated with a source.

To configure a UMD
1 In XEdit, click the Layouts tab, and then open a layout.
2 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 

Monitor on page 254).
3 Click the UMD you want to configure.
4 To pre-assign a logical source to be monitored by default, to configure the selected 

UMD as a monitor wall destination, or to configure its reporting behaviors, see:
• Assigning Logical Sources or Monitor Wall Destinations to Monitors, on page 185.
• Setting Monitored Alarm and Text Levels for a UMD, on page 224.
• Configuring a UMD’s Alarm Reporting Behavior, on page 225.
• Configuring a UMD’s Source Reporting Behavior, on page 227.

5 To configure UMD text properties, see:
• Configuring Static UMD Text, on page 228.
• Configuring Dynamic UMD Text, on page 229.
• Setting the Text Font, on page 230.

6 Click outside the composite monitor to lock it, if applicable.
7 On the File menu, click Save.

Setting Monitored Alarm and Text Levels for a UMD
When a system’s logical sources include more than one level under a given category, the 
first level is selected by default for monitoring. In the case of a UMD, you may change the 
alarm levels associated with the UMD itself, and with its left and right tallies, and the text 
level from which the UMD label will be retrieved.

To change the default alarm and text levels selected for a UMD
1 To monitor a different alarm level, or the source’s global alarm, select the appropriate 

level from the UMD alarm level list.

Note: UMDs configured to show static text are editable in XEdit, and on the 
monitor wall, whereas UMDs configured to show dynamic text are not 
editable.
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2 To have the UMD report alarm text (or other dynamic text), select the level from the 
Text label level list.

See Configuring Dynamic UMD Text on page 229, for more information.
3 If you want to monitor tallies, select the levels from the Left tally source level, and 

Right tally source level lists.
See Tally Interface Devices & Timer Systems on page 287, for examples of such 
configurations.

Configuring a UMD’s Alarm Reporting Behavior
To prevent users from missing temporary alarms on the monitor wall, monitors that are 
capable of displaying an alarm status (such as video monitors, subtitling monitors, UMDs, 
alarm monitors) can be configured with a latching mechanism. An alarm latch will keep the 
error state visible until someone acknowledges the associated alarm. For UMDs, the latch 
color can be set to follow the background or the text color configuration. See also: 
Configuring a UMD’s Source Reporting Behavior, on page 227.

To set the alarm reporting features for a UMD (text and tallies)
1 In XEdit, open a layout, and click the UMD whose alarm reporting behavior you want to 

configure.

2 If you want to use the UMD’s alarm latching mechanism, make sure the UMD is 
configured with a bevel.
In the Properties pane, the UMD bevel attribute should be set to either lowered, or 
raised.

Note: Double-click the UMD, if it is part of a composite monitor.
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3 Scroll down to the Alarms/Tallies section, in the Properties pane, to set the 
appropriate text and background color scheme.

4 Click the Blink mode boxes, and then select the appropriate blinking behavior, for your 
purposes:

Blink mode Description

Off The status indicator will never blink.

Follow latch The status indicator’s blinking will follow the latch status. 
The indicator will blink until someone unlatches the alarm.

Critical The status indicator will blink when the current status is 
critical.

Critical and major The status indicator will blink when the current status is 
critical or major.

Critical, major and 
minor

The status indicator will blink when the current status is 
critical, major or minor.

Blink mode selection

Display alarm latch check box

Display alarm latch check box

Display alarm latch check box

Blink mode selection

Blink mode selection

Latch colors selection
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5 Select the Display alarm latch check box to enable the latched status indicators.

Configuring a UMD’s Source Reporting Behavior
To help you distinguish which sources are currently active on the monitor wall, monitors 
that are capable of displaying an alarm status (such as video monitors, subtitling monitors, 
UMDs, alarm monitors) can have their borders, background or text configured to appear in 
a specific color, based on their current source. UMDs can provide this information through 
their text and background colors. See also: Configuring a UMD’s Alarm Reporting Behavior, 
on page 225.

To configure a UMD’s background or text colors for source reporting
1 In XEdit, open a layout, and click the UMD whose source reporting behavior you want 

to configure.

2 In the Properties pane, scroll down to the Alarms/Tallies section.

3 Click the text or background color box for a state you want associated with a distinctive 
color, based on the monitor’s current source.

4 Click the button that appeared at the end of the box.

Note: Double-click the UMD, if it is part of a composite monitor.
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5 In Colors, select the appropriate level from the Source color level list. See Configuring 
color level assignments on page 82, for more information.

6 Set the color’s transparency as necessary.
7 Set the color to be used for sources whose color levels might not be defined, by clicking 

the tab that corresponds to the color space you want to use, and then choosing a color 
(see Configuring a UMD’s Alarm Reporting Behavior on page 225, for more 
information).

8 Click OK to close the color picker window.
In the Properties pane, the name of the selected source-based color level appears next 
to the fallback color (and transparency, if used).

9 Repeat from step 3 for the remaining colors you want to set.

Configuring Static UMD Text
A UMD can show two types of static text:

• static text that you typed directly on a layout, in XEdit (see below), or on the monitor 
wall (see Editing UMD Text on page 330);

• static text associated with the current logical source assigned to the UMD, which you 
entered in the sources table.
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In the first case, the static text is tied to a specific layout whereas, in the other case, the text 
is tied to a specific input signal.

To configure static text for a specific UMD in a layout
1 In the Layouts tab, double-click the UMD whose static text you want to set.
2 Make sure the appropriate input language and method are set in your operating 

system.
3 Type some text.

To configure static UMD text from the sources table
1 In the Channels/Sources tab, click the cell that corresponds to the appropriate text 

level of the logical source that is assigned to the UMD whose static text you want to set.
2 Type the new static text.

Configuring Dynamic UMD Text
Assuming you have created logical sources (see Creating and Configuring Logical Sources 
on page 72) and a layout in XEdit, you can further configure UMDs in your layout to report 
dynamic text labels, associated with the sources you want to monitor.

To configure dynamic UMD text
1 In the Channels/Sources tab, click a cell that corresponds to the appropriate text level 

of a logical source.
2 In the filtered System list, navigate to the text element you want to monitor, and drag it 

onto the selected cell.

3 Make corresponding assignments to other logical sources by incremental copy, if 
necessary (see Making Further Assignments by Incremental Copy on page 83).

4 On the File menu, click Save.
Changes to the sources table are saved.

5 Click the Layouts tab, and then open the layout you want to configure.
6 Unlock the appropriate composite monitor if applicable (see Unlocking a Composite 

Monitor on page 254), and then click the UMD whose dynamic text reporting behavior 
you want to set.

7 In the Properties pane, click the Text label level box, and then select the text level you 
configured in step 2.
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8 Click outside the composite to lock it, if applicable.
9 Repeat step 6 – step 8 until you have configured all UMDs that are to display dynamic 

text when this layout is loaded on the monitor wall.
10 On the File menu, click Save.

Setting the Text Font
To set the text font for a UMD in a layout

1 In the Layouts tab, click the UMD whose text font you want to set.
2 In the Properties pane, click the Text font box, under Appearance, then click the 

button that appeared at the end of the box.
The Select a Font window appears.

3 Select the appropriate values from the Font, Font Style and Size lists.
4 Click OK.
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Configuring Alarm Monitors
To add an alarm monitor to a layout

1 Click the Alarm monitor button  on the toolbar, click the layout, and then move or 
resize the monitor as needed.
You may choose to layer this monitor on top of the video window within a composite. 
See Working with Composite Monitors on page 249, for instructions on how to add 
elements to a composite.

2 In the Properties pane, set the transparency attribute to the appropriate value for your 
purposes, by clicking the Transparency box, and then using the slider or typing a value 
directly into the box.

Set the other appearance attributes as necessary.
3 In the Alarms/Tallies section, set the appropriate color and video transparency scheme 

for the text and background, to achieve the required alarm reporting and source 
reporting behaviors (see Configuring an Alarm Monitor’s Source Reporting Behavior, 
on page 232, for details).

Note: On the monitor wall, an alarm monitor positioned over a video 
window has the following default behavior:
• If the source assigned to the alarm monitor is an active alarm (red), the 

alarm monitor is visible. The video transparency settings configured in 
XEdit for this alarm monitor apply to the part of the monitor that overlaps 
the video window.

• If the source assigned to the alarm monitor is an inactive alarm (green), 
the alarm monitor is not visible on the monitor wall. If the alarm monitor 
partially overlaps the video window, then the part of the monitor that 
does not cover the video window remains visible (green).

Alarm monitor
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4 Click the Blink mode box, and then select the appropriate blinking behavior, for your 
purposes:

5 To enable the latched status indicators, select the Display alarm latch check box, click 
the Latch colors box, and then select the appropriate color scheme for your purposes: 
either Same as text colors, or Same as background colors.

6 Choose from two display modes: Cycle and Marquee.
In cycle mode, the alarm monitor displays text from each alarm, one after the other. In 
marquee mode, the alarm text scrolls across the monitor. In addition, you can control 
the cycling speed and the scroll rate by setting the cycling period, in milliseconds.

7 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 
Destinations to Monitors on page 185), and select the required alarm and text label 
levels, if necessary.

8 On the File menu, click Save.

Configuring an Alarm Monitor’s Source Reporting Behavior
To help you distinguish which sources are currently active on the monitor wall, monitors 
that are capable of displaying an alarm status (such as video monitors, subtitling monitors, 
UMDs, alarm monitors) can have their borders, background or text configured to appear in 

Blink mode Description

Off The status indicator will never blink.

Follow latch The status indicator’s blinking will follow the latch status. 
The indicator will blink until someone unlatches the alarm.

Critical The status indicator will blink when the current status is 
critical.

Critical and major The status indicator will blink when the current status is 
critical or major.

Critical, major and 
minor

The status indicator will blink when the current status is 
critical, major or minor.

Display alarm latch check box

Blink mode selection
Latch colors selection

100% video transparency to keep the status
indicator hidden when there is no alarm.
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a specific color, based on their current source. Alarm monitors can provide this information 
through their text and background colors.

To configure an alarm monitor’s background or text colors for source reporting
1 In XEdit, open a layout, and click the alarm monitor whose source reporting behavior 

you want to configure.

2 In the Properties pane, scroll down to the Alarms/Tallies section.

3 Click the text or background color box for a state you want associated with a distinctive 
color, based on the monitor’s current source.

4 Click the button that appeared at the end of the box.

5 In Colors, select the appropriate level from the Source color level list. See Configuring 
color level assignments on page 82, for more information.

Note: Double-click the alarm monitor, if it is part of a composite monitor.
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6 Set the color’s transparency as required.
7 Set the color to be used for sources whose color levels might not be defined, by clicking 

the tab that corresponds to the color space you want to use, and then choosing a color.
8 Click OK to close the color picker window.

In the Properties pane, the name of the selected source-based color level appears next 
to the fallback color (and transparency, if used).

9 Repeat from step 3 for the remaining colors you want to set.
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Configuring Subtitling Monitors
To monitor subtitling from a DVB or SCTE 27 stream

1 To add a subtitling monitor, click the Subtitling monitor button  on the toolbar, click 
the layout, and then move or resize the monitor as needed.

2 Click the subtitling monitor you want to configure.

The subtitling monitor’s attributes appear in the Properties pane.

The first alarm level is selected by default for alarm reporting.
3 If you want to monitor a different alarm level, or the source’s global alarm, select the 

appropriate level from the Border alarm level list.

The first video level applies by default.
4 If your system’s logical sources include more than one video level, select the one you 

want to monitor from the Video level list.
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5 If you want to replace the default name, type a new name in the Name box.

6 If you want to assign a logical source, drag the appropriate element from the 
Channels/Sources list that appears on the Tools pane, to the subtitling monitor.

The selected logical source’s name appears in the Source box.

7 If you want to pre-select a specific text mode for this monitor, select a value from the 
Text mode list (see Teletext, Subtitles, and Closed Captions on page 122).

8 If you want to pre-select a specific DVB subtitling language for this monitor, click to 
expand the DVB subtitling language list, and then select the appropriate language or 
DVB stream you want to monitor.

The list of subtitling streams and languages contains the following:
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• A series of DVB streams identified by their relative number: DVB stream 1 to DVB 
stream 12. Choose from this series if you want to always monitor the third available 
subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you want to monitor subtitling in a specific language.

When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.

Then, following DVB stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.

9 If you want to pre-select a specific SCTE 27 subtitling language for this monitor, click to 
expand the SCTE 27 subtitling language list, and then select the appropriate language 
or SCTE 27 stream you want to monitor.

The list of subtitling streams and languages contains the following:
• A series of SCTE 27 streams identified by their relative number: SCTE 27 stream 1 

to SCTE 27 stream 12. Choose from this series if you want to always monitor the 
third available subtitling stream, for example.

• A list of all supported languages, in alphabetical order based on the English name, 
which is followed with the corresponding ISO 639-2 alpha-3 code. Choose from this 
series if you want to monitor subtitling in a specific language.
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When XEdit is connected to the multiviewer, the available languages are indicated in 
bold text. The ISO 639-2 alpha-3 code for each available language, and the 
corresponding PID appear in the list of relative subtitling streams.
Then, following SCTE 27 stream 12, for each of the currently available languages, the 
name, the 3-letter code, and the corresponding PID appear in bold text before the list 
of all supported languages.

10 Modify the subtitling monitor’s Appearance properties as needed.

11 If you want to use the subtitling monitor’s background color for source reporting:
a Click the Background color box, and then click the button that appeared at the 

end of the box.

b In Colors, select the appropriate level from the Source color level list. 
See Configuring color level assignments on page 82, for more information.

c Set the color’s transparency as required.
d Set the color to be used for sources whose color levels might not be defined, by 

clicking the tab that corresponds to the color space you want to use, and then 
choosing a color.

e Click OK to close the color picker window.
f In the Properties pane, the name of the selected source-based color level appears 

next to the fallback color (and transparency, if used).
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12 Change the Default aspect ratio as needed.

This value is used in the absence of aspect ratio information in the DVB or SCTE 27 
subtitling stream, when the associated video stream is not decoded. When the video is 
decoded, the video signal’s aspect ratio is used, in the absence of aspect ratio 
information in the subtitling stream. See Setting a Video Monitor’s Aspect Ratio on 
page 192 for more information, including on selecting a custom aspect ratio.

13 See Configuring a Video Monitor’s Alarm Reporting Behavior, on page 199, and to 
Configuring a Video Monitor’s Source Reporting Behavior, on page 200, to configure 
the subtitling monitor’s other alarm reporting, and source reporting features.

14 See Creating Monitor Wall Actions, on page 264 to configure mouse-click actions for 
this subtitling monitor.

15 On the File menu, click Save.
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Configuring Metadata Monitors
To monitor XDS data, or digital content advisory descriptor (CAD) information

1 Click the Metadata monitor button  on the toolbar, click the layout, and then move 
or resize the monitor as needed.

Alternatively, you may choose to layer this monitor on top of the video window within 
a composite. See Working with Composite Monitors on page 249, for instructions on 
how to add elements to a composite.

2 In the Properties pane, select the check boxes that correspond to the data elements 
you want the monitor to display.

• XDS data: APS, ASB, CGMS-A; channel number; elapsed time; network name; 
program description, ID, name, length, and type; station ID; TSID; time/date; time 
zone; V-chip rating

• CAD information: US rating, Canadian rating

3 You can also set appearance properties, including the font and size of the text labels, or 
choose not to display the labels by clearing the Display legend check box.
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The selected monitor is updated accordingly in the layout.
4 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 

Destinations to Monitors on page 185), and select a video level, if necessary.

5 Click the Save button on the toolbar.
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Configuring V-Chip Monitors
A V-chip monitor provides a visual indication of the V-chip rating from the CC (608) 
metadata in an SD video signal, or from the CC (608) legacy caption data when such data is 
present within an HD video signal.

To add a V-chip monitor to a layout
1 Click the V-chip monitor button  on the toolbar, click the layout, and then move or 

resize the monitor as needed.
You may choose to layer this monitor on top of the video window within a composite. 
See Working with Composite Monitors on page 249, for instructions on how to add 
elements to a composite.

2 In the Properties pane, set the transparency attribute to the appropriate value for your 
purposes, by clicking the V-chip transparency box, and then using the slider or typing a 
value directly into the box.

3 If you want to preview the logo associated with a specific V-chip rating, select it from 
the V-chip rating preview list. For example:

4 Make the appropriate assignments (see Assigning Logical Sources or Monitor Wall 
Destinations to Monitors on page 185), and select a video level if necessary.

Note: Extraction of CC (608) captions and CC (608) legacy captions is 
available with the Extraction of CC, Subtitling and XDS metadata option 
(CC/XDS). This requires this option to be enabled (see the multiviewer’s 
Installation & Service Manual for more information). 

Note: As its name implies, the V-chip rating preview is only a preview, and 
its value is not saved with the layout.
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5 On the File menu, click Save.

Notes

• Unlike alarms, the V-chip rating associated with a video signal that is 
currently monitored on the monitor wall is not relayed to the XEdit user 
interface, when working in online mode.

• The V-chip monitor uses the holding time configured with the XDS 
filtering calibrations for the associated video source (see Calibrating 
Metadata Holding Time on page 107). Once the specified holding time has 
expired, the V-chip monitor displays the N/A logo ( ).

• When V-chip data cannot be extracted from the current video signal, the 
V-chip monitor displays the N/A logo ( ).
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Configuring Clocks
In addition to the default combo-type clock that can be added to a layout by using the 
Clock button  on the toolbar, the predefined monitor library includes a selection of 
analog and digital clocks.

To configure a clock
1 In the Layouts tab, click the clock you want to configure.

2 In the Properties pane, make the appropriate assignments:
• Determine the time source (see Assigning Logical Sources or Monitor Wall 

Destinations to Monitors on page 185), and select a time code level if necessary.

• Select the appropriate time zone for your purposes.
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If you select Autodetect, then the clock will use the time zone from the assigned 
source, if possible. 

3 If the clock is bound to an LTC or DVITC time code, and you want it to momentarily use 
the multiviewer’s internal clock for reference should the assigned time code become 
unavailable, then select Fall back to internal pulse.

When a clock configured with this option loses its time reference, it will not stop but 
keep working to the beat of the multiviewer internal clock instead.

4 Modify the clock’s Appearance properties as needed:
• From the Clock type list, select between a digital, an analog or a combo-type clock.

Notes

• When a clock switches between the LTC or DVITC signal, and the 
multiviewer’s internal clock reference, you may notice a one-second offset 
on the monitor wall.

• Refreshing the current layout (or switching to another layout and then 
back) cancels the fallback mechanism. When this happens, the clock that 
had lost its time reference halts, showing the time it was at the moment 
the layout was refreshed (or loaded again), based on the multiviewer 
system clock.
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• Resize the clock as needed, set color attributes, and select the appropriate date and 
time formats.

• In the case of a digital or combo-type clock, select the Display leading zero check 
box, if you want to see the time with a leading zero when it is before 10:00 a.m. or 
10:00 p.m.

• In the case of an analog or combo-type clock, you can also add a clock logo 
(see Inserting a Clock Logo on page 247).

• In the case of an analog or combo clock, if the clock is to be displayed against a 
pink background such as RGB (255, 0, 255) or similar, then make sure to clear the 
Border antialiasing check box.

In such cases, if border antialiasing remains enabled, the clock will have a pink 
outline on the monitor wall.

5 Define actions associated to this layout element (see Creating Monitor Wall Actions on 
page 264).

6 On the File menu, click Save.
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Inserting a Clock Logo

To insert a clock logo
1 In the Properties pane, click the Logo box, under Appearance.
2 Click the button that appeared at the end of the box.

The Select Image window appears.
3 If the logo you want to use is not already listed in Select Image, then click the Open  

button to open the Browse Image window. Locate the image, select it, and then click 
Open.

The image is imported into the database.
4 In Select image, select the logo you want to use from the Image selection list, and 

then click OK.

Notes

• The maximum size for each image is 256 KB, and the maximum overall size 
for all images is 10 MB. The image can be in PNG, GIF, or JPEG format. 
Images can be used on multiple layouts and only need to be imported to 
the database once.
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The logo appears on the clock background.
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Working with Composite Monitors

Creating a Composite Monitor
Composite monitors encapsulate a number of primary elements (such as a video monitor, 
one or two audio monitors, a UMD, and a time code) that can then be managed as a single 
object. The following example outlines the basic rules to follow, in order to create 
composite monitors that can be resized elegantly.

To create a composite monitor
1 Open an existing layout or create a new one.
2 Click the Composite button  on the toolbar, and then click the layout. Resize the 

empty composite box approximately, to a size that will be appropriate for the display 
where it is to appear.

Empty composite

3 Right-click the empty box, and then click Unlock on the menu.
Notice that the handles around the box boundary line become orange.

Unlocked empty composite

4 Add a monitor to the composite, either using a button on the toolbar or dragging an 
element from a monitor library. For example, click the Video monitor button  on the 
toolbar, and then click inside the composite to add a video monitor.

Note: If you double-click a composite monitor, the handles also become 
orange. However, in such a case, you cannot move or resize individual 
components within the composite (see Unlocking a Composite Monitor on 
page 254).
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Video monitor within unlocked composite

5 Click the Audio monitor button  on the toolbar, and then click inside the composite 
to add an audio level meter.

Audio level meter within unlocked composite

6 Click the UMD button on the toolbar, and then click inside the composite to add a 
UMD.

UMD within unlocked composite

7 Move the audio level meter to the very edge of the composite, using the mouse and 
then finishing with the arrow keys, and resize it as appropriate.

Note: Only primary monitors (not composite) can be part of a composite.
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Audio level meter resized and moved to the side

8 Move the UMD to the very bottom of the composite, using the mouse and then finishing 
with the arrow keys, and resize it if needed.

UMD resized and moved to the bottom, with its upper right handle matching the audio level 
meter’s lower left handle

9 Move the video monitor to the top-left corner of the composite, then click its bottom-
right corner handle, and drag it to stretch the video until one of its dimensions 
completely fills the empty area (vertically or horizontally).

Notes

• Making sure that UMDs and audio monitors do not overlap one another in 
a composite monitor will ensure optimal performance of any layout where 
several copies of this composite might appear. As a rule, avoid overlapping 
graphical elements in a layout.

• To align a monitor more precisely against another, select one of them, and 
then click the second one while holding the Shift key. It is then possible to 
drag any of the sizing handles (the larger gray dots) to resize any of the 
selected monitors, while their relative position remains visible. Whenever 
appropriate, matching adjacent monitors’ corner or center handles 
together will help achieve a composite that can be resized elegantly.
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Video monitor stretched to fill the remaining horizontal area

10 Drag the video monitor’s bottom-center handle until it meets the UMD’s bounds.

Video monitor stretched vertically with its bounds matching the UMD’s

11 Adjust the size and position of the components some more if needed, making sure to 
keep the peripheral monitors at the very edges of the composite’s boundary box, while 
minimizing empty space within the composite.

12 Click outside the composite to lock it.

Locked composite

13 Drag the composite’s top or bottom center handle inwards, until there is no more 
empty space above and below the video monitor.

Note: Resizing the video monitor is easier with the UMD’s bounds visible: 
first click the video monitor, and then click the UMD while holding the Shift 
key.
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Composite resized to remove remaining empty space around video monitor

14 To be able to reuse the new composite in other layouts, drag it onto the appropriate 
monitor library while holding the Ctrl key. See Creating Monitor Libraries on page 259 
for more information.

15 On the File menu, click Save.

Resizing a Composite Monitor
To resize a composite

• Click the composite monitor, and drag any of its corner handles outwards or inwards.
The composite expands or shrinks while its individual elements maintain their relative 
position and aspect ratio. Certain multiviewer models have limitations as to the 
minimum allowed monitor size. See Monitor Limitations in a Layout, on page 183.

Larger and smaller copies of the original composite

Composite monitors configured for maximum video area
In the case of composite monitors from the legacy maximum video area monitor libraries, or 
that were created with a version of XEdit earlier than 7.40, individual monitors within a 
composite are resized according to the following rules:
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• Video monitors are scaled proportionally, in both width and height.
• Vertical audio monitors are scaled vertically, but their width does not change.
• Horizontal audio monitors, time codes, timers, and UMDs are scaled horizontally, but 

their height does not change.
• Clocks are not resized.

The following table summarizes these rules:

Unlocking a Composite Monitor
Since a composite monitor functions as a single entity, its individual components are 
locked together. If you want to configure individual components within a composite 
monitor, you need to first unlock the monitor. There are two ways in which a composite 
monitor can be unlocked, one of which prevents you from moving or resizing individual 
components. An unlocked composite monitor has orange handles around its boundary 
line.

If you want to configure properties for individual components within a composite 
monitor

• Double-click the composite monitor whose primary elements you want to configure.
Notice that the handles around the boundary line become orange. When using this 
method, you cannot move or resize the monitor’s individual components.

If you want to add, move, or resize individual components within a composite monitor
• Right-click the composite monitor you want to modify, and then click Unlock on the 

menu. Alternatively, click the monitor, and then press F2.
Notice that the handles around the boundary line become orange.

Monitor type Height Width

Video Scalable Scalable

Vertical audio monitor Scalable Fixed

Horizontal audio 
monitor, UMD, time 
code, timer

Fixed Scalable

Clock Fixed Fixed

Orange handles
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Using the Region Editor

Opening the Region Editor

To open the region editor
1 Click the monitor whose properties you want to see.
2 In the Properties pane, click the Bounds box, under Size & Position.

Click the button that appeared inside the box to open the Region Editor window.

Configuring a Monitor’s Position Using the Region Editor
To set a monitor’s position on the layout

1 For each position, first select the appropriate unit.

Note: The region editor is part of the expert view. To show the expert view, 
click the View filters button on the Properties pane’s toolbar, and then 
select the Expert view check box. Using the region editor is not 
recommended. To accomplish most configurations, the standard tools 
available in the layout editor are sufficient.
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2 Type values in the Left, Top, Right, and Bottom boxes, relative to the upper-left corner 
of the display.

3 Click OK to close the editor.
4 On the File menu, click Save.

Configuring a Monitor’s Dimensions Using the Region Editor
To configure a monitor’s dimensions

1 For each dimension, first select the appropriate unit.

2 Type values in the Width and Height boxes.
3 Click OK to close the editor.
4 On the File menu, click Save.
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Format Painting

Copying Properties from one Monitor to Another
Every monitor in a layout has properties related to its appearance that you can configure in 
the Properties pane. The Copy properties tool  copies most of these properties from one 
monitor to another of the same type (such as audio monitor to audio monitor, clock to clock, 
etc.). Assignments, and actions are not copied. Size is not copied by default (see TIP, below). 
To copy actions, use the Copy actions tool (see Copying Actions from one Monitor to 
Another on page 258). To copy size only, use the Copy size tool (see Copying Size from one 
Monitor to Another on page 257).

To use the Copy properties tool
1 In the Layouts tab, click the monitor whose properties you want to copy to another 

monitor of the same type.
The monitor’s boundary box appears.
The Copy properties button  becomes available on the toolbar.

2 Click the Copy Properties button to switch to format-painting mode.
3 Point to another monitor of the same type in the layout.

The pointer changes to a hand with the index finger pointing , indicating that the 
properties of the first monitor (whose boundary box is still shown) can be copied onto 
the monitor beneath the pointer.

4 Click the monitor beneath the pointer to copy the properties onto that monitor.
The monitor’s appearance changes to reflect the new properties.

5 Repeat this for every monitor whose properties you want to change.
6 Click the Select button  on the toolbar to exit format-painting mode when you have 

finished.

Copying Size from one Monitor to Another
The size of every monitor in a layout can be adjusted by the user, by dragging handles on 
the boundary box that appears when the monitor is selected. The Copy size tool  copies 
the size from one monitor to another monitor of the same type. The Copy size tool does not 
copy any other properties from one monitor to another.

To use the Copy size tool
1 In the Layouts tab, click the monitor whose size you want to copy to another monitor 

of the same type.
The monitor’s boundary box appears.
The Copy size button  becomes available on the toolbar.

2 Click the Copy size button to switch to size-painting mode.

TIP
To have the width and height copied as well, press and hold the Ctrl key 
while clicking the monitor.
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3 Point to another monitor of the same type in the layout.
The pointer changes to a hand with the index finger pointing , indicating that the 
size of the first monitor (whose boundary box is still shown) can be copied onto the 
monitor beneath the pointer.

4 Click the monitor beneath the pointer to copy the size onto that monitor.
The monitor’s size changes to match that of the first monitor.

5 Repeat this for every monitor whose size you want to change.
6 Click the Select button  on the toolbar to exit size-painting mode when you have 

finished.

Copying Actions from one Monitor to Another
The Copy actions tool  copies the single-click and double-click actions from one monitor 
to another monitor of the same type. The Copy actions tool does not copy any other 
properties from one monitor to another.

To use the Copy actions tool
1 In the Layouts tab, click the monitor whose actions you want to copy to another 

monitor of the same type.
The monitor’s boundary box appears.
The Copy actions button  becomes available on the toolbar.

2 Click the Copy actions button to switch to action-painting mode.
3 Point to another monitor of the same type in the layout.

The pointer changes to a hand with the index finger pointing , indicating that the 
actions of the first monitor (whose boundary box is still shown) can be copied onto the 
monitor beneath the pointer.

4 Click the monitor beneath the pointer to copy the actions onto that monitor. 
The monitor’s actions change to match that of the first monitor.

5 Repeat this for every monitor whose actions you want to change.
6 Click the Select button  on the toolbar to exit action-painting mode when you have 

finished.
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Managing Monitor Libraries

Creating Monitor Libraries
To create a monitor library

1 Click the Layouts tab.
2 On the Tools pane, click My monitors.
3 Right-click inside the custom monitor libraries area, and then click New monitor library 

on the menu. Alternatively, click New monitor library on the File menu.

The new monitor library appears in the custom monitor libraries area on the Tools 
pane.

4 On the File menu, click New. Alternatively, click Open to open an existing layout. 
5 Click the appropriate toolbar button, then click the layout to add a monitor of the 

selected type. Alternatively drag a monitor from one of the existing libraries onto the 
layout, or choose an existing monitor within the layout.

6 Customize the monitor if necessary, and then drag it onto the new monitor library 
while holding the Ctrl key.

7 Right-click anywhere inside the monitor library, and then click Save monitor library on 
the menu.
The Save Monitor Library window appears.

8 Type a name for the new custom monitor library, and then click Save.

Closing a Monitor Library
To close a monitor library

• Once the custom library is saved, you can right-click in the library area, and then click 
Close monitor library on the menu. Alternatively, on the File menu, click Close 
monitor library.

Opening a Monitor Library
To open a custom library

• Right-click inside the custom monitor libraries area, on the Tools pane, and then click 
Open monitor library on the menu.

• On the File menu, click Open monitor library.
• On the File menu, point to Open recent, and then select from the list of recently used 

monitor libraries.

Note: It is not possible to customize a monitor once it is inside a library.
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Note: It is possible to have multiple custom libraries open at the same time.
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Introduction
This chapter describes how to configure and trigger monitor wall actions, and background 
actions.

Overview
An action is an operation automatically performed in response to a specific trigger. A 
monitor wall action is associated with a monitor belonging to a specific layout, or directly 
with a specific layout. It can only be activated when that layout is loaded on the monitor 
wall, whereas a background action can be triggered at any time by any alarm on the 
multiviewer. Unlike monitor wall actions, background actions are always available within a 
multiviewer system, regardless of what layouts are currently loaded.

Key Concepts

Note: Version 5.30 of the Kaleido Software fixed a bug fix that required 
changes to the JavaScript code associated with all predefined actions 
elements in XEdit. For the fix to be applied to actions created with an earlier 
version of XEdit, open them with version 5.30 or later, and view the 
underlying JavaScript code by selecting every action element in turn, and 
then clicking the View source button in the Properties pane. XEdit will 
automatically update the JavaScript code. Verify that the first lines in the 
code start with var param_<xxx> = <value>, before saving the action.

Term Description

Layout A group of monitors (or composite monitors) arranged for display on a 
monitor wall.

Composite monitor A group of primary monitors.

Monitor A graphical component used in the creation of a layout. Typical monitors 
include UMDs, time code monitors, audio monitors, video monitors, and 
clocks.

System list Refers to the hierarchical list visible under XEdit’s System tab, which 
gives a virtual representation of the system hardware (such as 
multiviewers and peripheral devices).
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Action item Action elements are associated with a specific action. When defining an 
action for a monitor, you could specify, for instance, that a specific full 
screen layout be displayed on the monitor wall in response to the 
trigger. Multiple action items can be combined as a single action. The 
following action items are available:
• Toggle destination overlay
• Unlatch / Acknowledge all
• Reset a timer
• Pause a timer
• Start a timer
• Load layout
• Monitor audio
• Switch router crosspoint
• Set GPI output
• Show full screen layout
• Hide full screen layout
• Assign source
• Custom (JavaScript)

Trigger Refers to the event that causes an action to be invoked.
For a monitor wall action, a trigger could be a single click or a double 
click on a monitor, the loading of a layout to the monitor wall, or the 
unloading of a layout.
Background actions are triggered by alarms, or by Gateway commands:
• On Disabled: background action is triggered when an alarm is disabled
• On Normal/OK: background action is triggered when an alarm reverts 

to normal
• On Minor/Warning: supported for Gateway alarms only
• On Major: supported for Gateway alarms only
• On Critical/Error: background action is triggered by a critical alarm
• On Change / Gateway: background action is triggered by any change 

in alarms status, or by the setKFireAction Gateway command

Triggering of 
background actions

Any multiviewer alarm can be used as a trigger to invoke a background 
action.
The end event of any countdown timer can be used as a trigger to invoke 
a background action.
Any GPI input from the multiviewer can trigger a background action.
Gateway commands sent by an external device can be used to trigger 
actions created in XEdit.
The system verifies alarm states after a multiviewer has restarted, and 
every time you create or modify a background action. Consequently, if—
for example—an alarm’s Normal state was selected as the trigger for a 
background action, and this alarm’s state is Normal, when the action is 
created, or when the multiviewer has restarted, the action will be 
executed.
Note: A background action triggered by an alarm is always executed, 
regardless of the alarm’s operational mode (see Alarm Suppression on 
page 118).

Term Description
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Triggering of GPI 
outputs

Any multiviewer alarm can be used to trigger a GPI output change.

Gateway Kaleido multiviewers can execute commands received through the 
Kaleido Remote Control Protocol (Gateway) interface, allowing third-party 
developers and individual users remote access to some Kaleido 
functions. Refer to the Kaleido Remote Control Protocol (Gateway) User’s 
Guide, for more information. See Related Documentation, on page 11.

Term Description
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Creating Monitor Wall Actions
Monitor wall actions can be assigned to a specific monitor on a layout, or to the layout itself. 
Actions associated with a monitor on a layout can only be triggered when the layout is 
loaded on the monitor wall. Actions associated with a layout, are triggered either upon 
loading the layout to the monitor wall, or when the layout is being replaced with another 
one.

Assigning a monitor wall action to a monitor
To assign a monitor wall action to a monitor

1 Open the layout that contains the monitor to which you want to assign an action, or 
create a new layout.

2 In the Layouts tab, unlock the appropriate composite monitor if applicable 
(see Unlocking a Composite Monitor on page 254), and then click the monitor you 
want to configure.

3 In the Properties pane, click the Mouse click box, under Actions/Scripts.

4 Click the button that appeared at the end of the box you clicked.
The Action Editor window appears.

5 In Action Editor, drag the appropriate action item from the Action List pane to the 
middle pane under either the Single Click or Double Click tab.

6 Select the action in the middle pane.
7 In the right pane, specify the attributes of the action.

Note: For a UMD, three action types can be set, and there is a box for each 
under Actions/Scripts: Left tally - Mouse click, Right tally - Mouse click, and 
UMD click.



265

Kaleido Software
User’s Manual

8 Repeat this procedure if you want to add action items. If multiple actions are specified, 
the trigger (such as, a single click on UMD) will cause all of these actions to be executed 
in order.

9 When finished, click OK to close the window, and then click the Save toolbar button.
The next time the layout is loaded on the monitor wall, the actions will be available.

Assigning a monitor wall action to a layout
To assign a monitor wall action to a layout

1 Open the layout to which you want to assign an action, or create a new layout.
2 In the Layouts tab, click the layout background.
3 In the Properties pane, click the box that matches the type of action you want to set:

• On layout exiting — to define an action to be executed when the layout is 
unloaded (for example, when it is about to be replaced with another one, on the 
monitor wall), or

• On layout loading — to define an action to be executed when the layout is loaded 
to the monitor wall.

4 Click the button that appeared at the end of the box you clicked.

The Action Editor window appears.
5 In Action Editor, drag the appropriate action item from the Action List pane to the 

middle pane (named either On Unload or On Load depending on the type of action 
you have selected at step 3).

Note: When you click a monitor on the monitor wall, all the actions 
associated with the single-click event are triggered. When you double-click 
a monitor, all the actions associated with the single-click AND the double-
click events are triggered.
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6 Select the action in the middle pane.
7 In the right pane, specify the attributes of the action.

8 Repeat this procedure, if you want to add action items.
If multiple actions are specified, the trigger (for example., the loading or unloading of 
the layout) will cause all of these actions to be executed in order.

9 When finished, click OK to close the window, and then click the Save toolbar button.
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Creating Background Actions

Creating a Background Action from the Actions Tab
To create a background action

1 Open XEdit and load the database associated with the multiviewer for which you want 
to create a background action. Alternatively, click Connect on the Configure menu, to 
work online (see Using XEdit in Online Mode on page 28).

2 Click the Actions tab.

3 Click the New toolbar button.

4 On the Tools pane, click and drag an alarm from the filtered System list onto the new 
action. This defines the alarm as the trigger for the action.

New
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5 From the Action list area of the Tools pane, drag one of the available action items onto 
one of the six columns at the bottom of the Actions tab.

6 Configure the action’s properties in the Properties pane.

Note: You do not have to perform this step for actions triggered by 
Gateway commands, because the Gateway alarm itself acts as the trigger. 
See Creating an Action that can be Triggered through a Gateway Command, 
on page 270.
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7 Repeat step 5 and step 6 as necessary.

8 Click the Save toolbar button.

Creating a Background Action from the System List
To create a background action from the System list

1 In the Description/Calibration tab (or in any other tab that shows a filtered System list 
with alarms), right-click the alarm you want to associate with an action.

2 On the Set action menu, select the appropriate trigger condition:
• On Change
• On Disabled
• On Normal/OK
• On Critical/Error

The Action Editor window appears.

Note: If you assign multiple action items to a trigger, you can change the 
order of execution by dragging items to higher or lower positions in the list. 
When the background action is triggered, its associated action items are 
executed in order from top to bottom.

Note: The trigger conditions on Minor/Warning and on Major are 
supported for Gateway alarms only.
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3 From the Action list pane, drag one of the available action items to the middle column, 
and then set the action item’s properties in the Properties pane.

4 Repeat step 3 as needed.
5 Click OK to close the window, and then click the Save toolbar button, to save the action.

Creating an Action that can be Triggered through a Gateway Command
To create an action that can be triggered through the Gateway

1 Perform step 1 to step 3 from Creating Background Actions, on page 267.
2 From the Action list area of the Tools pane, drag one of the available action items onto 

the On Change / Gateway column at the bottom of the Actions pane.

3 Under Properties > General, type a Friendly name for the Action.
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Editing an Action
To edit an action

1 Select an action under the Actions tab, or in the middle pane of the Action Editor 
window.

2 Under the Properties pane, modify the action item’s parameters
3 Click Save on the toolbar if you modified the action under the Actions tab, or click OK if 

you modified the action in the Action Editor window.

Removing Action Items from an Action
To remove an action item from an action

1 Select an action under the Actions tab, or in the middle pane of the Action Editor 
window.

2 Select one or more action items associated with the action.
3 Press the Delete key.
4 Click Save on the toolbar if you modified the action under the Actions tab, or click OK if 

you modified the action in the Action Editor window.

Note: The Friendly name is used with the setKFireAction command to 
trigger the action. Refer to the Kaleido Remote Control Protocol (Gateway) 
User’s Guide, for details. See Related Documentation, on page 11.
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Deleting an Action
To delete an action

1 Select the action you want to delete under the Actions tab.
2 Click the Delete toolbar button.
3 Click Save on the toolbar if you modified the action under the Actions tab, or click OK if 

you modified the action in the Action Editor window.
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Introduction
A user uses either the Kaleido-RCP2 and RCP-200 panels to connect to the multiviewer 
using a username/password combination. This chapter explains the configuration of a 
Kaleido multiviewer for use with a Kaleido-RCP2, an RCP-200 Remote Control Panel, or from 
the Gateway.

XEdit Quick Start Task List
Follow these steps in XEdit, to set up your RCP users’ profiles:

1 Create an RCP user. See Managing RCP Users on page 274.
2 Grant room access to the RCP user. See Managing Room Access on page 276.
3 Select the configuration of the external keyboard for this user. See Setting the 

Keyboard Language on page 283.

Key Concepts

Term Description

Kaleido-RCP2 The Kaleido-RCP2 is a multi-function remote control panel designed for 
use with Grass Valley's Kaleido multiviewers. Ethernet connectivity 
allows multiple RCP users to access multiple Kaleido systems, allowing 
convenient access to their real-time operating features.
The XEdit application is used to manage certain aspects of the 
Kaleido-RCP2 such as layout presets and audio monitoring destination

RCP-200 The RCP-200 advanced remote control panel for Densité cards, Kaleido 
multiviewers, and NVISION/third party routers. It provides a highly 
intuitive graphical interface and it simplifies video/audio signal 
processing and control in both single and multi-user environments.
The XEdit application is used to manage certain aspects of the RCP-200 
such as layout presets and audio monitoring destination.

Gateway Kaleido multiviewers can execute commands received through the 
Kaleido Remote Control Protocol (Gateway) interface, allowing third-party 
developers and individual users remote access to some Kaleido 
functions. Refer to the Kaleido Remote Control Protocol (Gateway) User’s 
Guide, for more information. See Related Documentation, on page 11.
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Managing RCP Users

Adding RCP Users
To add an RCP user to the system

1 In the main window, click the RCP users tab.
2 On the Tools pane, right-click anywhere in the RCP users area, and then click New user 

on the menu.

A new user is added to the RCP users list.

Removing RCP Users from the System
To remove an RCP user from the system

1 In the main window, click the RCP users tab.
2 On the Tools pane, select the user you want to remove from the system’s RCP users list.
3 Right-click the selection, and then click Delete user on the menu.

A confirmation window appears.

Notes
• New users are called UserN, where N = 1, 2, 3 etc.
• RCP users can be renamed. See Changing an RCP User’s Name or Password 

on page 285.
• New users are saved automatically; it is not necessary to click the Save 

button after adding a user to the system.
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4 Click Yes.
5 On the File menu, click Save.

Note: The user Admin cannot be removed.
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Managing Room Access

Granting Room Access to RCP Users
To grant RCP users access to a room

1 In the main window, click the RCP users tab.
2 On the Tools pane, select the appropriate users from the RCP users list.

3 Drag the selected users onto the appropriate room in the RCP users tab.
4 Expand the room (if it is not expanded already) to verify that the users were added.

RCP user “User2” has been granted access to Room2

5 On the File menu, click Save.

Removing RCP Users from Rooms
To remove RCP users from rooms

1 In the main window, click the RCP users tab, expand the appropriate rooms if needed, 
and then select the users you want to remove.

2 On the File menu, click Remove user from room. Alternatively, click the toolbar’s 
Remove button , or right-click and then click Remove user from room on the menu.

The selected user is removed access to the room.
3 On the File menu, click Save.

Note: Use Shift+click or Ctrl+click to select multiple users.

Note: Use Shift+click or Ctrl+click to select multiple users.

Note: The user Admin cannot be removed.
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Setting Room Preferences
Room preferences will apply by default for any user who log on to the room from a 
Kaleido-RCP2, or RCP-200 control panel. See Setting RCP User Preferences on page 279, to 
learn how to configure preferences for a specific user.

To set default preferences for a room
1 In the main window, click the RCP users tab, and then select the appropriate room.

The selected room’s preferences (layout presets, audio monitoring output, mouse 
pointer size, and timer) are listed in the Properties pane.

2 Modify the room preferences as needed.

3 On the File menu, click Save.

Assigning Room Layouts to the Kaleido-RCP2 Preset buttons
To assign room layouts to the Kaleido-RCP2 preset buttons

1 In the main window, click the RCP users tab, and then select the room for which you 
want to configure layout presets.

2 For each Kaleido-RCP2 preset button, click the corresponding box in the Properties 
pane, and then select the appropriate layout from the list.

Note: An asterisk (*) will appear beside the room in the main pane, if any of 
its properties are modified. The asterisk will disappear when the changes are 
saved.
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Assigning an Audio Output to the Remote Control Panel’s AUDIO 
MONITORING Button

To assign an audio output to the Remote Control Panel’s AUDIO MONITORING button for 
a room

1 In the main window, click the RCP users tab, and then select the room for which you 
want to configure the remote control panel’s AUDIO MONITORING button.

2 In the Properties pane, click the Audio monitoring output box, and then select the 
output used to monitor audio signals, from the list.

Enabling the Large Mouse Pointer for a Room
To display a larger pointer on the monitor wall for a room

1 In the main window, click the RCP users tab, and then select the room where you want 
to use a large pointer on the monitor wall.

2 In the Properties pane, select the Use large mouse pointer check box.
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Assigning a Timer to a Room
To assign a default timer for all RCP users in a room

1 In the main window, click the RCP users tab, and then select the room to be assigned a 
timer.

2 In the Properties pane, click the Timer box, and then select the appropriate timer to be 
controlled by default from this room.

Setting RCP User Preferences
To modify the preferences for an RCP user

1 In the main window, click the RCP users tab, and then select the user whose 
preferences you want to set, from under the appropriate room.
The selected RCP user’s preferences (layout presets, full screen assignment, audio 
monitoring output, external keyboard configuration, and timer) are listed in the 
Properties pane.

Note: When the large mouse pointer option is enabled for a room, the 
menus also appear in a larger font size on the monitor wall displays 
associated with this room.
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2 Modify the preferences as needed. See:
• Assigning Room Layouts to a Kaleido-RCP2 User’s Presets, on page 281,
• Assigning a Full Screen Layout to an RCP User, on page 281,
• Assigning Audio Output to an RCP User, on page 282, and
• Setting the Keyboard Language, on page 283.

3 Modify the system-level attributes for this user (user name, description, password) as 
needed. See Changing an RCP User’s Name or Password on page 285.

4 On the File menu, click Save.

Note: User preferences are specific to an RCP user in a specific room. If no 
preferences have been specified for an RCP user, then the corresponding 
room preferences apply. They appear in gray in the Properties pane.

Note: These system-level attributes are specific to a user, independent of 
the room to which the user is assigned.

Notes

• The Admin user name cannot be modified.

• An asterisk (*) will appear beside the RCP user in the main window if any of 
the user properties are modified. The asterisk will disappear when the 
changes are saved.

• The message “Cannot find reference” indicates that a full screen layout, full 
screen zone, or layout associated with a Room or RCP user has been 
deleted.
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Assigning Room Layouts to a Kaleido-RCP2 User’s Presets
To assign a room layout to a Kaleido-RCP2 user’s preset button

1 In the main window, click the RCP users tab, and then select the user for whom you 
want to configure the remote control panel’s preset buttons, from under the 
appropriate room.

2 For each Kaleido-RCP2 preset button, click the corresponding box in the Properties 
pane, and then select the appropriate layout from the list.

Assigning a Full Screen Layout to an RCP User
To assign a full screen layout to an RCP user

1 In the main window, click the RCP users tab, and then select the user for whom you 
want to configure the remote control panel’s FULL SCREEN button, from under the 
appropriate room.

2 In the Properties pane, click the Full screen settings box, and then click the button that 
appeared at the end of the box.

Note: If no layout is specified for this user preset, the layout that has been 
selected for this preset in the room’s preferences will apply. It will appear in 
gray in the Preset [n] box. See Setting Room Preferences on page 277.
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The Full Screen Settings window appears.
3 In Full Screen Settings, select the appropriate full screen layout, and then click OK.

Assigning Audio Output to an RCP User
To assign an audio output to an RCP User

1 In the main window, click the RCP users tab, and then select the user for whom you 
want to configure the remote control panel’s AUDIO MONITORING button, from under 
the appropriate room.

2 In the Properties pane, click the Audio monitoring output box, and then select the 
output used to monitor audio signals by this user in this room, from the list of available 
outputs.

Note: Before XEdit 2.00, full screen layouts were not associated with a 
specific full screen zone. In the case of such legacy layouts, you must also 
select the appropriate full screen zone from the Zone list.

Full screen settings button
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Setting the Keyboard Language
To set the input language for an external keyboard connected to the Kaleido-RCP2 or 
RCP-200

1 In the main window, click the RCP users tab, and then select the user for whom you 
want to set the keyboard, from under the appropriate room.

2 In the Properties pane, click the Keyboard box, and then select the keyboard to be 
used by this user in this room, from the list of available keyboard configurations.

Note: If no audio monitoring output is specified for this user, the output 
signal that has been selected in the room’s preferences will apply. It will 
appear in gray in the Audio monitoring output box. See Setting Room 
Preferences on page 277.
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Assigning a Timer to an RCP User
To assign a timer to an RCP User

1 In the main window, click the RCP users tab, and then select the user to whom you 
want to assign a timer, from under the appropriate room.

2 In the Properties pane, click the Timer box, and then select the appropriate timer to be 
controlled by this user in this room, from the list of available timers.

Note: This setting applies to the selected user, in the current room only. A 
keyboard configuration must be selected for each user, in every room, 
unless the system default is suitable.
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Changing an RCP User’s Name or Password
To change an RCP user’s name and password

1 In the main window, click the RCP users tab, and then select the user whose user name 
or password you want to change, from under any of the rooms.

2 In the Properties pane, click the User name box, and then type the new name.

3 In the Properties pane, click the Password box, and then click the button that 
appeared at the end of the box.

The Password Modification window appears.

Note: If no timer is specified for this user, the timer that has been selected 
in the room’s preferences will apply. It will appear in gray in the Time box. 
See Setting Room Preferences on page 277.

Note: A user’s name or password cannot be changed from within the Tools 
pane. They can only be changed from within the rooms list, in the main 
pane. The user can be removed from the room after the name or password 
change. The change will be retained. See Granting Room Access to RCP 
Users on page 276.

Note: The name must be no more than 8 characters in length, and consist 
of only letters and numbers (no spaces or special characters).

Password modification button
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4 In Password Modification, type the new password (only numbers, up to 8 digits) and 
then type it again to confirm.

5 Click OK.
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Introduction
This chapter describes how multiviewers can be configured to receive dynamic labels and 
status from tally interface devices, timer, time code and status information from a timer 
system, or status from a GPI module.

Overview
Kaleido multiviewer systems support most production switchers and other tally interface 
devices such as UMD controllers and automation systems, through a network connection. 
Some timer systems and GPI I/O modules are also supported through a network 
connection. The multiviewer can dynamically update monitor wall elements to reflect text 
and status updates from the devices.

Key Concepts

Drivers for Controlling Tally Interface Devices from the Multiviewer
Drivers are available to extend your Kaleido-X system with the ability to control tally 
interface devices such as the ones listed in the tables below. Contact your sales 
representative for more information.

Production Switchers

Company Device/System

Grass Valley (Thomson) Kayenne K-Frame, Karrera K-Frame, XtenDD HD/SD series

UMD controllers

Company Protocol Device/System

TSL TSL UMD protocol V5.0 UMD Controller (TCP/IP or UDP/IP)
IP Limitation: only one screen index can be 
received per unicast port.

Image Video TSI-1000 Tally System Interface (requires 
option from Image Video)
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Drivers for Timers

Automation systems

Company Device/System

Sundance Digital Fastbreak NXT Automation (requires option from Sundance 
Digital)

Timer systems

Company Device/System

Plura (Alpermann+Velte) Studio Production Timer (SPT)
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Plura (Alpermann+Velte) Studio Production Timer

For your multiviewer to receive time code information from a Plura (Alpermann+Velte) 
Studio Production Timer (SPT) system, and to display the system’s contribution on the 
monitor wall, you need to configure your multiviewer’s Plura SPT service, by performing the 
following tasks in XEdit:

1 Add the Plura (Alpermann+Velte) SPT timer system to your multiviewer system 
configuration, and set up the communication parameters (see Adding a Timer System 
to your Multiviewer Configuration on page 289).

2 Add logical sources and configure them by assigning alarms (or text elements) from the 
SPT system to the logical sources’ alarm (or text) levels (see Assigning Timer System 
Information to Logical Sources on page 290).

3 Assign the appropriate alarm and text levels from logical sources, to layout elements 
such as time code monitors, UMDs or alarm monitors (see Configuring Layout Elements 
on page 292).

Adding a Timer System to your Multiviewer Configuration
To add a Plura (Alpermann+Velte) SPT system to your multiviewer configuration

1 Open XEdit.
2 Connect to the multiviewer, if you want to apply your changes in real time 

(see Connecting to a Multiviewer on page 28).

3 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

4 Drag the Plura (Alpermann+Velte) SPT device from the equipment library onto the 
root of the System hierarchical list.

Alternatively, right-click the list root, and then click Insert Plura (Alpermann+Velte) 
SPT on the menu.

Note: The Kaleido Software supports Plura (Alpermann+Velte) Studio 
Production Timer (SPT) systems that comprise a Rubidium series IE 
module with firmware version 2.14.24 or later, and option R (Timer 
Request Protocol) enabled. Only the Basic timer format mode is available.

Note: If this step is omitted, then you will need to export the database to 
apply the changes.
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A window appears, prompting you for a device identifier.
5 In Device Identifier, type a name for the timer system, and then click OK.

The timer system is added to the system list.

6 Click the Interconnects tab.
7 Position the pointer over the multiviewer icon, then click and drag towards the timer 

system icon.
A line representing the connection between the multiviewer and the device appears.

8 Click the connection line between multiviewer and device.
9 In the Properties pane, select Network (TCP/IP) from the Transport type list.

10 In the Interconnects tab, click the timer system icon.
11 In the Properties pane, type the IP address of your timer system.

You are now ready to add information from the timer system to logical sources.

Assigning Timer System Information to Logical Sources
To configure your logical sources

1 In the Channels/Sources tab, add the required number of logical sources for your 
purposes (see Manually adding a Logical Source on page 75).
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2 Add the required number of text and alarm levels for your purposes (see Adding a level 
on page 77).
For example, you might add one text level named Timer, and one alarm level named 
Timer status.

3 Click a cell that corresponds to the appropriate text level of a logical source you want to 
configure.

4 In the filtered System list, navigate to the text element you want to monitor, and drag it 
onto the selected cell.

5 If your logical sources include more text levels to be associated with the timer system, 
then repeat step 3 and step 4 for the current logical source’s remaining text levels.

6 Click a cell that corresponds to the appropriate alarm level of a logical source you want 
to configure.

7 In the filtered System list, navigate to the alarm element you want to monitor, and drag 
it onto the selected cell.
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8 If your logical sources include more alarm levels to be associated with the timer system, 
then repeat step 6 and step 7 for the current logical source’s remaining alarm levels.

9 Repeat step 3–step 8 for any remaining logical sources you want to configure with 
information from the timer system.

10 On the File menu, click Save.
Changes to the sources table are saved.

Configuring Layout Elements
You can now assign the logical sources you previously configured (see Assigning Timer 
System Information to Logical Sources on page 290) to UMDs or other monitors that can 
display text or alarms (such as time code monitors, alarm monitors) in a layout. Depending 
on your purposes, you will assign the appropriate text or alarm levels to specific 
components within the monitors.

For example, you might configure the assignments for an alarm monitor, by replacing the 
default alarm level and text label level assignments (both set to GlobalAlarm, by default) 
with an alarm level associated with the timer system, and the corresponding text level, 
respectively.

The procedure below explains how to configure a UMD to report timer text and status.

To configure a UMD for dynamic reporting of text and status from a timer system
1 Click the Layouts tab, and then open a layout.
2 Add a UMD from the set of predefined UMDs available on the Tools pane (such as 

umd2), or use the UMD toolbar button  (see Configuring UMDs, on page 224, and 
Working with Composite Monitors, on page 249, if needed).

3 On the Tools pane, select one of the logical sources you previously configured 
(see Assigning Timer System Information to Logical Sources on page 290) from the 
filtered Channels/Sources list, and then drag it onto the UMD.

4 In the Properties pane, click the Text label level box, and then select the text level you 
want to monitor (such as the Timer level you previously configured).
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5 Click the UMD alarm level box, and then select the alarm level you want to monitor 
(such as the Timer status level you previously configured).

6 Select a monospace font for the text:
a Click the Text font box, and then click the button that appears inside the box to 

open the font picker window.
b In Select a Font, click a monospace font (such as Lucida Sans Typewriter), and then 

click OK to close the window.
Alternatively, set the text to be left-aligned by clicking the Text horizontal alignment 
box, and then selecting Left from the list.

7 Click outside the composite to lock it, if applicable.
8 On the File menu, click Save.
9 If you have been working in offline mode, then export the database to your 

multiviewer (see Exporting a Database on page 32).

On the monitor wall, you can now load the layout containing the monitors that were 
assigned information from the Plura (Alpermann+Velte) SPT system. Text and status 
information from the device will be visible on the monitor wall. Any changes made by the 
device’s operator will be immediately reflected on the monitor wall.
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GPI-1501 General Purpose Interface I/O Module
The GPI-1501 is a 2RU Densité card that provides 20 dedicated GPI (General Purpose 
Interface) inputs plus eight terminals that can be individually configured as either a GPI 
input or GPI output. You may add one or more GPI-1501 modules to your multiviewer 
configuration to supplement the multiviewer’s existing GPI interface or, in the case of a 
Kaleido-Modular-X system, to provide such an interface. 

For example, you may resort to the GPI interface to receive tally information from a switcher 
whose specific protocol the multiviewer does not support, assuming the switcher is 
capable of communicating through GPI.

For your multiviewer to receive status information from a GPI-1501 module, and to display 
the module’s contribution on the monitor wall as visual tally information, you need to 
configure your multiviewer’s GPI-1501 service, by performing the following tasks in XEdit:

1 Add the GPI-1501 module to your multiviewer system configuration, and set up the 
communication parameters (see Adding a GPI-1501 Module to your Multiviewer 
Configuration on page 294).

2 Configure logical sources by assigning GPI alarms from the GPI-1501 module to the 
logical sources’ alarm levels (see Assigning GPI Status Information to Logical Sources on 
page 297).

3 Assign alarm levels from logical sources, to layout elements such as UMDs or alarm 
monitors (see Configuring Layout Elements on page 298).

Adding a GPI-1501 Module to your Multiviewer Configuration
To add a GPI-1501 module to your multiviewer system configuration

1 Open XEdit.
2 Connect to the multiviewer, if you want to apply your changes in real time 

(see Connecting to a Multiviewer on page 28).

3 In the main window, click the System tab, and then click Description/Calibrations on 
the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

4 Drag the GPI-1501 device from the equipment library onto the root of the System 
hierarchical list. Alternatively, right-click the list root, and then click Insert GPI-1501 on 
the menu.

A window appears, prompting you for a device identifier.

Note: If this step is omitted, then you will need to export the database to 
apply the changes.
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5 In Device Identifier, type a name for the GPI-1501, and then click OK.

The GPI-1501 is added to the system list.

6 Click the Interconnects tab.
7 Position the pointer over the multiviewer icon, then click and drag towards the 

GPI-1501 icon.
A line representing the connection between the multiviewer and the device appears.

8 Click the connection line between multiviewer and device.
9 In the Properties pane, select Network (TCP/IP) from the Transport type list.

10 In the Interconnects tab, click the GPI-1501 icon.
11 In the Properties pane, type the number of the slot where your GPI-1501 card is located 

in its housing frame, directly in the Slot number box, or use the slider to set it.

Note: In the case of a system with several GPI-1501 modules, some of which 
you do not necessarily use all the time, you may choose to momentarily 
disconnect those that are not in use, when you need to reduce network 
traffic, by selecting Disconnected from the Transport type list.
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• Enter the IP address of the Densité frame housing the GPI-1501 (use the IP address 
associated with the CPU-ETH2 controller card’s ETH1 port).

12 If you want to configure the GPI-1501 itself, click the Description/Calibrations tab, and 
then expand the appropriate GPI-1501 module in the System list.

a Click one of the eight configurable I/O terminals.

b In the Properties pane, select the appropriate value from the GPI IO direction list, 
to configure the GPI line’s direction (input or output).

c In the case of a GPI output line, if you want to set its ON/OFF state manually for test 
purposes, then select either ON or OFF from the GPI output control list.

d To configure the source of timestamp information, click the Timestamp element in 
the System list, and then, in the Properties pane, select the appropriate value from 
the Timestamp source list.

Note: GPI-1501 configuration is only available when XEdit is connected to 
the multiviewer. If you were working in offline mode up to this point, you 
must now export the database to the multiviewer (see Exporting a Database 
on page 32), and then switch to online mode (see Connecting to a 
Multiviewer on page 28).
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• None: No timestamping.
• CPU: Timestamping will be based on the Densité CPU-ETH2 controller card’s 

real time clock.
• LTC: Timestamping will be based on the LTC signal at GPI input 20 if available. 

Selecting LTC as the timestamp source renders GPI input 20 unavailable for GPI 
purposes.

• URS: Timestamping will be based on the time information carried in the URS 
signal internal to the Densité housing frame. The URS is generated by a 
reference module (REF-1801) which must be installed in the frame for the URS 
to be available.

e If you selected LTC, then you may enable SMPTE ST 309 support.

You are now ready to add information from the GPI-1501 to logical sources.

Assigning GPI Status Information to Logical Sources

To configure your logical sources
1 In the Channels/Sources tab, add the required number of alarm levels for your 

purposes (see Creating and Configuring Logical Sources on page 72). For example, you 
might add one alarm level named On-air tally.

2 Click a cell that corresponds to the appropriate alarm level of a logical source you want 
to configure.

3 In the filtered System list, navigate to the GPI element you want to monitor, and drag it 
onto the selected cell.

New alarm level
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4 If your logical sources include more alarm levels to be associated with the GPI-1501, 
then repeat step 2 and step 3 for the current logical source’s remaining alarm levels.

5 Make corresponding assignments to other logical sources by incremental copy, if 
necessary (see Making Further Assignments by Incremental Copy on page 83).

6 On the File menu, click Save.
Changes to the sources table are saved.

Configuring Layout Elements
You can now assign the logical sources you previously configured (see Assigning GPI Status 
Information to Logical Sources on page 297) to monitors that can display text or alarms (for 
example, UMD, video, text alarm status) in a layout. Depending on your purposes, you will 
assign the appropriate text or alarm levels to specific components within the monitors. For 
example, you might select an alarm level as the source for an alarm monitor, and the 
GlobalAlarm level (see Global Alarms on page 118) as the text label level. The procedure 
below explains how to configure a UMD to report the On-air tally status.

To configure layout elements for dynamic text and tally reporting
1 Click the Layouts tab, and then open the layout you want to configure.
2 On the Tools pane, select one of the logical sources you previously configured 

(see Assigning GPI Status Information to Logical Sources on page 297) from the filtered 
Channels/Sources list, and then drag it onto the appropriate monitor.

3 Repeat step 2 until you have assigned all the sources you want to monitor to the 
appropriate monitors in your layout.

4 Click a UMD whose tally reporting behavior you want to set, after unlocking the 
composite monitor that contains it if applicable (see Unlocking a Composite Monitor 
on page 254).

5 In the Properties pane, click the Right tally source level box, and then select the alarm 
level you want to monitor (such as the On-air tally level you previously configured).

Alarm level based on status 
information from the GPI-1501
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Alarm level selection for the right tally in a UMD

6 Click outside the composite to lock it, if applicable.
7 Repeat step 4 and step 5 until you have configured all UMDs that are to display tally 

status when this layout is loaded on the monitor wall.
8 On the File menu, click Save.
9 If you have been working in offline mode, then export the database to your 

multiviewer (see Exporting a Database on page 32).

On the monitor wall, you can now load the layout containing the monitors that were 
assigned tally information provided by the GPI-1501. Tally status from the device (such as a 
switcher) feeding the GPI-1501 module will be visible on the monitor wall. Any changes 
made by the device’s operator will be immediately reflected on the monitor wall.
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TSL IP UMD Controller
The TSL IP Tally system can be added to a multiviewer system to receive and interpret UMD 
information from peripheral devices. 
TSL IP Limitation: only one screen index can be received per unicast port.
Workaround: configure multiple unicast ports, each associated to a different screen index. Then 
in the multiviewer configure multiple TSL drivers (each configured with a different unicast port 
number) to receive each separate UMD stream index. 
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K-Frame Switchers
A multiviewer can receive dynamic source names and tally information from Grass Valley 
K-Frame production switchers, such as Kayenne K-Frame or Karrera K-Frame Video 
Production Center systems. The procedures below describe how to set up a multiviewer to 
interface with this family of production switchers.

Configuring the K-Frame Switcher
To establish tally contribution from the switcher to your multiviewer, you need to identify 
the multiviewer as a tally client, by using the switcher’s touch screen menu panel or the 
K-Frame Menu application.

To set up the K-Frame switcher
1 On the K-Frame touch screen menu panel, touch the Eng Setup menu button, the 

Ports & Devices category button, and then the Tally Ports tab.
The Tally Ports menu appears.

2 Enter your multiviewer’s IP address in one of the two tally ports, and then touch the 
Enable button for the selected port.
The connection status indicator turns red, since the connection has yet to be 
established on the multiviewer side.

Assuming the required sources and outputs have been defined, this completes the 
configuration required on the switcher. The multiviewer system will be able to send 
commands to the switcher, and the switcher will respond accordingly. Refer to your 
switcher’s Installation & Service Manual for more information.3

Configuring the Multiviewer
For your multiviewer to receive tally status, and source names from a K-Frame switcher, and 
to display the switcher’s contribution on the monitor wall as visual tally and dynamic text 
information, you need to configure your multiviewer’s K-Frame tally service, by performing 
the following tasks in XEdit:

• set up the communication parameters;

3.Manuals and Release Notes for all Grass Valley production switchers are available here:
http://www.grassvalley.com/apps/doc_prodlist?super=broadcast&set=switchers

http://www.grassvalley.com/apps/doc_prodlist?super=broadcast&set=switchers
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• configure logical sources by assigning source names and tally status from the switcher, 
to the logical sources’ text or alarm levels;

• assign alarm and text levels from logical sources to layout elements such as UMDs or 
alarm monitors.

Establishing communication between the K-Frame switcher and the 
multiviewer

To set up the multiviewer’s communication parameters
1 Open XEdit.
2 In the main window, click the System tab, and then click Description/Calibrations on 

the second-level tab bar. The main pane displays the System hierarchical list, and the 
Tools pane displays the equipment library when the root of the System list is selected.

3 Drag the K-Frame switcher device from the equipment library onto the root of the 
System hierarchical list. Alternatively, right-click the list root, and then click Insert 
K-Frame on the menu.
A window appears, prompting you for a device identifier.

4 Type a name for the K-Frame production switcher, and then click OK.
The device is added to your system configuration.

5 Click the Interconnects tab.
6 Position the pointer over the multiviewer icon, then click and drag towards the K-Frame 

production switcher icon.
A line representing the connection between the multiviewer and the device appears.

7 Click the connection line between multiviewer and device.
8 In the Properties pane, select Network (TCP/IP) from the Transport type list.
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9 In the Interconnects tab, click the K-Frame production switcher icon.
10 In the Properties pane, enter the K-Frame switcher’s IP address, and set the appropriate 

output numbers to use for tally calculation, based on your switcher’s configuration.

By default, in XEdit, Tally 1 corresponds to the K-Frame switcher’s output 1 (which 
typically carries the Program signal), and Tally 2 corresponds to the K-Frame switcher’s 
output 5 (typically the Preview signal).

11 On the File menu, click Save.
This establishes communication between the multiviewer and the switcher. On the 
touch screen menu panel (or in K-Frame Menu) you may notice that the status 
indicators turned green in the Tally Ports menu, and your multiviewer is now listed in 
the Tally Clients list.

Assigning K-Frame tallies and input names to logical sources
The K-Frame contribution tally protocol provides information on up to 192 inputs, up to 96 
outputs, the full set of fixed sources internal to the K-Frame system, and up to 2 complete 
operator suites. In XEdit’s Channels/Sources tab, configure logical sources using input 
names and system tallies from the K-Frame. You will find these elements by expanding the 
filtered system list that appears on the Tools pane.
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• For every input, 6 tallies, and 2 text labels (the engineering name and the OLED name) 
are available. When the OLED name is not defined for an input, both text labels contain 
the engineering name. A tally status indicates whether the input contributes to the 
output associated with the tally (see step 10, under Establishing communication 
between the K-Frame switcher and the multiviewer, on page 302). For example, if 
Tally 1 has been configured to match Output 1, then the Tally 1 status of an input 
indicates whether this input contributes to Output 1.

• For every physical output of the K-Frame, the (static) name of the output is available.

• Within the operator suites, 6 tally statuses are available for every video processing 
engine (VPE) output. The tally status indicates whether the VPE output contributes to 
the switcher output associated with the tally.
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To configure your logical sources
1 In the Channels/Sources tab, add the required number of text and alarm levels for your 

purposes (see Creating and Configuring Logical Sources on page 72).
You may, for example, add two text levels to monitor source labels from the K-Frame 
switcher, and two alarm levels to monitor Program and Preview tallies.

2 Click a cell that corresponds to the appropriate text level of a logical source.
3 In the filtered System list, navigate to the text element you want to monitor, and drag it 

onto the selected cell.

K-Frame elements available from the filtered System list, for assignment to text levels in the 
sources table

4 If your logical sources include more text levels to be associated with the switcher, then 
repeat step 2 – step 3 for the current logical source’s remaining text levels.

5 Click a cell that corresponds to the appropriate alarm level of the current logical source.
6 In the filtered System list, navigate to the tally element you want to monitor, and drag it 

onto the selected cell.
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K-Frame elements available from the filtered System list, for assignment to alarm levels in the 
sources table

7 If your logical sources include more alarm levels to be associated with the K-Frame 
switcher, then repeat step 5 – step 6 for the current logical source’s remaining alarm 
levels.

8 Make corresponding assignments to other logical sources by incremental copy, if 
necessary (see Making Further Assignments by Incremental Copy on page 83).

9 On the File menu, click Save.
Changes to the sources table are saved.

Configuring layout elements
You can now assign the logical sources you previously configured (see Assigning K-Frame 
tallies and input names to logical sources on page 303) to monitors that can display text 
(such as UMD) or alarms (such as UMD, video, text alarm status) in a layout. Depending on 
your purposes, you will assign the appropriate text or alarm levels to specific components 
within the monitors (for example, assign an alarm level to tally components in a UMD, or a 
text level to the UMD text component).

To configure layout elements for dynamic text and tally reporting
1 Click the Layouts tab, and then open the layout you want to configure.

Text levels based on dynamic 
K-Frame source labels

Alarm levels based on tallies 
from the K-Frame switcher
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2 On the Tools pane, select one of the logical sources you previously configured 
(see Assigning K-Frame tallies and input names to logical sources on page 303) from 
the filtered Channels/Sources list, and then drag it onto the appropriate monitor.

3 Repeat step 2 until you have assigned all the sources you want to monitor to the 
appropriate monitors in your layout.

4 Click the first UMD whose dynamic text and tally reporting behavior you want to set, 
after unlocking the composite monitor that contains it if applicable (see Unlocking a 
Composite Monitor on page 254).

5 In the Properties pane, click the Left tally source level box, and then select the alarm 
level you want to monitor.

Alarm level selection for the left tally in a UMD

6 Click the Right tally source level box, and then select the appropriate alarm level, if 
applicable.

7 Click the Text label level box, and then select the text level you want to monitor.

Text level selection for the text label in a UMD

8 Click outside the composite to lock it, if applicable.
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9 Repeat step 4 – step 8 until you have configured all UMDs that are to display dynamic 
text and tally status when this layout is loaded on the monitor wall.

10 On the File menu, click Save.
11 If you have been working in offline mode, then export the database to your 

multiviewer (see Exporting a Database on page 32).

On the monitor wall, you can now load the layout containing the monitors that were 
assigned dynamic text and tallies provided by the K-Frame switcher. Input names, and tally 
status from the switcher will be visible on the monitor wall. Any changes made by the 
switcher’s operator will be immediately reflected on the monitor wall.
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Introduction
This section introduces the multiviewer monitor wall features and describes the actions you 
can perform on the multiviewer’s monitor wall.

Key Concepts

Monitor wall The monitor wall refers to the group of display screens that are connected to 
the output modules of a specific Kaleido system.

Room A room is a visual grouping of display screens. A room represents the physical 
displays, positioned and sized as viewed by the user in an actual room. 
Rooms can include full screen zones, and are defined and configured by using 
the XEdit application. See Logging on to the Monitor Wall Using a Remote 
Control Panel on page 314.

Automatic 
resolution 
detection

Automatic resolution detection eases the initial setup of a new display monitor 
by automatically determining the best resolution supported by the display. 
This ensures that the multiviewer will be configured for the best video 
quality. When a new display is connected, the multiviewer will detect the 
EDID of the display on boot-up, and will set the correct resolution 
accordingly. This means that displays can be hot-swapped. If an existing 
display is replaced by a new one, the multiviewer will automatically change 
the resolution without the need for a system restart. 
Note: The Kaleido-IP does not support automatic output resolution 
detection.

Layout A layout refers to a visual grouping of monitors on the monitor wall. Layouts 
are specific to a room, and created by using the XEdit application. Full screen 
layouts, also defined in XEdit, are specific to a full screen zone within a 
particular room. See Loading Layouts, on page 320, and Displaying a Source 
in Full Screen Mode, on page 323.

Dashboard The dashboard is a window that contains the system name, IP address and 
software build version. It also displays error messages. The dashboard is 
displayed at the bottom right of each display, on the monitor wall:

See Displaying the Dashboard, on page 318, and Hiding the Dashboard, on 
page 319.
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Monitor A monitor is an element that is part of a layout. XEdit supports several types 
of primary elements (clocks, timers, video monitors, audio monitors, UMDs, 
time code monitors, alarm monitors, etc.), that can be grouped into 
composite monitors.

Logical source A logical source (called a channel, in earlier versions of the documentation) 
refers to a group of physical audio, video, or metadata sources, and text 
attributes. A logical source can be used as a whole, and assigned to a virtual 
monitor. See Assigning Sources to Monitors on page 332.

Video monitor A video monitor is a layout element used to define an area for displaying a 
video signal. Within a video monitor, the video window is the active area 
where the video signal is displayed, possibly including closed captions or 
teletext. See Displaying Subtitles and Closed Caption Text on page 326.

Composite 
monitor

A composite monitor (also referred to as a composite, a monitor or a tile) is a 
group of primary elements that can be seen as a single object within a layout. 
Composite monitors typically include a video window, one or more audio 
level meters, and a UMD with two tallies.

Safe area The safe area is a configurable region inside a video window. The safe area 
markers delimit this region (for example, a 4:3 region inside a 16:9 window). 
See Toggling Safe Area Markers on page 325.

Audio monitor An audio monitor (also called audio level meter or ALM) is a layout element 
that provides a visual representation of sound. See Audio Monitoring on 
page 313.

UMD An under monitor display (UMD) has a text label that can be static or 
dynamically updated by a peripheral device. It can also have left and right 
tally indicators. The UMD typically indicates the name of the video source 
seen in a video monitor. You can edit static labels directly on the monitor 
wall: see Editing UMD Text, on page 330, and Selecting an Input Method, on 
page 331.

Time code 
monitor

A time code monitor displays the Ancillary Time Code (ATC) from an HD video 
signal, or the time code found in an embedded SDI video signal, part of the 
vertical interval of an analog signal (VITC), or other external Linear Time Code 
(LTC). This monitor also supports time code information from external 
providers. Time code monitors can be used for monitoring the duration of 
programs.

RCP User The advanced Remote Control Panel (RCP) simplifies video/audio signal 
processing and control in both single and multiuser environments. RCP User 
use the RCP to control connected equipment.

Timer A timer monitor is based on a timer defined within the multiviewer system.
Three timer modes are available: (1) UP: timer counts up starting from zero 
up to a preset time, (2) DOWN: timer counts down from a preset time to zero, 
and (3) REMAINING: timer counts down from the current time until it reaches 
a preset time.
Timers are defined and configured in XEdit. They can be slaved to production 
timers, assigned to logical sources, assigned to rooms or specific RCP users, 
and controlled from the Kaleido-RCP2. See Using Timers on page 336.

Clock A clock is the visual representation of time in a video or display. It can be 
based on a reference LTC signal or on the multiviewer’s system time. 
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Subtitling 
monitor

A subtitling monitor defines an area for displaying subtitles extracted from a 
video signal. By using a subtitling monitor you can monitor subtitling from a 
specific DVB or SCTE 27 stream, independently from the associated video 
stream. This requires the CC/XDS option to be enabled (see the multiviewer’s 
Installation & Service Manual for more information). See Setting the DVB 
Subtitling Language from the Monitor Wall, on page 328, and Setting the 
SCTE 27 Subtitling Language from the Monitor Wall, on page 329.
Note: With the current version of the Kaleido Software, the subtitling 
monitor supports DVB subtitles and SCTE 27 subtitles, from Kaleido-IP 
sources only.

V-chip monitor The V-chip monitor provides a visual indication of the V-chip rating from the 
CC (608) metadata in an SD video signal, or from the CC (608) legacy caption 
data, when such data is present within an HD video signal. Requires the 
CC/XDS option to be enabled (see the multiviewer’s Installation & Service 
Manual for more information).

Metadata 
monitor

A metadata monitor defines an area for displaying XDS, or digital content 
advisory descriptor (CAD) information compliant with CEA-766-D, extracted 
from a video signal. This requires the CC/XDS option to be enabled (see the 
multiviewer’s Installation & Service Manual for more information).

Action An action is an operation automatically performed in response to a specific 
trigger. Monitor wall actions are directly associated with layout elements. 
Background (floating) actions are actions that are global to the multiviewer 
system. Unlike monitor wall actions, background actions are always available. 
See Triggering Actions on page 339.

Trigger A trigger is an event that triggers an action. An example of a trigger could be 
a double click on a monitor. Background actions are triggered by alarms or 
by Gateway commands. In XEdit, when defining an action for a layout 
element, you could specify, for instance, that a specific full screen layout be 
displayed on the monitor wall in response to the trigger.

Alarm monitor Alarm monitors help you see the status of global and virtual alarms, but their 
use is not limited to this type of alarms. When any alarm level is assigned to 
an alarm monitor, the status of this alarm will be shown. When using the 
global alarm at the text label level, it will display the text value of the alarm, 
which is a readable name.

Alarm latch To prevent operators from missing temporary alarms on the monitor wall, 
layout elements that are capable of displaying an alarm status (for example, 
video monitors, subtitling monitors, UMDs, alarm monitors) can be 
configured with a latching mechanism. An alarm latch will keep the error 
state visible until someone acknowledges the associated alarm. 
See Acknowledging Alarms on page 340.

When you acknowledge an alarm, latched or current, the latched status is 
reset to normal (that is, unlatched). If the alarm is acknowledged while its 
status indicates an error condition, the latched status is reset to normal, and 
will only go back to error if the alarm status returns to normal and then to 
error again.
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Note: If you have an iControl application server, you may use its GSM alarm 
browser to configure an acknowledgement snooze duration, which defines the 
period during which alarm status changes detected by your multiviewer are 
ignored, immediately after an alarm is acknowledged. Such a snooze period is 
typically not desirable in the context of multiviewer alarms. Therefore, a 
multiviewer’s GSM has its acknowledgement snooze duration set to 0 ms, by 
default. 

Video monitors can provide alarm status information through their borders’ 
color and blinking behavior, and show the latched state as small indicators in 
each corner of the video window. UMDs (text and tallies) and alarm monitors 
can change their text or background color and blinking behavior, to reflect 
the alarm status and show the latched state through their borders.

See Configuring a Video Monitor’s Alarm Reporting Behavior, on page 199, 
Configuring a UMD’s Alarm Reporting Behavior, on page 225, and 
Configuring Alarm Monitors, on page 231, for details on configuring the 
alarm reporting and latching attributes for these layout elements.
The multiviewer tracks the latched state of all alarm levels in a logical source 
at all times, even when alarms are not being monitored on the monitor wall, 
or through SNMP traps or background actions. It could thus happen that 
some layout elements will show a latched status indicator after a layout is 
loaded, even if the current state of the corresponding alarm is normal and 
the alarm was not monitored in the previous layout (the alarm occurred on 
the feed while the feed was not monitored).
• Latching only occurs when an alarm severity is above normal (for example, 

minor, major, or critical). All other alarm states (unavailable, unassigned, 
pending, unknown, etc.) are not latched.

• Unlatching a global alarm unlatches all its contributing alarms. Unlatching 
the last alarm contributing to a global alarm unlatches the global alarm 
itself.

• The color of the latch indicator reflects the highest level of alarm received 
since the corresponding alarm was last unlatched.

Gateway Kaleido multiviewers can execute commands received through the Kaleido 
Remote Control Protocol (Gateway) interface, allowing third-party developers 
and individual users remote access to some Kaleido functions. Refer to the 
Kaleido Remote Control Protocol (Gateway) User’s Guide, for more information. 
See Related Documentation, on page 11.

Red border indicates

Red corners indicate

current alarm state

latched state
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Audio Monitoring
The Kaleido-RCP2’s volume control, Mute, and -20dB buttons, their equivalent on the RCP-200, 
and the corresponding Gateway commands apply to analog audio monitoring outputs are not 
supported by the Kaleido-IP.
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Logging on to the Monitor Wall Using a Remote Control Panel
As network devices, the RCP-200 advanced remote control panel, and the Kaleido-RCP2 
control panel provides access to any room, from any Kaleido multiviewer system on the 
network. As a security measure, access is controlled by a login procedure. Multiple RCP-200 
and Kaleido-RCP2 can be used by different users to access the same room concurrently. 
When multiple RCP users are active in the same room, they each control a separate pointer 
on the monitor wall, and can use the monitor wall menu independently, as long as they 
limit their actions to separate displays.

In a default system configuration, a multiviewer’s video outputs are assigned to specific 
rooms:

• On a Kaleido-IP, the multiviewer outputs are assigned to ROOM.

Logging on to the Monitor Wall Using the Kaleido-RCP2
To log on to a Kaleido multiviewer’s room from the Kaleido-RCP2

1 On a Kaleido-RCP2 with an active connection to the network, press and hold the ENTER 
button until the ESC button lights up. The Configuration menu appears, with the 
ROOM SELECTION option displayed.

2 Press ENTER again to obtain the list of rooms from the Kaleido multiviewer systems that 
are currently available on the network.
The rooms are listed in the form [multiviewer name]/[room name].

3 In the room list, select the room you want to access by pressing the 2 key (to move up 
in the list) or the 8 key (to move down the list).

4 When the appropriate room name is highlighted, press ENTER to accept the new 
selection, and then press ESC to exit the Configuration menu.

5 Press the LOGIN key.
The following message will appear on the LCD display:
LOGIN Position
Admin 

6 Select your user name by pressing the 2 key (to move up in the list) or the 8 key (to 
move down the list).

7 When you user name is highlighted, press ENTER.
8 When prompted, type the password for this user name, then press ENTER.

The message “Access granted” will appear on the LCD display if the login is successful. If 
a mouse is connected to the Kaleido-RCP2, then you should be able to see and move 
the mouse pointer on the monitor wall. Alternatively, use the Kaleido-RCP2’s mouse-
function keys.

Note: By default, the user “Admin” has no password.

Notes

• If at any time the message “Target system is offline” or “No login list 
available” appears on the LCD display, press the ESC, ENTER and DEL keys 
simultaneously and go back to step 1.
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For more information on the Kaleido-RCP2, refer to the Kaleido-RCP2 Guide to Installation 
and Operation. See Related Documentation, on page 11.

Logging on to the Monitor Wall Using the RCP-200
To log on to a Kaleido multiviewer room from the RCP-200

1 On an RCP-200 with an active connection to the network, press the LIST button.
All devices, and Kaleido multiviewer rooms, detected by the RCP-200 appear on the left 
screen. Kaleido multiviewer rooms are listed in the form [multiviewer name]\[room 
name].

2 Touch the room you want to access (press the DOWN or UP soft keys to scroll the list as 
needed).

3 If the list of users assigned to this room appears on the right-hand screen, touch the 
user name under which you want to log on, enter your password, and then touch LOG 
IN.

The room’s monitor wall control panel appears on the right-hand screen, with the 
ASSIGN CHANNEL category selected. If a mouse is connected to the RCP-200, then after 
touching WALL MOUSE you should be able to see and move the mouse pointer on the 
monitor wall.

• The pointer may flicker when two RCP users access displays fed by the 
same multiviewer output.

• Two users accessing the same display will be limited to sharing a single 
pointer.

Notes (continued)

Note: By default, the user “Admin” has no password.

Notes

• If the ROUTER SELECT category becomes selected instead of ASSIGN 
CHANNEL, showing the following message on the right-hand screen: 
“Please select a router from the left-hand screen,” then you still need to 
complete the correlation between some monitor wall destinations and the 
representation of the corresponding KX Router logical router. See 
Correlating Monitor Wall Destinations and KX Router Logical Routers for the 
RCP-200 in the multiviewer’s Installation & Service Manual for more 
information.

• The RCP-200 will remember your user credentials until you log out 
explicitly (by touching LOG OUT at the upper-right corner of the control 
panel).

• The pointer may flicker when two RCP users access displays fed by the 
same multiviewer output.

• Two users accessing the same display will be limited to sharing a single 
pointer.
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For more information on the RCP-200, refer to the RCP-200 Guide to Installation and 
Operation. See Related Documentation, on page 11.
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Using On-Screen Wall Control

Locating the Mouse Pointer on the Monitor Wall
If you have a large system, the monitor wall may comprise a large number of display 
screens, where the mouse pointer location is not always obvious.

To locate the mouse pointer on the monitor wall
• Click the middle mouse button.

A more recognizable square shape appears around the pointer.

Using On-Screen Wall Control from the RCP-200
Once you have logged on to a room from the RCP-200 control panel, a mouse connected to 
one of the panel’s USB port automatically switches to the monitor wall, while the RCP-200’s 
touch screen features remain available. You can alternate using the mouse between the 
RCP-200’s right-hand screen, and the monitor wall.

To use the mouse on the RCP-200’s right-hand screen
• Touch the WALL MOUSE category.

The category’s background turns a darker shade (purple), and the mouse pointer 
appears on the RCP-200’s right-hand screen.

To use the mouse on the monitor wall
• Touch the WALL MOUSE category.

The category’s background turns a lighter shade (mauve), and the mouse pointer 
appears on the monitor wall.

Synchronizing the RCP-200’s Head View with the Monitor Wall
The RCP-200 control panel does not automatically reflect changes to the current layout that 
were not performed from the RCP-200—for example, someone may have loaded a different 
layout, or changed assignments, from another control panel, from XEdit, or by using the 
monitor wall mouse.

To synchronize the RCP-200’s head view with the monitor wall
• Press the REFRESH knob.

Note: Configuring a larger pointer may also help. See Enabling the Large 
Mouse Pointer for a Room on page 278, for details.
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Displaying the Dashboard
Whenever the Kaleido Software detects an error, it will automatically display the dashboard 
on every monitor of the monitor wall. When all errors are resolved, then the system 
automatically closes the dashboard on every monitor. You can also display the dashboard 
as needed, to view your multiviewer’s system name, IP address, software version and 
current error messages. In such cases you must manually close the dashboard.

To display the dashboard
1 Right-click a monitor. On the menu, point to Monitor wall, and then click Show 

dashboard to display the dashboard associated with the current head.

Monitor wall menu (from composite monitor menu)

After a brief delay, the dashboard appears at the bottom-right corner of the display 
monitor, and the command Hide dashboard replaces Show dashboard on the menu.

Dashboard on the monitor wall

Note: It is possible to disable the automatic display of the dashboard on 
specific displays. See \Disabling the Dashboard on page 157 for details on 
how to configure this option.

Note: If you right-click the monitor wall background directly, then the 
monitor wall menu appears immediately, and you can click Show 
dashboard directly:

i

Show dashboard
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Hiding the Dashboard
To hide the dashboard

• Click the × button at the bottom-right corner of the dashboard. Alternatively, right-click 
anywhere on the monitor wall, point to Monitor wall on the menu (if you clicked a 
layout element), and then click Hide dashboard to hide the dashboard on the current 
display.

To hide all the dashboards
• Right-click anywhere on the monitor wall, point to Monitor wall on the menu (if you 

clicked a layout element), and then click Hide all dashboards to hide the dashboard on 
every display in the room.

Note: Clicking the × button closes the dashboards on every display 
monitor in the room if they were displayed automatically.

Note: When a dashboard is closed while the system is in an error condition, 
it will automatically reappear after 60 minutes, or when a new error occurs.

Hide dashboard

Hide all dashboards
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Loading Layouts

Loading a Layout by Using the Mouse
To load a layout on the monitor wall, by using the mouse

1 Right-click anywhere on the monitor wall, point to Monitor wall (if you clicked a layout 
element), and then click Load layout on the menu.

The layout chooser appears.

2 Select the layout you want to load, from the set of layouts defined for this room, and 
then click OK.
The new layout appears on the monitor wall.

Loading a Layout by Using the Kaleido-RCP2
To load a layout on the monitor wall, by using the Kaleido-RCP2

1 Press LOAD on the Kaleido-RCP2.
The layout chooser appears.

Note: Due to a limitation in XEdit’s support for drag-and-drop operations, 
when you first load a new layout on the monitor wall, you may notice that a 
monitor’s source or destination assignment is incorrect. Open the layout in 
XEdit, click the corresponding monitor, verify the Source and Monitor wall 
destination attributes indicated in the Properties pane, and correct them as 
needed. See Assigning Logical Sources or Monitor Wall Destinations to 
Monitors on page 185.

Load layout
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2 Select the layout you want to load, from the set of layouts defined for this room, and 
then click OK.
The new layout appears on the monitor wall.

Using Layouts Presets
To load a layout using the Kaleido-RCP2’s preset buttons

• Press the appropriate preset button (1-10) on the Kaleido-RCP2.
The button you just pressed starts flashing (while the button associated with the 
currently loaded layout, if any, remains lit). Once the layout associated with the preset 
button for the current user appears on the monitor wall, the button stops flashing, and 
becomes lit (while the previously lit button is not lit anymore). See Assigning Room 
Layouts to the Kaleido-RCP2 Preset buttons on page 277, for more information.

Loading a Layout by Using the RCP-200
To load a layout on the monitor wall, by using the RCP-200

1 Touch LAYOUT SELECT on the RCP-200’s right-hand screen.
The layout chooser view appears.

2 Rotate the TAKE knob to locate the layout you want to load, scrolling the list as needed.
3 Once you have selected the layout you want to load, press TAKE.

After a moment, the new layout appears on the monitor wall, and the RCP-200’s right-
hand screen returns to the ASSIGN CHANNEL panel.

Refreshing a Layout
To refresh a layout

• Right-click anywhere on the monitor wall, point to Monitor wall (if you clicked a layout 
element), and then click Refresh on the menu.

Note: Once the preset button has stopped flashing on the Kaleido-RCP2, if 
the new layout has source assignments from an upstream router, it may still 
take a moment before these sources appear on the monitor wall.
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Refresh



323

Kaleido Software
User’s Manual

Displaying a Source in Full Screen Mode
To display a source in full screen mode from the Kaleido-RCP2

1 Move the pointer over the video source you want to display in full screen mode.
2 Press FULL SCREEN on the Kaleido-RCP2.

The full screen layout assigned to the current user is loaded into the full screen zone.

To display a source in full screen mode from the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the video source you want to display in full screen mode on the monitor 
wall.

2 If you have yet to assign the FULL SCREEN wall function to one of the programmable 
knobs, rotate the knob you want to program until FULL SCREEN is selected, and then 
press the knob.
FULL SCREEN appears above the programmed knob.

3 Press the FULL SCREEN knob.
The full screen layout assigned to the current user is loaded into the full screen zone.

To close the full screen view
• Move the pointer over the full screen zone, and then press FULL SCREEN again, on the 

Kaleido-RCP2 or RCP-200.

Note: A full screen layout can also be loaded by configuring actions in 
XEdit. See Managing Layouts on page 172, for information on creating a full 
screen layout, and see Creating Actions, on page 261, for detailed 
instructions.
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Changing a Source’s Aspect Ratio
To change the aspect ratio using the Kaleido-RCP2

• Move the pointer over the video source whose aspect ratio you want to change, and 
then press ASPECT RATIO on the Kaleido-RCP2. Continue pressing ASPECT RATIO to 
alternate between the available aspect ratio options (4:3, 16:9, and possibly a third 
custom aspect ratio if one was defined in XEdit for the monitor).

To change the aspect ratio using the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the video source whose aspect ratio you want to change on the monitor 
wall.

2 If you have yet to assign the ASPECT RATIO wall function to one of the programmable 
knobs, rotate the knob you want to program until ASPECT RATIO is selected, and then 
press the knob.
ASPECT RATIO appears above the programmed knob.

3 Press the ASPECT RATIO knob.
The video source’s aspect ratio changes. Continue pressing ASPECT RATIO to alternate 
between the available aspect ratio options (4:3, 16:9, and possibly a third custom 
aspect ratio if one was defined in XEdit for the monitor).

To change the aspect ratio using the mouse
1 Right-click the video source.
2 On the menu, point to Aspect Ratio, and then click 4:3 or 16:9.

The video is resized accordingly within the layout.

Note: There may be one more choice on the menu if you set a custom 
aspect ratio in XEdit, for this monitor. See Setting a Video Monitor’s Aspect 
Ratio on page 192.
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Toggling Safe Area Markers
To toggle the safe area markers on a video using the Kaleido-RCP2

• Move the pointer over the video source, and then press SAFE AREA on the 
Kaleido-RCP2. Continue pressing SAFE AREA to toggle the markers.

To toggle the safe area markers on a video using the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the video source whose cropping mode you want to change on the 
monitor wall.

2 If you have yet to assign the SAFE AREA wall function to one of the programmable 
knobs, rotate the knob you want to program until SAFE AREA is selected, and then 
press the knob.
SAFE AREA appears above the programmed knob.

3 Press the SAFE AREA knob.
The safe area markers appear inside the video window. Continue pressing SAFE AREA 
to toggle the markers.

To toggle the safe area markers on a video using the mouse
1 Right-click the video source, and then click Safe Area on the menu.

The safe area markers appear inside the video window.

2 Click Safe Area again on the menu, to hide the markers.

Safe area
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Displaying Subtitles and Closed Caption Text

Setting the Text Mode
To change the text mode for a video, or subtitling monitor

1 Right-click the appropriate video, or subtitling monitor, on the monitor wall.
2 If the current text mode indicator is Text (CC/subtitling), then:

a Click Enable text on the menu, to first enable the display of subtitles and closed 
captions.

b Right-click the monitor again.
3 On the menu, point to the text mode indicator —either Text (CC/subtitling), CC (608), 

CC (708), Teletext & subtitling, DVB subtitling, or SCTE 27 subtitling, then point to 
Text mode, and click the text mode you want to apply.

Notes

• The Kaleido-IP supports extraction of EIA-608, EIA-708, OP-47 Teletext, 
SCTE 27 subtitles, DVB subtitles, and DVB teletext.
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To prevent the menu from being too crowded by CC (608), CC (708), DVB subtitling, 
SCTE 27 subtitling, and Teletext/subtitling options, its content (label, icon and available 
choice) changes, depending on the current video format:

Switching Closed Captioning On/Off
To switch CC (608) closed captioning on/off

• Right-click the appropriate composite or video monitor on the monitor wall, point to 
CC (608), and then click either CC1 or Off.

Signal type Text Mode Indicator Label Available choices

SD-SDI/CVBS 525, 
MPEG-2, H.264

Auto CC (608) Off, CC1, Text mode sub-
menu

Any CC (608)

SD-SDI/CVBS 625, 
MPEG-2, H.264

Auto Teletext & 
subtitling

For a Kaleido-IP: Off, Page 
A to Page H, Text mode 
sub-menu
Other multiviewer 
models: Off, Page A, Edit 
pages, Text mode sub-
menu

Any Teletext & 
subtitling

HD-SDI, MPEG-2, 
H.264

Auto CC (708) Off, Service 1 to Service 
63, Text mode sub-menu

Any CC (708)

MPEG-2, H.264 Auto DVB subtitling Off, available language 
services, Text mode sub-
menu

Any DVB 
subtitling

MPEG-2, H.264 Auto SCTE 27 
subtitling

Off, available language 
services, Text mode sub-
menu

Any SCTE 27 
subtitling

Other / Unknown Auto Text 
(CC/subtitling)

Enable text, Auto sense, 
CC (608), CC (708), 
Teletext & subtitling, 
DVB subtitling, SCTE 27 
subtitling.
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To switch CC (708) closed captioning on/off
• Right-click the appropriate composite or video monitor on the monitor wall, point to 

CC (708), and then click either the appropriate service number or Off.

Setting the DVB Subtitling Language from the Monitor Wall
To set the decoded DVB subtitling language for a monitor on the wall

• Right-click the appropriate composite, video, or subtitling monitor, point to DVB 
subtitling, and then click the language you want to monitor.

To switch DVB subtitling off
• Right-click the monitor, point to DVB subtitling, and then click Off.

Note: The menu displays Service 1 to Service 6. Use the Extended services 
sub-menu to select from the Service 7 to Service 63 range. When an 
extended service is enabled it is added to the menu below Service 6.

Note: When monitoring a program that includes DVB subtitling based on a 
non-supported version of ETSI EN 300 743, the Kaleido-IP raises the DVB 
subtitle invalid alarm and no subtitling appears on the monitor wall.
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Setting the SCTE 27 Subtitling Language from the Monitor Wall
To set the decoded SCTE 27 subtitling language for a monitor on the monitor wall

• Right-click the appropriate composite, video, or subtitling monitor, point to SCTE 27 
subtitling, and then click the language you want to monitor.

To switch SCTE 27 subtitling off
• Right-click the monitor, point to SCTE 27 subtitling, and then click Off.

Selecting a Teletext/Subtitling Page from the Monitor Wall
To change the decoded teletext/subtitling page for a Kaleido-IP

• Right-click the appropriate composite or video monitor, point to Teletext & Subtitling, 
and then click the page you want to decode on the menu.
The menu displays Page A (###) to Page H (###) where “###” is the number of the 
actual page being monitored (from 100 to 899), or the word Disabled (if the page 
number associated with this page is not to be monitored).

The assignments of Page A to Page H are configured in XEdit.

To switch teletext/subtitling off
• Right-click the monitor, point to Teletext & Subtitling, and then click Off.
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Editing UMD Text

To edit the text on a UMD
1 Right-click the UMD whose text label you want to modify, and then click Edit text on 

the menu.

The UMD text area becomes editable.

2 Type the new text, and then press ENTER on the Kaleido-RCP2, RCP-200, or external 
keyboard.
The UMD displays the new text.

Note: Only UMDs configured to show static text are editable on the monitor 
wall.
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Selecting an Input Method
To select an input method

1 Click the appropriate composite or video monitor on the monitor wall.
2 Press left Alt+Shift+1 on the external keyboard.

The Select Input Method menu appears.
3 On the Select Input Method menu, click the appropriate input method.

You can now type text in your language of choice, using an external keyboard 
connected to the Kaleido-RCP2.
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Assigning Sources to Monitors
Any monitor in a layout can be assigned a logical source in XEdit. It is possible to change 
the logical source assignment directly on the monitor wall.

Assigning a Logical Source to a Monitor by Using the Kaleido-RCP2
To assign a logical source to a monitor, by using the Kaleido-RCP2’s CHANNEL button

1 Move the pointer over the monitor that is to be assigned a logical source, and then 
press CHANNEL on the Kaleido-RCP2.
The Assign Source window appears.

The label of each category/index button in Assign Source is based on recurring strings 
found in the logical source names available for your system. The Src box shows the 
current assignment.

2 Click through the categories until the Pst box shows the logical source you want to 
assign to the selected monitor. For example, if you want to assign the logical source 
named “/Input B/Channel 16” to the monitor, click Input B, 1, and then 6.

3 Click Take.
The selected logical source is now assigned to the monitor.

4 Click the × button to close the Assign Source window.

Assigning a Logical Source to a Monitor by Using the RCP-200
Although logical source assignments can be accomplished through the CHANNEL monitor 
wall function (see page 333), you may find the RCP-200’s category/index router view more 
convenient. To use the RCP-200’s category/index panel, your multiviewer system must have 
been configured to be controlled as a router. In a layout, the RCP-200 can only control 
monitors that have been assigned a monitor wall destination.

Note: Logical source assignments can also be changed by configuring 
actions in XEdit. See Creating Actions on page 261 for more information.

Current assignment
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To assign a logical source to a monitor, by using the RCP-200’s Category/Index panel
1 Select the appropriate head from the room view, by rotating the HEAD knob (or by 

touching the DISPLAY SELECT category, and then touching a room display), if needed.
2 Touch the monitor whose source assignment you want to change.

The monitor’s border turns yellow, indicating that this monitor is a monitor wall 
destination, and the RCP-200’s category/index panel appears on the left-hand screen.
The label of each category/index button is based on recurring strings found in the 
logical source names available for your system. The Src and Dst areas show the current 
source assignment and the monitor wall destination number for the selected monitor.

3 Touch through the categories until the Pst area shows the logical source you want to 
assign to the selected monitor. For example, if you want to assign the logical source 
named “/Input B/Channel 16” to the monitor, touch Input B, 1, and then 6.

4 Press Take.
The selected logical source is now assigned to the monitor.

To assign a logical source to a monitor, by using the RCP-200’s CHANNEL knob
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the composite or video monitor whose source assignment you want to 
change.

2 If you have yet to assign the CHANNEL wall function to one of the programmable 
knobs, rotate the knob you want to program until CHANNEL is selected, and then press 
the knob.
CHANNEL appears above the programmed knob.

3 Press the CHANNEL knob.
The Assign Source window appears on the monitor wall.

The label of each category/index button in Assign Source is based on recurring strings 
found in the logical source names available for your system. The Src box shows the 
current assignment.

4 Click through the categories until the Pst box shows the logical source you want to 
assign to the selected monitor. For example, if you want to assign the logical source 
named “/Input B/Channel 16” to the monitor, click Input B, 1, and then 6.

Current assignment
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5 Click Take.
The selected logical source is now assigned to the monitor.

6 Click the × button to close the Assign Source window.

Assigning a Logical Source to a Monitor by Using the Mouse
To assign a logical source to a monitor, by using the mouse

1 Right-click the monitor that is to be assigned a logical source.
2 On the menu, point to Assign source to [component] (where [component] will be 

monitor, video, UMD, tally, audio meter, status alarm, time code, metadata display, 
subtitling, or clock, depending on the monitor you clicked).

The Assign Source window appears.

The label of each category/index button in Assign Source is based on recurring strings 
found in the logical source names available for your system. The Src box shows the 
current assignment.

3 Click through the categories until the Pst box shows the logical source you want to 
assign to the selected monitor. For example, if you want to assign the logical source 
named “/Input B/Channel 16” to the monitor, click Input B, 1, and then 6.

4 Click Take.
The selected logical source is now assigned to the monitor.

Current assignment
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5 Click the × button to close the Assign Source window.
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Using Timers
Timers can be assigned to timer monitors in a layout. Any user can control such timers by 
using the timer monitor’s buttons and menu. An RCP user can be assigned a specific timer. 
This allows using the numeric keypad on an external keyboard connected to the 
Kaleido-RCP2 to control the timer.

Controlling a Timer by Using the Timer Monitor’s Buttons and the Menu

.

To configure an interactive timer monitor on the monitor wall
1 Right-click the timer you want to configure.

Notes

• Timer monitors display time in HH:MM:SS format. Even if the monitor is 
synchronized with an LTC source, frame count is not displayed.

• Using a timer monitor’s Reset, Timer mode or End behavior buttons will 
stop the timer, if it was running.

Reset Timer mode End behaviorStart/Stop

Stop

Remaining

Loop

Down

Overrun Up
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2 On the menu, point to Mode, navigate to the appropriate timer mode, and then click 
an end behavior.

Alternatively, you can set the mode and behavior directly, by clicking the timer 
monitor’s Timer mode, and End behavior buttons:

• Click the Timer mode button to select one of three modes: Overrun, Stop or Loop.
• Click the End behavior button to select one of three modes: Down, Up or 

Remaining.
The timer monitor is updated accordingly.

3 Use the Preset controls to set a new preset time.
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4 Click the Reset button to reset the timer to its initial value (based on timer mode and 
preset time).

5 Click the Start button to start the timer.

Controlling a Timer by Using an External Numeric Keypad
If a timer is assigned to the current RCP user, or else if a timer is assigned by default for the 
room, then the external keyboard’s numeric keypad controls this specific timer.

To configure your assigned timer, by using a numeric keypad
• Press the slash key (“/”) to set the timer mode and end behavior. Keep pressing the key 

to cycle through all the available options, until the buttons show the appropriate 
settings.

• Press the plus key (“+”) to reset the timer. (This will also stop the timer if it was running.)
• Press the Enter key to start/pause the timer.
• Use the number keys to set or modify the preset time.

Note: The reserved keys are always enabled, whether Num Lock is set or 
not.
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Triggering Actions

Triggering an Action from the RCP-200
To trigger a background action from the RCP-200’s programmable knobs

1 If you have yet to assign the action you want to trigger to one of the programmable 
knobs, rotate the knob you want to program until the action is selected, and then press 
the knob.
The action’s name appears above the programmed knob.

2 Press the knob to trigger the action.

Triggering an Action from the Monitor Wall

To trigger a monitor wall action
1 Move the pointer over a monitor associated with the action you want to trigger.

The pointer changes to a hand icon.
2 If the action is not triggered automatically, click or double-click the monitor.

Notes

• An Action’s trigger is determined when the Action is created in XEdit. 
See Creating Actions on page 261 for more information.

• To create background actions that can be triggered from the RCP-200’s 
programmable knobs, see Creating an Action that can be Triggered 
through a Gateway Command, on page 270.
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Acknowledging Alarms

Acknowledging Alarms on the Monitor Wall
To acknowledge an alarm, by using the Kaleido-RCP2

• Move the pointer over the monitor whose alarm state you want to acknowledge, and 
then press the UNLATCH STATUS button on the Kaleido-RCP2.

To acknowledge an alarm, by using the RCP-200
1 Touch the WALL MOUSE category if it is not already selected, and then move the 

pointer over the monitor whose alarm state you want to acknowledge on the monitor 
wall.

2 If you have yet to assign the UNLATCH STAT wall function to one of the programmable 
knobs, rotate the knob you want to program until UNLATCH STAT is selected, and then 
press the knob.
UNLATCH STAT appears above the programmed knob.

3 Press the UNLATCH STAT knob.

To acknowledge an alarm, by using the mouse
• Right-click the monitor whose alarm state you want to acknowledge, and then click 

Unlatch/Acknowledge on the menu.

To acknowledge all current alarms in a room
• Right-click the monitor wall, point to Monitor wall (if you clicked a monitor), and then 

click Unlatch/Acknowledge all on the menu.

Unlatch/Acknowledge

Unlatch/Acknowledge all
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This will acknowledge every alarm monitored in the current room.

Acknowledging Alarms by Using an Action
To acknowledge alarms, by using an action

• Create a Unlatch/Acknowledge all action. This action can be assigned to a monitor on 
the monitor wall, it can be triggered by loading or unloading a layout, or it can be a 
background action. See Creating Actions on page 261 for details.
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Monitoring Audio

Triggering Audio Monitoring by Using the mouse, the RCP-200, or the 
Kaleido-RCP2

To trigger audio monitoring, by using the mouse, the RCP-200, or the Kaleido-RCP2
• Move the pointer over an audio monitor, and then

• click the monitor
• press AUDIO MONITORING on the Kaleido-RCP2

• press the AUDIO MONITOR programmable knob on the RCP-200

This will route the monitor’s audio source to the monitoring output assigned to the 
current RCP user.

• Move the pointer over a video monitor, and then
• click the monitor
• press AUDIO MONITORING on the Kaleido-RCP2

• press the AUDIO MONITOR programmable knob on the RCP-200

This will route the specific audio level associated with the video monitor, based on the 
assigned logical source.

• Move the pointer over any other monitor, and then
• click the monitor
• press AUDIO MONITORING on the Kaleido-RCP2

• press the AUDIO MONITOR programmable knob on the RCP-200

This will route the first audio level of the associated logical source to the monitoring 
output.
Audio monitors that have an audio monitoring indicator (see Configuring Audio 
Monitors on page 207) and that are currently assigned the same audio level, will turn 

Notes

• Before connecting a display to a Kaleido-IP multiviewer, make sure the 
multiviewer is powered off. In the event that you have connected such a 
device while the multiviewer is running, you must restart the multiviewer 
for audio monitoring to be functional. See Restarting and Shutting Down 
a Kaleido-IP Multiviewer in the multiviewer’s Installation & Service 
Manual for how to do this.

Notes

• All audio and video monitors are configured by default, with a Monitor 
audio action triggered by a single click.

• If you have yet to assign the AUDIO MONITOR wall function to one of the 
RCP-200’s programmable knobs, rotate the knob you want to program 
until AUDIO MONITOR is selected, and then press the knob. AUDIO 
MONITOR appears above the programmed knob.
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the color associated with the current display (see Calibrating the Audio Monitoring 
Color on page 113), showing that is being sent to an audio monitoring output.

If multiple users are listening to the same audio source at the same time, then the 
indicator will show one color only: (1) the color associated with a display in the same 
room (2) the color associated with the display at the monitoring output that was 
enabled last in the room.

Controlling the Volume at the Audio Monitoring Output

Controlling the volume from the Kaleido-RCP2

To control the volume at the audio monitoring output, from the Kaleido-RCP2
• Adjust the audio volume for your assigned monitoring output by using the up and 

down volume buttons on the Kaleido-RCP2.
• Mute the audio by pressing the Mute button on the Kaleido-RCP2.
• Attenuate the volume by 20 dB by pressing the -20 dB button on the Kaleido-RCP2.

Controlling the volume from the RCP-200
On the RCP-200, pressing the VOL knob repeatedly alternates between the normal, mute, 
and -20 dB audio output mode.

To control the volume at the audio monitoring output, from the RCP-200
• Adjust the audio volume for your assigned monitoring output by rotating the VOL 

knob.
• Mute the audio by pressing the VOL knob until MUTE appears above the knob.
• Attenuate the volume by 20 dB by pressing the VOL knob until -20 dB appears above 

the knob.

Audio monitoring indicator

Note: The Kaleido-RCP2’s volume control, Mute, and -20dB buttons, their 
equivalent on the RCP-200, and the corresponding Gateway commands 
apply to analog audio monitoring outputs are not supported by the 
Kaleido-IP.
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14Maintenance & Troubleshooting

Introduction
This chapter shows you the various maintenance operations and corrective actions that 
maybe required to be performed when configuring the multiviewer system and over the 
multiviewer’s lifetime.

Troubleshooting Common Issues
Troubleshooting consists of identifying common configuration errors and to provide 
solutions to these issues. Use the following troubleshooting table to diagnose common 
issues and take corrective actions to restore operation.

Symptom  Probable cause Test Corrective action

Mosaic layout is 
scrambled and has 
ghost images.

Head is assigned to two 
rooms.

Using XEdit, verify that 
each head is assigned 
only once.

In XEdit's room configuration pane, 
remove the extra displays. See 
Adding Displays, on page 148.
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abcAcronyms Used in this Document

The acronyms used in this document are defined in the following table.

Acronym Definition

ABT Audio Bridge Terminal

ACOS Mnemonic, tally and control of crosspoints

AES Audio Engineering Society, specifically the AES3 standard

AFD Active Format Description

AFD VI AFD Video Index

ALM Audio Level Meter

APS Analogue Protection System

ARIB Association of Radio Industry and Businesses

ASB Analog Source Bit

ASCII American Standard Code for Information Interchange

ASM Any-Source Multicast

ATC Ancillary Time Code 

ATSC Advanced Television Systems Committee

AUX Axillary

AV Audio-Video

BNC Bayonet Neill–Concelman

CAD Content Advisory Descriptor

CBR Constant Bit Rate

CC Closed Caption

CEA Consumer Electronics Association

CGMS-A Copy Generation Management System - Analog

CPU Central Processing Unit

CSV Comma Separated Values

CVBS Composite Video and Blanking Signal

dBFS Decibels Full Scale

dBu A logarithmic voltage ratio with a reference voltage of 0.7746 volt = 0 dBu

DCII Digicipher 2

DHCP Dynamic Host Configuration Protocol

DIN Deutsches Institut für Normung / German Institute for Standardization
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DNS Domain Name System

DPI Digital Program Insertion

DTMF Dual-Tone Multi-Frequency signaling

DTVCC Digital Television Closed Captioning

DVB Digital Video Broadcasting

DVI Digital Visual Interface

EBU European Broadcasting Union

EDID Extended Display Identification Data

eDPM expansion Digital Picture Manipulator 

ETH Ethernet

ETS European Telecommunication Standard

ETSI European Telecommunications Standards Institute

GB GigaBytes

GENLOCK Generator Locking

GPI General Purpose Interface

GPIO General-Purpose Input/Output

GPU Graphics Processing Unit

GSM General Status Manager

GUI Graphical user interface

HD High Definition

HD-SDI High Definition-Serial Digital Interface

HDMI High-Definition Multimedia Interface

HDR High Dynamic Range

HLG  Hybrid Log-Gamma (BT.2100)

HLS HTTP Live Streaming

HTTP Hypertext Transfer Protocol

HTTPS HTTP Secure

IEC International Electrotechnical Commission

IEEE Institute of Electrical and Electronics Engineers

IP Internet Protocol

IRE Institute of Radio Engineers

ISO International Standards Organization

ITU International Telecommunication Union

KMV Kaleido Multiviewer

LAN Local Area Network

Acronym Definition
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LAP Look Ahead Preview

LCD Liquid Crystal Display

LED Light Emitting Diode

LEQ A-weighted LEQ

LKFS Loudness, K-weighted, relative to Full Scale

LTC Linear Time Code

LUFS Loudness Units relative to Full Scale

LUT Look Up Table (also known as Look Profiles)

MIB Management Information Base

MIDI Musical Instrument Digital Interface

MPEG Moving Picture Experts Group

MPEG ID MPEG stream Identifier

msec millisecond

mV milliVolt

NIC Network Interface Card

NMOS Networked Media Open Specifications

NMS Network Management System

NTP Network Time Protocol

NTSC National Television System Committee

NTSC-J National Television System Committee-Japan

OLED Organic LED

PAL Phase Alternating Line

PAT Program Association Table

PCM Pulse-code modulation

PCR Primary Clock Reference

PGM Program

PID Packet Identifier

PMT Program Map Table 

PQ Perceptual Quantizer (SMPTE ST 2084)

PST Preset

PSU Power Supply Unit

PTS Presentation Time Stamp

PVW Preview

RAM Random Access Memory

RCP Remote Control Panel

Acronym Definition
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RDD Registered Disclosure Document

Rec.2020
BT.2020

The standard for Ultra-high-definition television (ITU-R BT.2020)

Rec.709
BT.709
709 Standard

The standard for high-definition television (ITU-R BT.709)

REST Representational State Transfer

RGB Red Blue Green, or a VGA connection

RMI Remote Method Invocation

RTMP Real-Time Messaging Protocol

RTP Real-time Transport Protocol

RTSP Real Time Streaming Protocol

RU Rack Unit

SCTE Society of Cable Telecommunications Engineers

SD Standard Definition

SDI Serial Digital Interface

SDR Standard Dynamic Range, Rec.709 (BT.709), as opposed to HDR

SECAM Séquentiel couleur à mémoire / Sequential Color with Memory

SFM Source-Filtered Multicast

SFP Small Form-factor Pluggable

S-Gamut3 One of Sony’s gamma curves for WCG

S-Log3 One of Sony’s transfer function curves for HDR

SMPTE Society of Motion Picture & Television Engineers

SMTP Simple Mail Transfer Protocol

SNMP Simple Network Management Protocol

SPT Studio Production Timer

SSH Secure Shell

SSM Source-Specific Multicast

TCP Transmission Control Protocol

TS Transport Stream

TSID MPEG Transport Stream identifier

TTF True Type Font

UDP User Datagram Protocol

UHD Ultra-High Definition

UMD Under Monitor Display

URL Uniform Resource Locator

Acronym Definition
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URS Universal Reference Signal

USB Universal Serial Bus

UTF Unicode Transformation Format

VANC Vertical Ancillary Data

VESA Video Electronics Standards Association

VGA Video Graphics Array connector, a 640×480 screen resolution, or the DE-15 
connector.

VITC Vertical Interval of an analog signal

VLAN Virtual Local Area Network

VPE Video Processing Engine

VU Volume Units

WCG Wide Color Gamut

WSS Wide screen signaling

WST World System Teletext

XDS Extended Data Services

XLS
XLSX

Microsoft Office spreadsheet file format

ZIP Lossless file compression format

Acronym Definition
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Aspect ratio

about  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .90, 167
AFD  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197
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WSS . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 197

Assigning
alarms to logical sources . . . . . . . . . . . . . . . . . 80
audio outputs to RCP users . . . . . . . . . . . . . . 282
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Grass Valley Technical Support
For technical assistance, contact our international support center, at
1-800-547-8949 (US and Canada) or +1-530-478-4148.

To obtain a local phone number for the support center nearest you, consult the Contact Us 
section of Grass Valley’s website (www.grassvalley.com).

An online form for e-mail contact is also available from the website.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com
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